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Introduction 
This Operator’s Guide is applicable to ADVIA CentraLink® System Software 13.0 
and higher. 
The ADVIA CentraLink system software is your network solution provider and 
multi-system data manager for the instruments and laboratory automation 
systems (LAS) in your lab. 
The ADVIA CentraLink software consolidates data from all connected 
instruments so that an operator can review and edit patient and quality control 
results from a single location. 

The ADVIA CentraLink system is configurable to have 1 or 2 separate 
communication channels with a single lab information system (LIS) to enable 
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concurrent uploading data to and downloading data from the LIS. With this 
configuration, the communication channels consist of one channel for 
downloading test orders from the LIS and another for uploading results from the 
ADVIA CentraLink software. The 2 separate communication channels ensure 
continuous communication flow of information from the LIS to the 
ADVIA CentraLink software and from the ADVIA CentraLink software to the LIS.
For LIS that do not support more than one channel for communication to the 
same host, the upload and download communication can be achieved using a 
single connection. 
The ADVIA CentraLink software supports the ability to configure either one or two 
lab automation systems. 
Upon receipt of workorder download from the LIS, the ADVIA CentraLink 
software automatically downloads all received workorders to the LAS. Upon 
sample checkin to the LAS and during the physical routing of samples to the 
analyzers, Sample Managers, and Cold Storage for archival of samples, LAS 
status update messages are uploaded from the LAS to the ADVIA CentraLink 
software to provide accessioning and sample location information. The 
ADVIA CentraLink software also provides the ability to manually query the LAS 
for sample location information. 
When 2 lab automation systems are configured, the ADVIA CentraLink software 
downloads all workorders and queries to both lab automation systems. If one lab 
automation system is temporarily not accepting orders, the ADVIA CentraLink 
software sends previously unsent orders to the LAS after the connection is 
reestablished with the associated lab automation system. Accordingly, the 
ADVIA CentraLink software receives updates from both lab automation systems 
upon a LAS status update. 
The ADVIA CentraLink software can support a maximum of 32 connections. 
These connections can include a maximum of 32 instrument connections or 30 
instrument connections and 2 lab automation system connections. The total 
number of combined instrument and LAS connections cannot exceed 32. 
The ADVIA CentraLink software supports a maximum of 15 client computers or 
workstations, of which a maximum of four clients may be remote clients. 
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Operator Functions
An ADVIA CentraLink operator is a person who performs routine operations.
Routine operations include the following tasks:
• Reviewing data for multiple instruments from any ADVIA CentraLink system 

workstation
• Managing automated data review and result release of patient test samples. 
• Customizing laboratory-specific criteria for flagging, delta check, and auto-

reflex and repeat testing
• Viewing ADVIA® hematology system cytograms and histograms
• Performing manual result entry 
• Managing Quality Control (QC)
• Generating QC reports
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System Functions
A system manager is the person who configures and monitors ADVIA CentraLink 
software for the operators who perform routine operations.
The system manager uses the ADVIA CentraLink software to do the following 
tasks:
• Verify that initial settings are properly configured for instruments, tests, 

patients, physicians, QCs, and related data
• Add new users
• Set up security for all users
• Customize ADVIA CentraLink software toolbars
• Monitor communication with the LIS, lab automation system (LAS), and 

instruments
• Monitor instrument and QC status
• Back up and restore the system
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Data Communication
The ADVIA CentraLink software displays a variety of data, such as patient 
results, workorders, QC results, patients, and physicians. Some information 
comes from the LIS, LAS, and from the instruments performing tests. 
The following illustration depicts the flow through which ADVIA CentraLink 
software receives and sends data. 

Data Collection and Transfer Points Workflow Paths

1 LIS A Workorders from LIS 

2 ADVIA CentraLink system B Workorders from the 
ADVIA CentraLink system 
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The ADVIA CentraLink software receives downloaded workorders from the LIS 
and downloads them to the LAS. The instrument queries the ADVIA CentraLink 
software for test selectivity for specific bar-coded sample IDs. When the tests are 
completed for a sample, the instrument sends the results to the 
ADVIA CentraLink software. Normal results can be automatically validated and 
sent to the LIS.

G Sample location information from the 
LAS 

3 Lab automation system (LAS) C Tube Transfer Communication

4 Instruments D Sample Query Communication

E Sample Results

F Results from the ADVIA CentraLink 
system to the LIS

Data Collection and Transfer Points Workflow Paths
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ADVIA Modular Automation System
If you are using ADVIA CentraLink software within an ADVIA® LabCell® or 
ADVIA WorkCell™ CDX system, your lab can have several different workstations 
each running different applications. Operators can perform daily operations using 
other applications within the ADVIA automation system. 

LineMaster and Router Software
Use the LineMaster software or the Router software to accomplish the following 
tasks:
• Identify and resolve samples in question
• Correct routing status
• Manage sample tray input and output

- Direct sort trays to offline laboratories to complete processing 
- Determine where sample trays are stored after processing

• Query for the current location and processing status of samples
• For pick list purposes, locate samples that were moved to storage

- Print tray contents
• Handle errors and troubleshooting
• Manage which components are currently online and offline
• Manage LIS-ADVIA CentraLink software to automation computer status

LIS Software 
Use the LIS software to manage the following items:
• Order entry
• Dilutions ordered at the LIS
• Long term result storage
• Reporting
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Getting Started 
In this section, you learn about the following features and functions:
• Log on to the ADVIA CentraLink software
• Work with the ADVIA CentraLink system workspace
• Use the toolbar to access the data you need
• Use ToolTips to help you understand the meaning of a data field
• Execute a command using the menus or right mouse button
• Use the online version of this guide

Logging On and Off 
To log on to the ADVIA CentraLink software, you must have a user name and 
password and enter them in the fields of the Login window. See your 
ADVIA CentraLink system administrator to obtain a user ID.
To launch the ADVIA CentraLink application, double-select the 
ADVIA CentraLink system icon on the desktop. The Login window displays. 
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If at a given workstation the ADVIA CentraLink software is already running, you 
can check who is currently logged onto that workstation by looking at the user 
name in the status bar, which is located at the bottom of the screen.

 

To log off the system: 
1. On the menu bar, select Start > Exit. 

1 Start menu

2 Name of current user
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Using the Workspace
The ADVIA CentraLink system workspace consists of different areas. 

1 Menu Bar. Displays the ADVIA CentraLink software menus. Some menu items 
vary depending on the windows open in the workspace. For example, the 
Record menu is not active until a window, such as the Samples window, is open. 
The items on the Edit menu (Cut, Copy, Paste) are active for an open window.
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Resizing Windows on the Workspace 
System managers have the ability to resize windows within the 
ADVIA CentraLink software. 
To resize a window on the workspace, do the following: 
1. Select the title bar of the window. 
2. Select the Resize active window icon. 

The title of the window changes and a boarder displays. For window resizing, 
drag the black border box to the required size. For column resizing, select the 
column header border and drag to the required size.

3. To save the changes after you resize the window, select the Resize active 
window icon. 

2 Editing toolbar. Icons for common tasks (Open, Save, Find Data) apply to an 
open window.
The Resize active window icon is one of the icons on the Editing toolbar and 
enables you to resize windows and browsers within the ADVIA CentraLink 
application. For example, you can decrease the overall frame size of the Review 
and Edit window or the individual browser columns contained within the Review 
and Edit window. You can resize windows to view multiple windows 
simultaneously within the ADVIA CentraLink software; for example, the Review 
and Edit and QC Results (Across controls view) windows.
Once specified, the resized windows maintain the new size specifications 
between ADVIA CentraLink sessions for that user. Double-selecting the frame 
title bar restores the default window size. 
Refer to Resizing Windows on the Workspace‚ page 23. 

3 Function toolbar. Icons for commonly used functions. Each function opens a 
window. The first group of functions on the toolbar are also on the Start > 
Routine menu.

4 Workspace. Area where open windows are displayed. You can work on multiple 
open windows simultaneously with other users on other workstations.

5 Status bar. Displays messages, workstation name, and logged in user.
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NOTE:You can restore the default window size by double-selecting the title 
bar of the window when the resize setting is active.

Using Toolbar
When the ADVIA CentraLink software is initiated, only the menus and toolbars 
are displayed. To start your work, which can include reviewing and editing results 
or checking QC, you can select a toolbar icon. 
The toolbar contains the most frequently used functions. By hovering over the 
toolbar, the name of each operation displays. Each of the toolbar functions are 
described later in this guide. 

1 Instrument

2 Tests

3 Order Entry

4 Patients

5 Physicians

6 Samples

7 Review and Edit

8 Results Entry Grid

9 QC

10 System Manager Functions
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Using ToolTips for Quick Help
The ADVIA CentraLink software has ToolTips for quick help on any toolbar 
button, field, or window button.
To find out a brief description of an item, rest your mouse pointer over it to 
activate a ToolTip.
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Working with Functions and Windows
The ADVIA CentraLink software offers several ways for you to do your work, 
including menus, context menus, selection from the ? symbol, and keyboard 
shortcuts.

Using Menus
The menus on the top of the ADVIA CentraLink system window contain functions 
that you can use as an alternative to using the toolbar. 
The main functions for routine operations can be initiated as follows: 
1. On the menu bar, select Start > Routine menu. 
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A menu item with a right-arrow indicator contains submenus.
NOTE: After selecting a specific menu option, you might have to select Related 
prior to seeing the display of your menu choice. 
After you select a menu item or toolbar icon, the workspace displays a window 
appropriate for the function you selected. 

Using Browsers and Editors
The ADVIA CentraLink software contains two types of windows: 
• Browser windows display information in a list format. You cannot enter data to 

Browser windows. 
• Editor windows contain fields, that allow you to enter data. You submit this 

information by selecting OK. 
NOTE: Greyed fields on Editor windows indicate that these fields are not 
enabled; that is, you cannot enter data to these greyed fields. 

The main difference between the two window types is that browsers display lists 
to which you cannot directly add items. You add items to a browser by accessing 
and inputting data to its corresponding editor. An editor enables you to enter and 
submit data. Shortcut keys are associated with different types of windows. For 
more information, see Using Keyboard Shortcuts‚ page 37. 
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Browser Window
A browser allows you to view data.

Selecting Records within a Browser Window
Highlighting a record alone is not sufficient to select the record. When you 
successfully select a record, the greater than symbol, (>), populates the left-most 
column of the selected record. 
To select or deselect an individual record in a browser window, you must navigate 
to the record, highlight the record with your cursor, and select the record by 
pressing Space Bar. 
To select one record or multiple records in a browser window, do one of the 
following: 
• Navigate to each record individually, highlight the record with your cursor, and 

select the record by pressing Space Bar. 
• At the Editing toolbar, select the Select All icon. 
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• At the Menu bar, select Record > First occurrence.
Selects the first record in the list to the highlighted record. 

• At the Menu bar, select Record > Current to last.
Selects the current highlighted record in the list to the last record. 

To deselect multiple records in a browser window, do one of the following:
• Navigate to each record individually, highlight the record with your cursor, and 

deselect the record by pressing Space Bar. 
• At the Editing toolbar, select the Deselect All icon. 

Within a generic Browser window, you can update multiple records at the same 
time by selecting the appropriate records and executing a given command or 
function. Each of the selected records is updated. 
If you attempt to execute a command or function on multiple selected records in a 
generic Browser window and another row of the browser is highlighted, but not 
selected, a message displays warning that the current record is not selected. If 
you select Yes to continue, the selected records are updated; the highlighted 
record is not updated. 
This warning message is not displayed if you attempt to execute a multirecord set 
command or function at the Review and Edit window or at the QC Across 
Controls View window. 
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Editor Window
An editor allows you to enter data. To submit the data, select OK. 

Browser and Editor Windows: Using Double-Select and Context Menus 
After opening a window, you can double-select in a field or right-select a selected 
entry to gain access to additional information. The right-select menu is called the 
context menu.
• For additional information, double-select an item in a window. In the Samples 

window, for example, you can select a sample and double-select. The Order 
Entry window displays. 

• To take additional action on an item, select the item and right-select. Select a 
function from the right-select menu.
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Right-select a selected item to display the context menu.
A popup menu that lists functions specifically available to the record displays. 
Depending on the target record, the context popup menu dynamically adjusts 
itself, disabling options that are not applicable to the single target record. 
Double-select a selected item to view details about it. 

NOTE:  Functions on the right-select menu also display on the main 
ADVIA CentraLink system context menu. A different menu displays in place of 
the Context menu depending on the window that is open in the workspace. If a 
window is not open, the Context menu is empty. 
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Using the ? Symbol Placeholder
On many ADVIA CentraLink system windows, a ? symbol displays. 
The ? symbol can have different meanings depending on the field in which it 
displays. 
NOTE: Before making changes to a field that contains the ? symbol, ensure that 
you fully understand the acceptable values. 
To use the ? symbol placeholder, perform the following steps:
1. Rest your mouse on a field that contains the ? symbol.
2. If your cursor changes to a hand shape, double-select the ? symbol. 

Another window opens with a list of acceptable data for the field. 
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3. If your cursor changes to an I-beam shape, there is no list of data from which 
to select. 
You can type into the field. See the I-beam cursor in the Sample ID field of the 
Order Entry window. 

If the field is not required, the ? symbol is a default value, and you do not 
have to change it. In some cases, such as search queries, the ? symbol is an 
indication that the system does not use the field to filter results. Leaving the ? 
symbol returns items regardless of what they contain for the field.
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NOTE:  In some cases, the ? symbol is necessary if no entry is made in a field. 
Removing the ? symbol and leaving the field blank can cause system errors. 
For example, if your cursor changes to a hand shape when the mouse rests in 
the Method test field, you can double-select the ? symbol to view a selection list. 
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Upon double selecting in the Method test field, the Tests browser window 
displays. 

Upon selecting the appropriate test and double selecting, the QC Population 
editor window redisplays. 
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The Method test field is populated with the selected test, RBC. 
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Using Keyboard Shortcuts
Keyboard shortcuts are available in the software.

Window Keyboard Keys to Press Description of Action

Any F10 Places active keyboard control on the 
Start selection of the main menu

F4 Displays the right-select menu
F2 Submit and proceed
ESC Cancel and proceed

Browser INSERT Call editor for create
F5 Refresh current query
F6 Call editor for update
CTRL + F Call Find dialog
<Space> Toggle selection
ENTER, <double-select> In lookup mode: return record, otherwise 

call editor for update
Editor TAB Advance to next field or button

SHIFT + TAB Backup to previous field or button
F7 Go to the first empty field

Field SHIFT + <Arrow> Select
CTRL + C Copy selection
CTRL + X Cut selection
CTRL + V Paste selection

Refnce. CTRL + F Call browser for lookup
F6 Zoom (call Editor)
<Up arrow> Previous alternative
<Down arrow> Next alternative

Fill-in CTRL+ E Deletes the text after your cursor
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Scrolling to a Data Item
If you know the name or ID of a sample, patient, physician, or other data item, 
you can display the information by typing it into a field on the appropriate window 
rather than scrolling through a long list.
1. Open the appropriate window. 

For example, select Patients on the toolbar. The Patients browser window 
displays. 

2. Select in the left-most field. 
Select in Last Name on the Patients browser window. Do not select the entry. 

3. Type the data item that you want to access. 
Type Smith to access a patient named Smith. As you type, the browser 
scrolls to the first match.

CTRL+ R Recall
Window Keyboard Keys to Press Description of Action
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Using the ADVIA CentraLink Software
• If you initiate a database query and the system remains unresponsive, you 

can cancel the query by pressing CTRL+BREAK if necessary. Pressing 
CTRL+BREAK, however, could stop the Progress database and close the 
ADVIA CentraLink software.
To shorten query time and to prevent the likelihood of an unresponsive 
system, restrict the search parameters by providing the known search criteria 
when making queries. 

• If you make a database query that takes a long time, and you want to cancel 
it, just press CTRL+BREAK. This action closes query. At other times, this 
action closes the ADVIA CentraLink software, and you can log on again and 
start over.

• If you open several windows, use the Active Window to Foreground and 
Active Window to Background icons on the toolbar to refocus the 
appropriate window.

• Use the Find function (the Binocular icon on the toolbar) to find a specific 
test, sample type or other data. You can enter only alphabetical text in the 
Find window; numbers are not accepted.

• For the quickest help, refer to How Do I?‚ page 45 of this guide.

Using the Online Version of this Guide
If you are using the online version of this Operator’s Guide, you can use the 
following features:
• Access this guide by selecting Help from the ADVIA CentraLink system help 

menu. Adobe Reader opens with the ADVIA CentraLink system operator 
guide displayed.

• The Table of Contents displays in the left pane on the window. 
• Access the full text search feature by selecting the Binocular icon. 
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Installing the Operator’s Guide on Another Computer
You may need to install the ADVIA CentraLink system Operator’s Guide on a 
computer that is not running the ADVIA CentraLink software. The installation 
procedure installs the following items:
• Adobe Reader 9.0
• ADVIA CentraLink Operator’s Guide

To install the Operator’s Guide:
1. Close all Windows programs before beginning the installation.
2. Insert the ADVIA CentraLink Operator’s Guide CD in the CD drive. 

The installation starts automatically.
3. On the Welcome window, select Next. 
4. Leave both options selected on the Choose options window and select Next.

A Choose Destination Location window displays with the following text:
“WARNING: CentraLink Server software has not been installed on this 
computer. 

5. If you wish to continue installing the ADVIA CentraLink Operator’s Guide, you 
must select a destination folder using Browse. 

6. If you do not want to continue the installation, select Cancel.
Select Next to agree to the default destination folder: C:\CentraLink\Doc.

7. Select Yes if asked to create the C:\CentraLink\Doc folder. 
The Adobe Reader 9.0 install runs. When the installation is complete, the 
CentraLink Install window displays. The Adobe License Agreement and the 
Software License Agreement displays.

8. Select Accept. 
The ADVIA CentraLink Operator’s Guide installation runs. After the 
Operator’s Guide is installed, a Setup Complete window displays a message 
to reboot to complete setup. I want to restart my computer now is selected 
by default. 

9. Select Finish to restart the computer and complete the installation.
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How Do I?
For a quick answer, go to the page for a specific task: 

Task Go to

Review and Edit

Review sample results page 47

Review results for specific samples page 54

Validate and Invalidate results page 132

Rerun a test page 134

Edit a result page 152

Print a sample report page 86

Append a comment to a result page 152

Interpret result severities page 125

Display result flag details page 137

Revert a result page 135

Omit a test page 149

QC Results

Review QC results page 193

Interpret QC from results or Levey-Jennings plots page 184

Omit a QC data point page 216

Reinstate a QC data point page 216

Audit a QC data point page 217

Reset QC severity page 205
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Close out QC page 219

Print QC results page 220

Add a new QC lot page 173

Miscellaneous

Create a workorder page 231

Use Diff Pad page 73

Manually enter results and send to the LIS page 226

Merge a workorder with unsolicited results from an instrument page 235

Task Go to
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Viewing Samples
Each sample consists of one or more test requests. The status of a sample is the 
same as the lowest status of a test request within the sample. For example, if a 
sample has 10 tests and one test result has a status of Pending, the sample 
status is Pending. 

Understanding the Unique Sample ID and Patient ID 
Environment
The ADVIA CentraLink system is designed to operate with unique sample IDs 
and unique patient IDS. The LIS must support unique sample and patient IDs. 
If sample IDs must be reused, ensure that the sample IDs that are candidates for 
reuse are deleted from the sample database before they are reused. 

Deleting Existing Sample IDs before Sample ID Reuse 
The first step in ensuring that sample IDs are deleted from the database before 
reuse is to execute the Purge function. 

Purge Function
Purging the sample database removes all samples from the database with status 
Uploaded, Omitted, and Unknown; that is, the purge function deletes those 
samples that do not have Pending, Rerun, Scheduled, or Review status test 
requests. Refer to Purging Sample and Worklist Data from the Database‚ 
page 72.
Those samples with status Pending, Rerun, Scheduled, and Review are not 
purged from the database upon executing the Purge function. These samples 
have active workorders and outstanding test requests within the 
ADVIA CentraLink system and as such, the sample IDs that identify them are not 
typically candidates for reuse. It is important to note, therefore, that if they were 
reused without first being deleted from the system, the results for the new 
physical sample would merge with the results of the original, different physical 
sample.
If your lab requires the reuse of sample IDs that are associated with samples in 
Pending, Rerun, Scheduled, and Review status, however, you must take the 
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additional step of executing an Omit command to ensure that these sample IDs 
are deleted from the database. 

Omit Command
The Omit command changes the status of samples that exceed the sample 
retention time period requirements of your lab to Omitted. 
Your local technical support provider can configure the Omit command to change 
the status of samples that existed in the database for a user-specified number of 
days from Pending, Rerun, Scheduled, and Review to Omitted. 
Once configured, the Omit command can be scheduled to run as a task as per 
your lab’s requirements. The next time the Purge function is initiated after the 
Omit command is executed, the sample IDs associated with these samples in 
status Omitted are deleted from the database along with the sample IDs 
associated with other samples in status Uploaded, Omitted, and Unknown. 

Retaining Unique Patient IDs
Although samples with status Uploaded, Omitted, and Unknown are deleted from 
the database upon executing the Purge function, the patient information 
associated with these samples is not deleted from the database. Patient 
information and the patient IDs that identify this patient information exist in the 
database after the samples to which they were associated are deleted. As such, 
patient IDs should never be reused. 
CAUTION: The ADVIA CentraLink software does not support the automatic 
purge of patient information when the samples, to which the patient IDs are 
associated, are purged from the sample database. Do not reuse patient IDs. 
The ADVIA CentraLink software is designed to operate with unique Patient IDs. 
As the LIS is considered the master system from which the most current data 
originates, the ADVIA CentraLink software always accepts updates to patient 
records from the LIS. 
As such, every patient demographic update that is downloaded from the LIS to 
the ADVIA CentraLink software must be identified by a unique patient ID that 
references the same physical patient. 
If a patient ID were reused to reference another physical patient, patient 
demographic updates downloaded from the LIS would overwrite the original 
patient details associated with this patient ID. Under this circumstance, an 
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erroneous mix of new patient details that pertain to another physical patient 
would coexist in the same record of the ADVIA CentraLink database with 
unrelated patient details that pertain to the original physical patient. Upon 
download from the LIS, the existing patient data in the ADVIA CentraLink 
database would be overwritten with non-related patient demographic data that 
pertains to another physical patient. 
WARNING: Do not reuse patient IDs. 
Upon download, the LIS should always send valid, populated values within the 
following fields: Patient Age, Patient Gender, and Patient Name.
The LIS must be capable of assigning different sample IDs to samples of different 
sample types for the same patient and must be capable of sending these sample 
IDs to the ADVIA CentraLink system as different workorders. 
The LIS must also be capable of separating different sample types into different 
workorders. Most often, the LIS specifies the sample type in the workorder. If the 
sample type is not included in the workorder, the ADVIA CentraLink system 
applies the sample type for the first test in the workorder to the entire workorder.

Understanding the Sample Reuse Period 
As an additional safeguard to ensure the unique sample ID environment, the 
ADVIA CentraLink software does not accept results from an instrument for a 
given sample ID after a configurable time period, known as the sample reuse 
period. Refer to Configurable Sample Reuse Period‚ page 142.
Within the ADVIA CentraLink software, the sample reuse period parameter is 
defined as the number of days in which you would retain a sample in your lab 
after the first sample result is generated. This sample reuse period parameter is 
used in a calculation to determine whether sample results from an instrument are 
received within the sample reuse period and whether they are accepted and 
saved. 
This definition ensures that even when the sample ID exists in the system, the 
ADVIA CentraLink software does not accept results from the instrument for this 
sample ID after the sample reuse period. 
When sample results received from an instrument exceed the sample reuse 
period, the results are not saved and the sample ID associated with this sample 
is eligible for reuse. 
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If your lab requirements dictate that you reuse a sample ID that references a 
sample for which results exceeded the sample reuse period, upload the sample 
results to the LIS. This upload changes the sample status to Uploaded. 
The next time the Purge function is initiated, the sample ID associated with this 
sample in status Uploaded is deleted from the database along with the sample 
IDs associated with other samples in status Uploaded, Omitted, and Unknown.
After the sample reuse period has elapsed and the sample ID is purged from the 
system, the same sample ID can be reused in the ADVIA CentraLink software as 
a unique sample ID.

Summary of the Unique Sample ID and Patient ID Environment
To ensure the proper maintenance of the unique sample ID and patient ID 
environment, define a relevant sample reuse period and contact your local 
technical support provider to configure and schedule regular Purge and Omit 
tasks. In so doing, you delete sample IDs from the database, make them 
available for subsequent reuse, and maintain the overall integrity of the database. 

Following the Sample Status Through the Life Cycle
The status of a sample is the same as the lowest status of a test within the 
sample. To better understand samples, a hypothetical sample life cycle can be 
considered. Let’s assume for this example that the sample must be transported 
to two instruments.
The life cycle of a typical sample is as follows: 
• Upon receiving an order from the LIS, all requests in the sample record are 

created in status Pending. As such, the sample status is set to Pending. 
• The sample is transported to its first target instrument. The instrument queries 

the ADVIA CentraLink system and receives part of the original workorder in 
return. Some requests are promoted to status Scheduled. The sample status 
remains in status Pending. 

• The first instrument uploads results. The scheduled requests are promoted to 
status Review. The sample status remains in status Pending. 

• Some requests are automatically validated based on low severity 
assignments. These requests are promoted to status Validated. The sample 
status remains in status Pending. 
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• The sample is transported to its second and final target instrument. Upon 
query to the ADVIA CentraLink system from the instrument, all requests still 
in status Pending are promoted to status Scheduled. At this point, when all 
requests are scheduled, the sample status is promoted to status Scheduled. 

• The second instrument uploads results. Upon result upload, the sample 
status is in status Review. 

• During a Review and Edit session, all requests still in Review status can be 
validated and then uploaded to the LIS. Once all requests are validated and 
uploaded, the sample status is promoted to Uploaded. 

Browsing All Samples
You can see a list of all samples in the database by sample ID, patient ID, 
collection date/time and physician ID. 
Access the Samples browser window: 
1. At the menu bar, select Start >Routine > Samples > Browse. 

You can also select the Samples icon on the toolbar menu and then select 
OK on the Sample query window. 
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NOTE: If the sample list is very large, the display could take a long time. If it takes 
too long to display a sample list, press CTRL+BREAK to cancel the query.

Viewing the First, Previous, Next, and Last Sample
To move through the selected set of samples and display the corresponding 
Review and Edit window for each sample, select the following toolbar buttons: 

Name Description

First Review and Edit: Displays the first sample record.
Browser: Positions the cursor on the first sample 
and highlights it.
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Previous Review and Edit: Displays the previous sample 
record. 
NOTE: When the Auto-skip feature is enabled, 
samples records that would otherwise appear with 
no test requests on the Review and Edit window due 
to restrictions set by specifying a filter view are 
skipped when you select the Next page/Previous 
page or Next record/Previous record button icons of 
the editing toolbar. For details, refer to Auto 
Skipping Sample Records that Do Not Match Test 
Request Criteria‚ page 141. 
Browser: Positions the cursor on the previous 
sample and highlights it.

Next Review and Edit: Displays the next sample record. 
NOTE: When the Auto-skip feature is enabled, 
sample records that would otherwise appear with no 
test requests on the Review and Edit window due to 
restrictions set by specifying a filter view are skipped 
when you select the Next page/Previous page or 
Next record/Previous record button icons of the 
editing toolbar. For details, refer to Auto Skipping 
Sample Records that Do Not Match Test Request 
Criteria‚ page 141. 
Browser: Positions the cursor on the next sample 
and highlights it.

Last Review and Edit: Displays the last sample record.
Browser: Positions the cursor on the last sample 
and highlights it.

Name Description
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Querying Specific Samples 
The ADVIA CentraLink system database may contain thousands of samples. 
Most of the time you do not want to see all samples, but rather a subset of 
samples based on specified criteria. 
You can specify criteria on the Sample Query window to restrict the samples that 
are accessed. The more selection criteria specified, the smaller the resulting 
record set. Leaving a ? symbol in a field indicates that the field is not used to filter 
the record set the query returns.
You have the option of viewing your query results in standard data view or 
alternate data view: 
• Selected samples with standard data view. The listed data includes sample 

ID, priority, patient ID, collection date/time, physician ID, and status.
• Selected samples with alternate data view. The listed data includes Sample 

ID, Priority, Patient ID and name, Status, LAS seq no, LAS general area, LAS 
specific area, LAS tray id, LAS tray position, and LAS time. 

Regardless of the view in which you want to see your sample result set, you can 
enter search criteria by setting one or more of the fields on the Basic and 
Advanced tabs of the Sample Query window. 
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Access the Sample query editor window: 
1. At the menu bar, select Start > Routine > Samples > Query. 

The Sample query window displays. 
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Basic Tab of Sample Query Window

Field Description

Sample ID When Sample ID is specified, only one single sample 
can be returned by the query. 
The ADVIA CentraLink software supports Sample IDs 
with a maximum of 16 characters.

NOTE: Use caution when using sample ID values 
consisting of 16 uppercase alpha characters. While the 
sample ID is accepted by the ADVIA CentraLink 
software, the 15th and 16th, uppercase, alpha 
characters display as if they were truncated in the 
ADVIA CentraLink software. Upon subsequent retrieval 
of the sample ID at the Sample browser window, the 
16th character does not display, and at the Review and 
Edit window, both the 15th and 16th characters do not 
display. For example, if you enter a sample ID value of 
“ABCDEFGHIJKLMNOP," the sample ID value 
"ABCDEFGHIJKLMNO" would display at the Sample 
browser window and the sample ID value 
"ABCDEFGHIJKLMN" would display at the Review and 
Edit window. 

You can enlarge the size of the Sample browser 
window or Review and Edit window to increase the 
Sample ID field and display the full Sample ID value.
NOTE: For information on resizing windows in the 
ADVIA CentraLink software, refer to Using the 
Workspace‚ page 22.

NOTE: The ADVIA CentraLink system is designed to 
operate in a unique environment. All sample IDs must 
be unique. 
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At least one test in 
Status

By selecting this checkbox, you have the ability to 
select samples with at least one test in a particular 
status. For example in selecting this checkbox and 
selecting REV in the Minimal Status field, all samples 
with at least one test in REV status are returned to the 
Sample browser window.
If you do not select this checkbox, only samples having 
a sample status that corresponds to the search criteria 
in the Minimal status and Maximal status fields are 
returned. 

Field Description
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Minimal status and 
Maximal status

Restricts the eligible sample statuses to a from and to 
range. 
All samples with a status between the Minimal status, 
which is the “from” status value, and Maximal status, 
which is the “to” status value, are returned. For example 
if PND and REV are selected in the Minimal status and 
Maximal status range fields respectively, all samples 
with the following statuses are returned: PND, SCH, 
RRN, REV. 
When the At least one test in Status field is selected 
and the Minimal status and Maximal status fields are 
populated, then all samples with at least one test in the 
status range are returned to the Sample browser 
window. 
When you enter a Minimal status value, the Maximal 
status field is automatically assigned the same status 
value. 
When you enter a Maximal status value, the Minimal 
status value is not affected. 
As a convenience, the Maximal status field value 
automatically changes to Validated (VAL), when any 
restrictions are provided on the following: Instrument or 
Instrument Group; Test or Test Group; Aspiration From 
and To dates. You can modify this automatically 
populated value of VAL to any other status value 
including the ? symbol. 
You are not required to enter a Maximal status value 
when the At least on test in Status checkbox is 
selected. 

Field Description
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Minimal status and 
Maximal status 
(cont’d) 

NOTE:  Exercise caution when entering a Maximal 
status value. You could inadvertently enter a Maximal 
status value that is less than the Minimal status value. 
Under these conditions, the query returns 0 samples. 

As no error message displays under these 
circumstances, recheck the query parameters that you 
selected when queries return no samples. 
If you do not want to specify a status, leave the ? 
symbol displayed in both fields. 

Minimal priority Sets the minimum priority that a sample must have to 
display. The options include the following priorities: 
• Routine
• Stat
• ASAP 

Test group Restricts the result set to samples containing at least 
one request for a test of the specified test group. 
When a value is entered into the Test group field, the 
Test field is disabled. 

Test Restricts the result set to samples containing at least 
one request for the specified test. 
When a value is entered into the Test field, the Test 
group field is disabled.

Collected from and to Restricts the result set to those collected within the 
specified date-time interval. The first field of each pair is 
the date. Double-select to display and select from a 
calendar. The second field is the time in hours and 
minutes.

Species Restricts the result set to a species. 

Patient identifier Restricts the result set to patient ID. 

Field Description
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Patient last name Restricts the result set to patient last name. 

Type Restricts the result set to those of a specified sample 
type. 

Instrument group Restricts the result set to those containing at least one 
request referencing the specified instrument group.

Instrument Restricts the result set to those having at least one 
request for the selected instrument. 
When searching for test requests or results when a 
normal instrument is specified, the query searches for 
the instrument that equals the normal instrument. 
When searching for test requests or results when a 
concentrator is specified, the query searches for the 
instrument and the parent instrument that equals the 
concentrator. 
For details on normal and concentrator instrument 
types, refer to Understanding Instrument Types‚ 
page 286. 

Field Description
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2. Select the Advanced tab for additional fields.
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Advanced Tab of Sample Query Window 

Field Description

Minimal status minutes Entering a time in minutes restricts the result set to 
those having the specified status for equal to or more 
than the specified time in minutes. 

NOTE: Exercise caution when entering a Minimal 
status minutes value. You can enter a Minimal status 
minutes value >= Maximal status minutes value. Under 
these conditions, the query returns 0 samples.

Maximal status 
minutes

Entering a time in minutes restricts the result set to 
those having the specified status for less than or equal 
to the specified time in minutes. 

Physician identifier Restricts the result set to those associated with the 
physician ID.

Physician last name Restricts the result set to those associated with the 
physician’s last name. 

Patient location Restricts the result set to those associated with the 
patient’s location. 

Slide request Slide request parameters include the following choices: 
• Not Required - No restriction to the result set based 

on slide when Not required is selected. 
• Required - Restricts the result set to those with a 

slide request.
• Result Required - Restricts the result set to those 

with a resulted slide request. 
See Understanding Slide Requirements‚ page 75 for 
information on slide processing. 
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Aspirated from and to Restricts the result set to those with at least one 
aspiration time within the specified date-time interval. 
The first field of each pair is the date. Double-select to 
display and select from a calendar. The second field is 
the time in hours and minutes.

Requiring LAS update If selected, restricts the result set to samples requiring 
an update message to the LAS. This query parameter 
is required to set up a command for automatic LAS 
communication. 
See Viewing the Sample Status Overview‚ page 70. 

NOTE: Commands are always associated with a table 
and reference both a query, which determines the 
records for processing, and a function, which 
determines how the records are processed. Automation 
is the unattended execution of pre-configured functions 
on pre-configured queries. When a command is 
defined, your system administrator can create 
associated task records that are scheduled for 
execution by a task scheduler service. 

You can bypass the automatic LAS communication 
feature by manually dispatching a workorder to the 
LAS. See Addressing Perpetual Pending Issues 
through the Dispatch to LAS Function‚ page 83. 

Not reported If selected, restricts the result set to samples that do not 
have any reports. When generating Sample reports, 
you have the option of tagging samples as “Mark as 
reported” to differentiate them as being listed in a 
generated report. 
See Generating a Sample Report‚ page 86 and Mark as 
reported‚ page 90 for more information. 

Field Description
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3. After entering the parameters, select OK to view the search results. 

Viewing the Sample Browser Standard View

Prior to the display of the Sample Query editor window, you have the option of 
viewing your query results in standard data view or alternate data view. If you 
chose to view the query results in standard view, you selected Start > Routine > 
Samples > Query. 

Filter A filter is a logical-valued, sample site function. 
Restricts the result set to those samples for which the 
function returns the value True. 
Here you can select from a list of filters or create a new 
filter. 

NOTE: Specifying filters can degrade performance. 

Max sample count Restricts the maximum number of samples that can be 
returned by the query. Restricting the number of 
returned samples can improve response time for 
queries that result in large test results. 

Sort criterion Specifies the sorting order of the search results. You 
have three sort options:
• Sample ID – default
• Priority – Creation time 
• Instrument time

Field Description
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Through the standard view, the listed data includes sample ID, priority, patient ID, 
collection date/time, physician ID, and status.

To re-enter other search criteria parameters, select Options to re-display the 
Sample Query window. 

Viewing the Sample Browser Alternate View

Prior to the display of the Sample Query editor window, you have the option of 
viewing your query results in standard data view or alternate data view. If you 
chose to view the query results in alternate view, you selected Start > Routine > 
Samples > Query (Alternate View). Through the alternate view, the listed data 
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includes sample ID, priority, patient ID and name, status, LAS SeqNo, LAS 
general area, LAS specific area, LAS tray ID, LAS tray position, and LAS time. 

To re-enter other search criteria parameters, select Options to re-display the 
Sample Query window. 

Finding out More Information about Each Sample
After a query has successfully returned a sample list, you can obtain additional 
information about a sample from the Sample browser window in one of two ways:
• Right-selecting a selected entry to access the context menu
• Double-selecting an entry 
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Using the Right-Select Menu
Right-selecting a selected sample displays the following options: 

Function Description

Check results Applies an automatic check to the results. This function 
is useful when norms or delta norms were modified 
after result entry.

Container type Specifies tube or other container that contains the 
sample. 

Diff Pad Opens the Diff Pad, which allows you to perform a 
manual diff using the keyboard. 
See Understanding the Diff Pad‚ page 73. 

Dispatch to LAS Sends an updated workorder to the LAS. Normally, 
updated workorders are sent to the LAS automatically 
by a task scheduler, which is set up by an administrator. 
See Viewing the Sample Status Overview‚ page 70. 
You can bypass the automatic process with the 
Dispatch to LAS option. 
See Workorder Download‚ page 95 and Dispatch to 
LAS Function‚ page 96. 
See Addressing Perpetual Pending Issues through the 
Dispatch to LAS Function‚ page 83. 

Instrument Last instrument to process the sample. 

Patient Specifies demographic information. 

Patient location If specified, displays patient locations such as ER. 

Physician ID If specified, displays physicians. 

Report Generates a report for a sample. An administrator can 
define report generation to run when all results of a 
sample are validated. 
See Generating a Sample Report‚ page 86. 
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Print label Generates and prints a sample label.
See Generating and Printing Sample Labels‚ page 91. 

Rerun Reruns all tests in the sample. 
NOTE: When you manually initiate a Rerun by right-
selecting the sample or samples, the Dispatch to LAS 
task must be running for the order to be downloaded to 
the LAS. 

Review and Edit Opens the Review and Edit window
See Understanding the Review and Edit Window‚ 
page 102. 

Set Slide Suppression Enables the creation or removal of a suppression 
request for the ADVIA CentraLink system slide test. 
See Setting Slide Suppression‚ page 79. 

Species Opens the Species window and displays the species 
name and description. 

Type Opens the Sample Type window and displays the 
sample type name and description. 

Upload result Opens the Upload results window allowing for you to 
specify the test for upload. 

Upload validated 
results

Uploads validated results to the LIS. A system 
administrator can define automatic upload of the 
validated results to run when all results of a sample are 
validated. 

View image If a sample has an image, you can use this function to 
view it. 

Function Description
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Viewing Sample Details
You can obtain details about the sample by double-selecting an entry in the list to 
display the Order Entry window. For more information on the Order Entry window, 
see Manually Entering a Workorder‚ page 231.
You can obtain an overview of the number of samples in each status category. 
See Viewing the Sample Status Overview‚ page 70. 

Finding a Single Sample
Access the Samples browser: 
1. At the menu bar, select Start > Routine > Samples > Browse. 
2. At the toolbar, select the Find icon.
3. Enter a Sample ID. 
4. Select OK. 

Query LAS status Queries the LAS and provides updated status 
information on the Sample browser (Alternate View) 
window and on the LAS tab of the Order Entry and 
Review and Edit windows. 
See Query Download‚ page 97 and Query LAS Status 
Function‚ page 98. 

Unschedule requests Demotes the status of test requests for which results 
are not received from the instrument from Scheduled to 
Pending or Rerun. 
See Addressing Infinite Schedule issues through the 
Unschedule Function‚ page 81. 

Upload LAS info Manually uploads current LAS information to the LIS. 

Function Description
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Viewing the Sample Status Overview
The Sample Status Overview window allows you to verify the number of samples 
in each status category as well as the total number of samples in the 
database.The Sample Status Overview window displays sample counts grouped 
by status and priority.
The counter values indicate the number of samples in a given status at a given 
point of time. These values, however, do not always represent the exact quantity 
of samples in a given status particularly when there is concurrent activity in other 
sessions or batch processes. During the counting process, other processes may 
add or delete samples or change their status. For performance, uploaded 
samples are not counted directly; their number is obtained by subtracting the 
other counters from the total sample count maintained explicitly in the database. 
Consequently, negative counter values sometimes display on the Sample Status 
Overview window. 
Each possible status value is represented in a row. The unknown row is for 
samples without any associated requests. The right-most column lists the same 
counters, but only displays counter values for samples with priority STAT.
To ensure that the ADVIA CentraLink system database does not grow too large, 
you can monitor it and purge results as necessary.
Access the Sample status overview window: 
1. At the menu bar, select Start > Routine > Samples > Status Overview. 
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The Sample status overview window displays.

NOTE: When the Sample status overview window displays initially, all fields are 
populated with the ? symbol until you select the Refresh button. 

To initiate the count and update the view, select the Refresh button. 
To remove sample and/or worklist records from the database, select the Purge 
button. The Purge data window displays. 
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Purging Sample and Worklist Data from the Database
You can access the Purge data window through the Sample status overview 
window or you can access it as a pulldown option from the System Management 
function. 
NOTE: As an audit log is generated and written to during the manual purge 
process, system performance can be significantly degraded when initiating a 
manual purge. If you purge on a regular basis, contact your local technical 
support provider to configure a task, which can be scheduled to purge 
automatically during off hours so as not to impact response time during peak 
operating hours. Task based purges are not audited. 
Access the Purge data window: 
1. At the Sample status overview window, select Purge. 

To access the window from the System Management window, see Purging 
Data from the Database‚ page 377. 
The Purge data window displays.

At the Purge data window, purge samples from the database as follows:
1. At the Days to keep field, enter the period of time in days for which data is not 

purged.
2. Select the Samples checkbox.

NOTE: If the Samples checkbox is not selected, no sample records are 
purged from the database.

3. Select OK. 

Field Description

Days to keep The period of time, starting from the current date back, 
for which the data is not purged. 

Samples When selected, samples with status Uploaded, Omitted 
or Unknown, that is, those samples without requests, 
and their dependent data are purged. 

Worklists When selected, worklists and their dependent data are 
purged. 
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Understanding the Diff Pad
The Diff Pad function allows you to use designated keys on the computer 
keyboard to increment counters for different blood cell types. You can open the 
Diff Pad, the virtual blood differential counter, from any Sample browser window 
or from the Review and Edit window. 
Although no physical instrument is in actual use, a differential counter is 
represented in the ADVIA CentraLink system by an instrument record. Instrument 
records become eligible as counters when one or more of their contained 
methods have their counter key label field set. The ADVIA CentraLink system 
comes pre-configured with a single counter-type instrument called Diff Pad. You 
can add other counter-type instruments. 
The Diff Pad function can be used whether or not the corresponding tests have 
already been requested or if the instrument results already exist. If the tests have 
not been requested, the ADVIA CentraLink system automatically adds the tests 
to the request when the Diff Pad is used. 

Using the Diff Pad 
If no instrument is specified in the Diff Pad field on the More tab of the system 
Options window, you must enter an instrument to use the Diff Pad. If you attempt 
to right-select on a selected sample in the Sample browser window before 
specifying an instrument in the Diff Pad field, a list of instruments displays from 
which you can select an instrument counter. Should you select an instrument that 
is not setup correctly for counters, the following warning message displays: None 
of the contained methods have an associated counter key. 
When a Diff Pad value is specified in the Diff Pad field on the More tab of the 
system Options window, the Sample Counter window displays. This window 
consists of the following two lists, which can be updated: 
• Contained methods that have counter key labels defined. In the case of the 

pre-configured DiffPad instrument, it contains the typical white blood cell 
types. 

• Contained methods that do not have counter key labels defined. If the counter 
instrument is properly configured with additional methods, this list can be 
used to view related results. 
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Upon display of this window, available results are displayed first. These results 
can include those obtained from a real instrument. You can select Reset to reset 
all counters to zero.
Navigate to the Diff Pad:
1. At the Sample browser window, right-select the selected entry and select Diff 

pad. 
The Diff Pad window displays. 

2. While looking through the microscope, use the keyboard to count the different 
cell types. 
Press the appropriate key to increment the cell count by one. If you make a 
mistake or want to restart the count, select the Reset button on the counter 
window to set all the counts to zero. 
When a total of 100 cells has been counted, you hear a signal indicating that 
sufficient data is available. 
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3. Select OK.
NOTE: To see the Diff Pad count reflected on the Review and Edit window, close 
the Review and Edit window and reopen it. 

Understanding Slide Requirements
The ADVIA CentraLink system provides support for communication with the 
ADVIA 2120 Autoslide. Slides are implemented as special tests. 
You have the following slide function capabilities through the ADVIA CentraLink 
system: 
• Order a slide and communicate this request to the instrument.
• Set the Set slide suppression command and communicate this information to 

the instrument to prevent slides from being generated.
• Reorder a slide on the same existing sample without having to generate a 

new workorder on the sample. 
• Search the database and retrieve samples that have either a result generated 

for the slide or a request for a slide regardless of sample status.

Defining the Test for Slide Processing 
Slides are implemented as special tests. By default, the ADVIA CentraLink 
system is preconfigured with the slide test defined for slide processing on the 
ADVIA 2120 Autoslide. 
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“Whole blood” is typically configured as the sample type that allows for 
processing slide requests and displaying slide information. You can configure 
only one sample type to the test that is specified as the slide test. 

For example, define the slide processing test with a sample type of Whole blood: 

See Configuring Test Settings‚ page 243 for more information on defining tests. 

Defining Slide Setup
At this point, the slide test is defined as a test for slide processing and the name 
of the slide test, Slide, is assigned to the Slide test field on the More tab of the 
system Options window. In addition, the slide information is defined on the Slide 
setup window for processing slide requests. 

Test name Sample Type

Slide Whole blood
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Access the Slide Setup window:
1. At the menu bar, select Start > Configuration > Setup slide.

The Slide setup window displays. 

Field Description

Test Reference to the name of the test defined for 
representing slide preparation.
In the above example, Slide is the name of the slide 
test.

Allow LIS download If selected, the ADVIA CentraLink system accepts slide 
requests from the LIS. 
If not selected, the ADVIA CentraLink system does not 
accept slide requests from the LIS. You must enter slide 
requests manually or through reflex testing. 
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Defining the Slide Requirements on the Sample Query window
When initiating a sample query, you specify your slide requirements through the 
Slide Request field on the Advanced tab of the Sample Query window. You can 
specify the following options: 

LIS upload mode Select one of the following options: 
• Suppress – Do not allow slide upload information to 

the LIS. 
• Allow manual only – Allow slide upload information 

to the LIS from the Review and Edit window via the 
Upload button or from the Sample window via right-
selecting and accessing the Upload result window. 

• Allow always – Allows automatic slide upload 
information to the LIS. 

NOTE: The instrument sends the following slide test 
result values back to the ADVIA CentraLink system: 
Req., Prod., and Fail. Based on predefined result 
choices, the ADVIA CentraLink system converts these 
result values to the following: Requested, Produced, 
and Failed. 

Affects sample status If selected, the presence of a slide test within a sample 
does not prevent auto validation of all tests within that 
sample. 
If not selected, the presence of a slide test within a 
sample prevents auto validation of all tests within that 
sample.

NOTE: The Affect sample status functionality is not 
retroactive. If the Affects sample status checkbox is 
selected or unselected within the life cycle of a given 
sample, the changed functionality does not affect the 
existing slide or its test requests. 

Field Description
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• Not Required – Result set is not restricted to slide requests or resulted slide 
requests. 

• Required – Result set is restricted to slide requests. 
• Result required – Result set is restricted to resulted slide requests. 

After the query is run through the Sample Query window and the sample(s) 
display on the Review and Edit window, you can append a comment to a slide 
request as you would to any other test request. Comments are appended by 
right-selecting on the selected slide request and selecting Edit Comments. 
See Appending a Comment to a Request‚ page 152 for more information. 

Setting Slide Suppression
You can create or remove a suppression request for the slide test. The Set slide 
suppression function enables a request for slide suppression in workorders to 
certain instruments including the ADVIA 2120 Autoslide. On setting slide 
suppression on a sample, a NoSlide command is sent to the SMS instrument 
upon instrument query. If a sample meets the slide criteria but a NoSlide 
command is sent to the instrument within the workorder download message, the 
SMS instrument does not make a slide for the sample. 
NOTE: The Set slide suppression function only suppresses slide creation when 
the Set slide suppression function is specified prior to instrument query. If Set 
slide suppression is specified after instrument query for workorders, the 
requirement is unknown to the instrument and slide creation is not suppressed.
To set up slide suppression navigate to the following window:
1. At the Sample browser window, right-select the selected entry and select Set 

slide suppression.
The Set slide suppression window displays. 
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Considering Slide Sample Statuses
The following statuses exist for a slide sample: 

Field Description

Suppress If selected, slide suppression is enabled for the current 
sample. A NoSlide command is sent to the SMS 
instrument upon instrument query for the respective 
SID. Even if the sample meets the slide criteria, the 
SMS instrument does not make a slide for the sample. 
If not selected, slide suppression is reenabled if 
previously enabled for the current sample. If the sample 
meets the slide criteria, the SMS instrument can make 
a slide for the sample. 

Status Description

Pending When a slide request is created. The slide request 
exists in a workorder from the LIS, or the slide request 
was created manually. The request was not sent to the 
instrument. 

Scheduled The slide request exists and was sent to the instrument. 

 Review The slide request was processed at the instrument. The 
result value of Req. Prod. or Fail. is assigned to the 
slide test request and is sent back to the 
ADVIA CentraLink system.

Validated The result value assigned to the slide test request is 
validated. 

Uploaded The slide request has been uploaded to the LIS. 
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Resolving Scheduling Issues 
Addressing Infinite Schedule issues through the Unschedule Function
The Unschedule function addresses “infinite scheduling” issues by enabling the 
rerouting of samples to the instrument for those samples for which the 
ADVIA CentraLink system never received results from the instrument. 
For those requests that remain in status Scheduled indefinitely without a result 
message from the instrument, you can select Unschedule from the context menu 
of the Sample browser window, the Review and Edit window, or the Request 
window. 
By invoking the Unschedule command at the sample level or the request level, 
the following demotions of Scheduled requests occur depending on the 
availability of a previous result:
• Test requests that do not have previous results are demoted from status 

Scheduled to status Pending. 

Omitted When a slide request is cancelled. To be eligible for 
omission, a slide request can be in any status other 
than Uploaded. 
Pending – When a slide request is Pending and is 
omitted, the request is not sent to the instrument. 
Scheduled – When the slide request is Scheduled, 
exists at the instrument, and is omitted, the slide 
request is not accepted back at the ADVIA CentraLink 
system. 

Rerun The slide request is rerun. Slide requests in status 
Validated or Uploaded can be rerun when the Allow 
manual rerun all field on the Review tab of the system 
Options window is selected. 

NOTE: Your local technical support provider can code a 
MISPL function to automatically rerun a slide request.

Status Description
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• Test requests that have previous results are demoted from status Scheduled 
to status Rerun. 

• Upon reschedule, the ADVIA CentraLink system sends an updated message 
to the LAS, which reroutes the samples to the instrument. 

You can specifically query the number of Scheduled requests for which results 
have not been returned for a specified amount of time from the Sample query 
window. On the Basic tab of the Sample Query window, select Scheduled in the 
Minimal status and Maximal status fields. On the Advanced tab of the Sample 
Query window, enter the minimum amount of time for which a request must be in 
status Scheduled and for which no results are received from the instrument. Test 
requests that are in status Scheduled for longer than the specified time are 
displayed through the Sample browser window. 
Unschedule a test request for which results have not been received from the 
instrument: 
1. At the Sample browser window, right-select the selected entry and select 

Unschedule. 
The Unschedule requests window displays. 

NOTE: At the Request window, right-select and select Unschedule. When 
invoking the Unschedule command at the request level, an Unschedule requests 
window does not display. 

Field Description

Instrument The instrument for which you want to unschedule 
requests. 
If the instrument is not specified, all scheduled requests 
for the sample are unscheduled. 
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Addressing Perpetual Pending Issues through the Dispatch to LAS Function
The Dispatch to LAS function addresses “perpetual pending” issues by allowing 
requests that are in status Pending and Rerun to be sent to the LAS. Ultimately, 
the associated samples are rerouted to the instruments again. 
For those requests that are in status Pending and Rerun, you can select Dispatch 
to LAS from the context menu of the Sample browser window or the Review and 
Edit Request window. 
You can specifically query requests that are in Pending status for a specified 
amount of time from the Sample query window. On the Basic tab of the Sample 
Query window, select PND in the Minimal Status and Maximal Status fields. On 
the Advanced tab of the Sample Query window, enter the minimum amount of 
time for which a request must be in status Pending. Test requests that are in 
status Pending for longer than the specified time are displayed through the 
Sample browser window. 
Send a Pending or Rerun test request to the LAS: 
1. At the Sample browser window, right-select the selected entry and select 

Dispatch to LAS. 
The Dispatch to LAS window displays.

Field Description

Target Determines to which LAS system the sample workorder 
is dispatched.
Valid values include the following: 
1 – Dispatched to LabCell 1. 
2 – Dispatched to LabCell 2. 
All – Dispatched to both LabCell systems. 



 

84 ADVIA CentraLink Operator’s Guide

Addressing Scheduled Twice Issues through the Enable Rescheduling Checkbox
The Enable Rescheduling checkbox addresses “scheduled twice” issues by 
allowing for instruments to rerun test requests when the test request has already 
been scheduled to another instrument. 
When the Enable rescheduling checkbox is not selected, ADVIA CentraLink does 
not download workorders upon instrument query when the test request has been 
scheduled to another instrument. 
Access the Enable Rescheduling checkbox on the Instrument window: 
1. At the menu bar, select Start > Configuration > Instruments. 
2. Double-select the appropriate instrument. 
3. Select or deselect the Enable Rescheduling checkbox. 
NOTE: The recommendation is to not select the Enable Rescheduling checkbox. 

Viewing the Sample Log Records
The Sample Log table contains an audit trail of information from the LAS to the 
ADVIA CentraLink system. 
When samples are purged from the database, all associated data from the 
Sample Log table is purged. 

Accessing Logs of Sample Window
Access records from the Sample Log table: 
1. At the Sample browser window, right-select the selected entry and select 

Logs. 
The Logs of sample window displays. 

Include dispatched If selected, the message to the LAS includes requests 
that were previously dispatched to the instrument and 
are not in status Review. 

Field Description
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Accessing Sample Log Editor Window
1. To access the Sample log editor window, double-select on the applicable log 

entry. 
The Sample log editor window displays. 

Field Description

Sample Reference to the containing sample. 



 

86 ADVIA CentraLink Operator’s Guide

Generating a Sample Report 
The Report window enables you to generate reports on samples and to print or 
fax the report. Depending on whether you print or fax the report, the report format 
can be text or HTML. 
Although the text and HTML formats generate reports that look different, the 
general layout and information content is the same in both formats. The content 
of the generated Sample report is determined by the report model. You can 
define different report models for use with different reports. 
The ADVIA CentraLink system uses the following logic in determining which 
report model to use for a given sample: 
• If a sample references a physician and the physician references a report 

model, then the report model referenced by the physician is used. 
• Else, if the Report model field on the More tab of the system Options window 

specifies a report model, then this report model is used. 

Effective time This value is used to sort the logs. The effective time 
value can either be the time that is transmitted by the 
LAS or the actual transmission time. 

Instrument Reference to the instrument.

Instrument rack Instrument rack as received from the referenced 
instrument. 

Instrument position Instrument position as received from the referenced 
instrument. 

LAS seq. no. Identifies which LAS supplied the message: LAS1 or 
LAS2. 

Status, tray id, tray 
position, general area, 
shelf, door, area, gate

Values as reported by the LAS. 

Field Description
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• Else, a built-in report model, which cannot be configured, is used. This 
generic function, accessible from Record > Report, enables you to generate 
simple multiple-record text reports with dynamic content. 

Select each of the samples that you want to report on by highlighting the sample 
and pressing the space bar. To select all the samples in the browser, select the 
Select all icon on the editing toolbar. A selection arrow (>) displays next to each 
selected sample. 
For information on defining report models, which allow you to configure header, 
body, and footer information, see Configuring a Report Model‚ page 328. 
Generate a Sample report: 
1. At the Sample editor window, right-select the selected entry and select 

Report. 
The Report window displays. 
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Field Description 

Format Select HTML or Text. 
The text format requires a line width of up to 132 
characters. Ensure that your Windows font or page 
orientation settings are properly set to avoid text 
wrapping. 
Graphs are available in HTML format only. The graphs 
might not display properly when scrolling during 
preview.
NOTE: This field is disabled and Text displays when the 
Via fax checkbox field is selected. 

Preview If selected, a screen preview of the generated report is 
displayed. 
When the specified format is HTML, a web browser is 
used for previewing the generated HTML report. 
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Via fax If selected, enables you to fax a report generated by the 
ADVIA CentraLink software through an external fax 
software package. 
When selected, the Format and Printer fields are 
disabled. 
Upon report generation, the sample file is output to the 
fax software, not to the printer. 
When a report model is defined, the 
ReportModel.FaxHeader text is added as the header. 
When a report model is not defined, a default header 
that includes patient identifier and name as well as 
physician name and fax number is used. 

The way in which the file is sent to the fax system, is 
defined as a command in the Fax command field at the 
system Options window. In this command, the token &1 
is replaced by the full file name, &2 is replaced by the 
base file name without a directory path, and &3 is 
replaced by the chosen fax number. 
Example: “FaxCommand FullFile=&1 BaseFile=&2 
Fax=&3” or “copy &1 \\zetafax-xp\ZFAX\SERVER\Z-
TEMP\&2.sub” 

Printer The printer reference applies only when the specified 
format is Text. References the printer to which the text 
output is directed. 
When the specified format is HTML, the Windows 
environment determines the printer. 
NOTE: This field is disabled when the Via fax checkbox 
field is selected. 

Field Description 
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NOTE: Your system administrator can establish automatic reporting by defining a 
reporting command, which can be scheduled to run automatically. Commands 
are always associated with a table and reference both a query, which determines 
the records for processing, and a function, which determines how the records are 
processed. The format setting of text or HTML is specified through command 
parameters. Do not use the format setting of HTML for automatic reporting. Due 
to the extensive use of system resources, the HTML format setting degrades 
ADVIA CentraLink server performance. 

For details on setting up automatic reporting, contact your local technical support 
provider.

Fax number By default when one sample is selected, the fax 
number specified in the Fax number field at the 
Physicians window automatically populates this field. 
You can also enter a different fax number, which 
overrides the fax number specified in the Fax Number 
field at the Physicians window. 
When more than one sample is selected, the ? symbol 
populates the Fax number field. If you do not enter a fax 
number value, the fax is sent to the fax number 
specified in the Fax number field at the Physicians 
window for the sample. 
Refer to Accessing Physician Records‚ page 239. 
NOTE: Do not specify special characters, for example, 
+ or -, among the numerical values specified in the fax 
number field. Spaces are permitted between numbers, 
for example, 0032 9 220 48 10. 

Mark as reported If selected, the sample record is marked as having 
been reported. 
When a sample record is marked as reported, it is not 
accessed when a sample query is initiated from the 
Sample Query window and the Not reported parameter 
on the Advanced tab is selected. 

Field Description 
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Generating and Printing Sample Labels
The Print label window enables you to generate and print sample labels. 
To generate sample labels, the definition that defines the sample label text must 
be specified on the Label definition field on the More tab of the systems Option 
window. 
Generate and print a Sample label: 
1. At the Sample editor window, right-select the selected entry and select Print 

label. 
The Print label window displays. 

Field Description

Preview A preview of the expanded label displays before the 
sample label is printed. 

Printer Specifies the printer to which the generated sample 
label is output. 
NOTE: Upon sample label print, the dynamic text within 
the label definition defined on the More tab of the 
system Options window is expanded and the output is 
stored in a .lbl file before the label output is sent to the 
specified printer. 
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Supported Two-Way Communication 
The ADVIA CentraLink software supports two-way communication between the 
following interfaces:
• The LIS and the ADVIA CentraLink software 
• The ADVIA CentraLink software and the LAS
• The ADVIA CentraLink software and the instruments

NOTE: The units of measure for a given test must be defined identically at the 
LIS, in the ADVIA CentraLink software, and at the instruments. The units for test 
results uploaded from the instrument are not read by the ADVIA CentraLink 
software. You must predefine the units for tests in the ADVIA CentraLink software 
to match the units for tests on the instrument. If units of measure of results are 
manually changed on an instrument, you must change the units of measure for 
the test in the ADVIA CentraLink software at that time. In addition, you must 
purge all existing results for the test from the ADVIA CentraLink software. Units of 
measure are not uploaded to the LIS from the ADVIA CentraLink software. 

Communication: LIS and the ADVIA CentraLink Software
Two-way communication between the LIS and the ADVIA CentraLink software 
exists. 
You have the option of configuring 2 separate communication channels with a 
single LIS to enable concurrent downloading of workorder data from the LIS to 
the ADVIA CentraLink software and uploading of result data and LAS status 
information from the ADVIA CentraLink software to the LIS. While the 2 
communication channel configuration is not required, the duplicate 
communication channels improve communication efficiency for LIS that are 
capable of supporting dual channels.
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Should you elect to have the 2 communication channel configuration, a separate 
Inbound Translator value and an Outbound Translator value is specified on the 
LIS1 tab of the system Options window. 

A single communication channel configuration, however, can be maintained for 
LIS that do not support dual-channel configuration. 
The ADVIA CentraLink system has the ability to send accessioning information, 
which is also known as inlabbing information, that it receives from the LAS to the 
LIS. Inlabbing information is sent by the LAS to the ADVIA CentraLink system 
when sample barcodes are read on the automation system. This inlabbing 
information serves as notification to the ADVIA CentraLink system that the 
sample is in the lab. Inlabbing information can be sent to the LIS from the 
ADVIA CentraLink system only once and is sent before result upload to the LIS. 
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The ADVIA CentraLink software can be configured to upload to the LIS sample 
archive and location information for each sample for which it receives information 
from the LAS. You have the ability to upload this sample archive and location 
information as many times as the ADVIA CentraLink software receives cold 
storage message updates from the LAS. 
Refer to Update LAS Info Upload: ADVIA CentraLink Software to LIS‚ page 100. 

Communication: ADVIA CentraLink System and the LAS
Two-way communication can be established between the ADVIA CentraLink 
system and the LAS. 
The ADVIA CentraLink system can download workorders to the LAS or query the 
LAS for sample location information; the LAS sample status updates are 
uploaded to the ADVIA CentraLink system and are available through the Sample 
browser (Alternate View) window, the LAS tab of the Review and Edit window, 
and the LAS tab of the Order Entry window. 
Refer to Workorder and Query Download from ADVIA CentraLink Software to the 
LAS‚ page 95 and to LAS Sample Status Update Upload from the LAS to the 
ADVIA CentraLink Software‚ page 99. 

Configuring Two Automation Systems
ADVIA CentraLink software supports the ability to configure a second automation 
system. 
When 2 automation systems are configured, the ADVIA CentraLink software 
receives all download orders from the LIS and sends all orders to both 
ADVIA LabCell systems. If one automation system is temporarily not accepting 
orders, upon reestablishing communication with the previously inoperable 
system, ADVIA CentraLink sends previously unsent orders to this LAS as well. 
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The LAS configuration fields on the LAS tab of the system Options window are 
duplicated to provide support for the second automation system.

Workorder and Query Download from ADVIA CentraLink Software to the LAS
The communication between the ADVIA CentraLink system and the LAS consists 
of workorder downloads, query downloads, and LAS sample status update 
uploads. 
Each of these communication messages uses a separate translator–order 
translator, status query translator, and status update translator–which are defined 
on the LAS tab of the system Options window.

Workorder Download
Workorders that are created within the LIS or within the ADVIA CentraLink 
system are sent to the LAS. Workorder messages sent to the LAS do not contain 
an instrument specification unless an instrument was explicitly specified when 
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initiating an Advanced Rerun. See Setting Up Advanced Reruns‚ page 157 for 
information on Advanced Reruns. 

Dispatch to LAS Function
The Dispatch to LAS function sends workorders to the LAS. 
Automatic Dispatch to LAS
Typically this function is defined as a an automated command run by a task and 
is assigned to a task scheduler, which initiates the appropriate Dispatch to LAS 
command at the specific time on all samples requiring LAS update. 
NOTE: When you manually initiate a Rerun by right-selecting the sample or 
samples, the Dispatch to LAS task must be running for the order to be 
downloaded to the LAS. 

When 2 lab automation systems are configured, the Dispatch to LAS function 
automatically sends workorders to both LAS. 
Your local technical support provider can configure a DeleteRouteOnLAS MISPL 
that is triggered through the Dispatch to LAS function. This DeleteRouteOnLAS 
MISPL extends the ability to delete an outstanding request on 1 LAS after the 
request is processed either on the other LAS, or offline. 
Upon executing the Dispatch to LAS function, the delete command is 
downloaded to 1 LAS if you have a 1 LAS configuration or to both LAS if you 
have a 2 LAS configuration. Upon receipt of the delete command, the Route 
status for the request is changed to Deleted in the LineMaster software and the 
sample is no longer routed to an instrument for that specific test request. Upon 
request deletion, a comment can be added to the user comment field of the 
request. 
The DeleteRouteOnLAS command is not limited by sample status. For example, 
the delete command can be activated on a request in status Uploaded.
The status of the request within the ADVIA CentraLink software remains 
unchanged. 
Manual Dispatch to LAS
You can also manually initiate the Dispatch to LAS option. This option enables 
you to manually send an updated workorder to the LAS. 
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Initiate a workorder download: 
1. At the Sample browser window, right-select a selected entry and select 

Dispatch to LAS.
The Dispatch to LAS window displays. 

Query Download
A query download consists of a request for the status of samples on the LAS.
Sample status query messages are sent directly from the ADVIA CentraLink 
system to the status query translator. No status update response is expected on 
the query channel. The sample status update message is received into the 
database from the sample status update translator and translator server running 
in batch mode at a later time.
NOTE: The Record Passed message that displays after a query is run indicates 
that the sample status query message was sent to the LAS. It does not indicate 
that an update message was uploaded from the LAS to the ADVIA CentraLink 
system. 

Field Description

Target Determines to which LAS system the sample workorder 
is dispatched.
Valid values include the following: 1, 2, All. 

Include dispatched If selected, the message to the LAS includes requests 
that were previously dispatched to the instrument and 
are not in status Review. 
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Send a Query Download Message to the LAS 
You can send a query to the LAS requesting an update on the selected sample 
records or on the focused sample record. 
Initiate a LAS status query: 
1. At the Sample browser window, right-select a selected entry and select 

Query LAS status. 
The Query LAS status window displays. 

Query LAS Status Function
After the query is initiated from the Sample browser window, the Query LAS 
status function sends the status query message to the LAS. 
When 2 lab automation systems are configured, the Query LAS status function 
sends the status query message to both LAS systems. The LASSeqNo 
parameter specifies to which LAS system you send the status query message. If 
the LASSeqNo parameter is set to All, both automation systems receive the 
message.
In response to the query LAS status message, the query translator sends an 
acknowledgement to the requesting process. 
After initiating a query you can view updated LAS status information from the 
following windows: 
• At the Sample browser (Alternate View) window, refresh the targeted sample 

record or records to see the updated LAS information. 

Field Description

Target Determines to which LAS system the sample workorder 
is dispatched.
Valid values include the following: 1, 2, All. 
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• At the Sample browser window, you can double-select a selected record and 
view the updated LAS information on the LAS tab of the Order Entry window. 

• At the LAS tab of the Review and Edit window.

LAS Sample Status Update Upload from the LAS to the ADVIA CentraLink Software 
A LAS sample status update message consists of the current status of a sample 
on the LAS. This LAS sample status update message is uploaded from the LAS 
to the ADVIA CentraLink system. 
The LAS sample status update upload is initiated in response to a Query LAS 
status request or is uploaded automatically when a sample is checked in to the 
LAS; reaches an end of route location, such as a Sample Manager Unload tray; 
or is archived to Cold Storage within the LineMaster software. 
The LAS status information is stored in the Sample Log table and displays 
through the following windows: 
• Sample Editor window
• Review and Edit window at the Advanced tab and the LAS tab
• Logs of sample browser window
• Sample log editor window
• Sample Query (Alternate View) window

The SeqNo field value of the following windows in the ADVIA CentraLink 
software are updated automatically and identify the LAS system that updated the 
LAS information: 
• Sample Editor window. This window is also referred to as the Manual Order 

Entry window. Refer to Updated LAS Information Uploaded to Fields on LAS 
Tab‚ page 236. 

• Review and Edit window. Refer to Advanced Tab‚ page 114 and LAS Tab‚ 
page 115. 

• Logs of sample browser window. Refer to Accessing Logs of Sample 
Window‚ page 84. 

• Sample Log editor. Refer to Accessing Sample Log Editor Window‚ page 85. 
• Sample Query (Alternate View). Refer to Viewing the Sample Browser 

Alternate View‚ page 65. 
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Update LAS Info Upload: ADVIA CentraLink Software to LIS
You have the ability to upload accessioning information, which is also known as 
inlabbing information, as well as sample archive and location information, which 
is also referred to as cold storage information, from the ADVIA CentraLink 
software to the LIS. While inlabbing information can only be uploaded once, 
sample archive and location information can be uploaded as many times as the 
ADVIA CentraLink software receives cold storage message updates from the 
LAS. 
The ADVIA CentraLink software could receive an additional cold storage update 
from the LAS, for example, when a sample tube is removed from cold storage, 
rechecked into the track, and returned to cold storage after sample testing is 
complete. 

Update LAS Info Function
The Upload LAS Info function can be configured to automatically upload 
inlabbing and cold storage information from the ADVIA CentraLink software to 
the LIS through upload messages. Inlabbing information is the auto-receipt 
registration of samples checked in to the LAS. Inlabbing information includes the 
SID, registration date and time stamp, and location of the sample tube. 
If available, the archival cold storage information can include Shelf, Door, Area, 
Tray ID, and Tray Position values. You can specify whether shelf, door, and area 
information are uploaded via the Upload LAS info window. 
Inlabbing information can be sent from the ADVIA CentraLink software to the LIS 
only once and must be sent before result upload to the LIS. When 2 automation 
systems are configured, the ADVIA CentraLink software can accept more than 
one inlabbing message, but the Update LAS Information function only uploads to 
the LIS the first inlabbing message received from one of the 2 automation 
systems. 
Cold storage information can be sent from the ADVIA CentraLink software to the 
LIS as many times as a cold storage update is sent from the LAS to the 
ADVIA CentraLink software. In order for the LAS to send cold storage information 
to the ADVIA CentraLink software, a tray of sample tubes must be removed from 
the Sample Manager and archived to a defined cold storage location within the 
LineMaster software. 
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The Upload LAS info window can be configured to specify whether shelf, door, or 
area information is uploaded in the message. 
1. At the Sample browser window, right-select the selected entry and select 

Upload LAS info. 
The Upload LAS info window displays. 

 

NOTE: To prevent the occurrence of a deadlock caused by attempts to access 
the same data, do not initiate a manual Upload LAS info function while an 
automatic LIS Upload task is running. 

Field Description

Include shelf Determines whether the sample tube’s cold storage 
shelf is included in the upload message. 

Include door Determines whether the sample tube’s cold storage 
door is included in the upload message. 

Include area Determines whether the sample tube’s cold storage 
area is included in the upload message. 
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Understanding the Review and Edit Window
You can review, modify, and disposition test results from connected instruments 
through the Review and Edit window. 
Several options exist for accessing the Review and Edit window. Those options 
that include entering criteria to restrict the display on the Review and Edit window 
for a given sample set include the following: 

Review and Edit Access through Sample Query Window
To access the Review and Edit window through the Sample query window, you 
must first enter sample query selection criteria. On the Sample query window, 
you enter parameters that restrict the sample set for this query only. Upon 

Window Type/Icon Option

Sample query window Allows you to enter sample query criteria and restrict 
the sample set that displays on the Review and Edit 
window for the current sample query only. 

Review and Edit 
window refreshed with 
test result criteria from 
the Request Query 
option

Allows you to restrict the test results displayed in the 
Tests and Results area of the Review and Edit window 
for the current sample set. The parameters for this 
restricted sample result set apply until the current 
Review and Edit window session ends.

Toolbar icon that 
contains configured 
sample query criteria 
and test request 
criteria 

Initiating a single select of a configured toolbar button 
allows you to directly access a prepopulated R&E 
window, which displays the current sample set that 
meets the defined sample and test request criteria 
referenced upon selecting the configured toolbar 
button. The parameters for this restricted sample result 
set applies to all queries initiated by selecting this 
configured toolbar icon until you define new sample 
query and request parameters and associate them with 
the configured toolbar icon. Toolbar icons can be 
configured by users with system manager privileges. 
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selecting OK, the test results that meet the requirements of the sample 
parameters are displayed through the Review and Edit window. 
Access the Review and Edit window through the Sample query window: 
1. At the menu bar, select Start > Routine > Review & Edit. 

You can also select the Review and Edit icon at the toolbar menu. 
NOTE: If you do not enter parameters to the Sample query window, by 
default all samples with a status of Review are accessed and are available for 
display through the Review and Edit window. Use the navigation buttons on 
the toolbar to navigate from one sample to the next. 
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The Sample query window displays.

For details on the fields of the Sample query window, refer to Basic Tab of 
Sample Query Window‚ page 56 and Advanced Tab of Sample Query 
Window‚ page 62. 

2. After entering the parameters and selecting OK, the Review and Edit window 
displays. 
Only one sample ID with all of its associated test results displays on the 
window at any given time. Using the navigation buttons on the toolbar, you 
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can navigate between samples on the Review and Edit window that match 
the query criteria entered on the Sample Query editor window.

NOTE: Upon reviewing a test result, you may find that an error message 
displays. Upon display of an error message, you can cancel out of this error and 
continue reviewing other test results within the sample. 

The ADVIA CentraLink system does not display disposition codes on results from 
the ADVIA 120/2120 system. If a result is manually edited at the ADVIA 120/2120 
system and then sent to the ADVIA CentraLink system, there is no indication in 
the ADVIA CentraLink system that the result was edited.

Areas of Review and Edit Window

1 Demographics

2 Tests and results

3 Disposition
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For details on the areas and fields of the Review and Edit window, see Areas and 
Fields of the Review and Edit Window‚ page 112. 

Review and Edit Window Refresh Using the 
Request Query Option
At the Review and Edit window, you can restrict the test results displayed in the 
Tests and Results area for the current sample set. 
To limit the display of test results within the current sample set to those that meet 
specified test request criteria, access the Request Query window from the 
Review and Edit window. The parameters for this restricted sample result set 
apply until the current Review and Edit window session ends.
Access the Request query window: 

1. At the Review and Edit window, select the Options button. 
The Request query window displays. 

For details on the fields of the Request query window, refer to Fields of the 
Request Query Window‚ page 140. 

2. After entering the test request criteria that will restrict the test results within 
the sample set, select OK. 
The refreshed Review and Edit window displays. 
The results that display in the Test and Results area are restricted to meet the 
request query parameters entered to the Request Query window. The 
parameters for this restricted sample result set apply until the current Review 
and Edit window session ends. 
For details on the areas and fields of the Review and Edit window, see Areas 
and Fields of the Review and Edit Window‚ page 112. 
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Review and Edit Access through Configured Toolbar Icon 
After creating a configured toolbar icon and associating sample query and test 
request parameters to it, you can select the toolbar icon and directly access the 
Review & Edit window populated with the sample set that meets your predefined 
sample query and test request parameters. 
Each time you select the configured toolbar icon, the same sample query and test 
request parameters are reused until you chose to define new sample query and 
request parameters via the Review and Edit - Query setup window and associate 
these parameters with the configured toolbar icon. 

Create Toolbar Icon
Create a toolbar icon to which you will associate sample query and test request 
criteria: 
1. At the menu bar, select Start > System Management > Menu > Toolbar 

buttons. 
The Toolbar button browser window displays. 

2. At the toolbar menu, select the New icon or press the Insert button. 
The Toolbar button editor window displays. 

3. At the Function table field, double-select the ? symbol.
The Tables browser displays.

4. Double-select gp_Site
5. At the Function mnemonic field, double-select the ? symbol. 

The Functions defined on table browser displays. 
6. Double-select ReviewAndEdit.

The Function mnemonic field of the Toolbar buttons window is populated with 
ReviewAndEdit. 

7. At the Function parameter set field, double-select the ? symbol. 
The Actual parameter sets of function browser displays. 

8. At the toolbar menu, select the New icon or press the Insert button. 
The Actual function parameter set editor window displays. 



 

108 ADVIA CentraLink Operator’s Guide

The Function table field and Function mnemonic fields are populated with the 
values that you had just entered: gp_Site and ReivewAndEdit respectively. 

9. At the Short description field, enter a descriptive term. 
The maximum number of characters for the Short Description field is 50 
characters. 
Enter a descriptive term that accurately reflects the function of the toolbar. 
The term should signify the sample set that is accessed as per the predefined 
sample query and test query parameters that are automatically referenced 
upon toolbar icon selection and that will populate the Review and Edit 
window.
For example, if you are creating the toolbar button to view a prepopulated 
Review and Edit window that contains current sample query and test request 
criteria for chemistry samples, enter ReviewCHEM. 

Define and Associate Sample Query and Test Request Criteria to Toolbar Icon
Define sample query and test request criteria and associate these parameters to 
the created toolbar icon: 
1. At the Actual parameter sets of function browser, highlight the newly created 

parameter set, right-select, and select Setup. 
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The Review and Edit - Query setup displays. 

2. At the Basic and Advanced tabs, enter the sample query parameters that will 
restrict the sample set as per your requirements. 
The Basic and Advanced tabs of the Review and Edit - Query setup window 
contain each of the fields of the Basic and Advanced tabs of the Sample 
query window. 
For details on the fields of the Sample query window, refer to Basic Tab of 
Sample Query Window‚ page 56 and Advanced Tab of Sample Query 
Window‚ page 62. 
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NOTE: On the Basic tab of the Review and Edit - Query setup window, the 
status values do not display to the right of the Minimal and Maximal status 
fields although these values do display on the Basic tab of the Sample Query 
window.

3. At the Requests tab, enter the test request parameters that will restrict the 
test results within the restricted sample set. 
The Request tab of the Review and Edit - Query setup window contains each 
of the fields of the Request query window. 
For details on the fields of the Request query window, refer to Fields of the 
Request Query Window‚ page 140. 

4. After entering all of the sample query and test request parameters at the 
Review and Edit - Query setup window, select OK. 
The Actual parameter sets of function browser displays. 

5. At the Actual parameter sets of function browser window, select OK. 
The Toolbar button editor window displays. 
The Function parameter set field is populated with the Short description field 
value that you entered at the Actual function parameter set editor window. 

Define Remaining Toolbar Icon Characteristics
At the Toolbar button editor window, define the remaining fields that characterize 
the toolbar icon:
1. At the Label field of the Toolbar button editor window, enter the label that will 

display on the toolbar button. 
The maximum number of characters for the Label field is 240 characters.
For example, you could enter a label that reflects the window accessed upon 
toolbar icon selection, ReviewCHEM. 

2. At the Help text field, enter the text that will display on the toolbar button when 
the mouse is positioned over the button. 
The maximum number of characters for the Help field is 240 characters.

3. At the Image up, Image down, and Image disabled fields, enter the file names 
of the image the button displays when it is active but not pressed, pressed, 
and disabled. 
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Image up is the only mandatory file name. These image file names are 
located in the <root>/img directory. 
NOTE: Images and text are mutually exclusive.

4. To delineate this toolbar button from other toolbar buttons with a vertical line, 
select the Insert ruler field checkbox. 

5. At the Toolbar button editor window, select OK. 
The Toolbar button browser window displays. 

6. At the Toolbar button browser window, select Close. 

Log Out and Log In to the ADVIA CentraLink Software
To display the toolbar icon that is preconfigured with the sample query and test 
request parameters, you must log out and log back in to the ADVIA CentraLink 
software: 
1. Log in to the ADVIA CentraLink software. 
2. At the toolbar, the new Review and Edit icon displays and is identified by the 

label or image to which you assigned it. 
3. At the toolbar menu, select the newly created toolbar button. 

The Review & Edit window displays and is populated with the sample set that 
meets your predefined sample query and test request criteria. 
NOTE: After selecting the configured toolbar icon and directly accessing the 
populated Review & Edit window, you can temporarily override the configured 
request query parameters by accessing the Request query window, entering 
new request query parameters, and reaccessing the refreshed Review and 
Edit window. Refer to Review and Edit Window Refresh Using the Request 
Query Option‚ page 106.The newly entered request query parameters for this 
restricted sample result set, however, only apply until the current Review and 
Edit window session ends. After the current Review and Edit window session 
ends and you select the configured toolbar icon, you reaccess a Review and 
Edit window populated with the sample set that meets your predefined 
sample query and test request parameters. 
For details on the fields of the Review and Edit window, refer to Areas and 
Fields of the Review and Edit Window‚ page 112. 
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Areas and Fields of the Review and Edit Window
The Review and Edit window is comprised of three areas:

Demographics Area
The Demographics area of the Review and Edit window includes a Basic, 
Advanced, and LAS tab. This Demographics section displays sample-specific 
information. 
If the sample contains a request with associated instrument flags, a warning 
triangle displays in the upper right corner of the section. 

Areas of Review and Edit Window

1 Demographics

2 Tests and results

3 Disposition
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Basic Tab
The Basic tab includes the following fields:

Field Description

Sample ID Identification number of the displayed sample. 
The ADVIA CentraLink software supports Sample IDs 
with a maximum of 16 characters.

NOTE: Use caution when using sample ID values 
consisting of 16 uppercase alpha characters. While the 
sample ID is accepted by the ADVIA CentraLink 
software, the 15th and 16th, uppercase, alpha 
characters display as if they were truncated in the 
ADVIA CentraLink software. Upon subsequent retrieval 
of the sample ID at the Sample browser window, the 
16th character does not display, and at the Review and 
Edit window, both the 15th and 16th characters do not 
display. For example, if you enter a sample ID value of 
“ABCDEFGHIJKLMNOP," the sample ID value 
"ABCDEFGHIJKLMNO" would display at the Sample 
browser window and the sample ID value 
"ABCDEFGHIJKLMN" would display at the Review and 
Edit window. 

You can enlarge the size of the Sample browser 
window or Review and Edit window to increase the 
Sample ID field and display the full Sample ID value.
NOTE: For information on resizing windows in the 
ADVIA CentraLink software, refer to Using the 
Workspace‚ page 22.
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Advanced Tab
The Advanced tab includes the following fields: 

Priority Displays the following priority of the sample:
• Routine
• Stat
• ASAP 

Age Age of the patient in years. 

Patient ID Patient ID number. 

Patient name Name of the patient

Sex Sex of the patient. 

DOB Patient date of birth. 

Patient location Place where patient is located, for example, ER. 

Collection D/T Date and time of the sample collection. 

Sample comment Comment associated with the sample. 

Patient comment Comment associated with the patient. 

Field Description

Field Description

Physician ID Identification number of the associated physician. 

Physician name Name of the physician. 

Species Species associated with the sample or patient. 
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LAS Tab
The LAS tab includes the following fields:

Instrument time Time the sample was last detected on the specified 
instrument. 

Creation time Time the sample record was created. 

Sample type Type of the sample. 

Instrument Name of the instrument on which the test is performed. 

Rack Rack location of the sample at the specified instrument. 

Position Position of the sample within the rack location at the 
specified instrument. 

Field Description

Field Description 

Seq No The sequence number of the LAS system that 
uploaded the LAS information. 

Time Time the sample was last detected at the LAS. 

General area A location field as reported by the LAS. The General 
area field includes the following application codes: 
• CS – Cold storage
• MT – Main track
• SC – Side car
• OT – Off track



 

116 ADVIA CentraLink Operator’s Guide

Tests and Results Area
The Tests and Results area consists of request information in a browser format. 
You can double-select on any test to see detailed information about the request. 

Shelf, Door, Area, 
Gate, Tray id, Tray 
position 

Location fields as reported by the LAS. 
See Viewing the Sample Status Overview‚ page 70. 

Field Description 

Field Description

Test Name of the requested test.
NOTE: If a test name that consists of 20 characters was 
entered at the Test window, the test name value 
appears to be truncated in the Test field at the Review 
and Edit window. To verify the entire test name, put 
your cursor in the Test field and press the right arrow 
key until each of the remaining characters of the test 
name display. Avoid entering test names that consist of 
20 characters.

Sts The status of the request: Pending (PND), Rerun 
(RRN), Scheduled (SCH), Review (REV), Validated 
(VAL), Uploaded (UPL), Omitted (OMT). 
See Understanding Result Status‚ page 124. 
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Current Current result value. 
Every request can have multiple associated results. 
Each time a new result value is available, either through 
manual entry or automatic upload from an instrument, a 
new result record is created to store the value. At the 
Review & Edit window, the latest two results display. 
The most current result value is stored in this Current 
column. 
The background of the Current field is color coded to 
indicate the accumulated result severity. The 
accumulated result severity is the maximum absolute 
value of the norm, delta norm, instrument, and QC 
severity values. These individual severities are color 
coded in the NS, DS, QS, and IS columns respectively. 
The following colors display in the Current column 
depending on the absolute value of the accumulated 
severities: 
• Yellow - Displayed when equal to 2. 
• Green - Displayed when equal to 1. 
• Red - Displayed when greater than or equal to 3. 

Red also displays when the patient result generates 
one of the following conditions: 
- Type error – Patient result has a datatype error. 

The datatype of the patient result cannot be 
converted to the datatype of the corresponding 
test. 

NOTE: If a patient result value contains a 
comparator and a numeric value, however, the 
patient result is treated as a numeric value. A 
datatype error condition does not result. 

Field Description
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Current (Cont’d) - Ambiguous result as per comparator– Patient 
result has a comparator that renders the result 
value ambiguous with relation to the normal 
range. As per the comparator, you cannot 
definitively determine whether the result value 
falls within the normal range or whether it falls 
outside the normal range. 

Norm records are checked in sequence according 
to their evaluation order.
If a result falls outside the range defined by the Low 
and High Limit values, then the Severity value of the 
Norm is applied to the result. 
If the result does not fall outside the range, the norm 
with the next highest evaluation order is checked.
Consider another example, for which the Low Limit 
and High Limit normal range values of a test are set 
from 0.02 to 10.0: 
– If the result value <0.02, the result value is not 
ambiguous because the result is definitively outside 
the norm range. 
– If the result value >10.0, the result value is not 
ambiguous because the result is definitively outside 
the norm range. 
– If the result value <0.19, the result value is 
ambiguous because the values may or may not 
exceed the norm range. The value <0.19 may be on 
either side of the  Low Limit of 0.02. 
– If the result value >9.99, the result value is 
ambiguous because the values may or may not 
exceed the norm range. The value >9.99 may be on 
either side of the High Limit of 10.0.

Field Description
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When a test’s normal range is not properly defined 
and a result containing a comparator is ambiguous 
with respect to the normal range, the respective 
norm is considered violated. In addition to the red 
color display in the Current column, the result is 
held in REV status and must be manually validated.  
NOTE: This feature ensures the laboratory is not 
accidentally releasing ambiguous results.  
If you receive an ambiguous patient result, the 
normal ranges are not specified correctly and 
should be re-evaluated.
Upon display of this ambiguous patient result on the 
Review and Edit window, the following text 
populates the Comment field: “Check defined 
ranges.” 
NOTE: This comment is hard coded and cannot be 
overwritten or deleted. This comment is not 
uploaded to the LIS and is not printed on patient 
reports. This comment serves as an internal note 
for the laboratory. 

F Flag. An asterisk in the Flag field indicates that a flag is 
available. The expanded text associated with this flag is 
displayed in the Flag field of the Disposition section 
when the result is highlighted.

Prev Run Contains the previous result value of the same sample.
When Rerun is selected, the result value from the 
Current field displays here.

NOTE: Enumerated type test results can display 
differently in the Prev Run field than in the Current field 
if an expansion is defined in the associated result 
choice record. The Prev Run field displays the original 
input string; the Current field displays the result after 
expansion. 

Field Description
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Prev Samp Contains the most recent result value on a different 
sample for the same patient. This value is used for delta 
checking. 

Date/Time Contains the date and time in which the Prev Samp 
value was recorded. Depending on the settings on the 
Options window, this date/time stamp may originate 
from the LIS or from the ADVIA CentraLink system 
database. 

Norm Displays the normal range of acceptable values that 
have a corresponding severity of 1.

NOTE: If a normal range is not defined or if the defined 
range has a corresponding severity value that is not 
equal to 1, the ? symbol displays in this field. 

Field Description
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NS, DS, QS, and IS Normal severity, delta norm severity, QC severity, and 
instrument severity values. 
Normal Range Severity
Suggested values: -3 panic low, -2 very low, -1 low, 
<blank> normal, 1 high, 2 very high, 3 panic high
A type error occurs for a patient result when the 
received result does not match the Patient data type 
field configured for the test. 
In ADVIA CentraLink System Software 11, type error 
patient results were automatically assigned a norm 
severity of 5. In System Software 12, although the 
current field within Review and Edit displays a red 
background, no norm severity is assigned. 
Through the Allow on type error checkbox setting of the 
Method window, however, you can configure methods 
to either enable or disable autovalidation upon receipt 
of type error patient results. 
Delta Check Severity 
The value represents where the current result is 
positioned with reference to a user-defined percentage 
or absolute difference of the previous sample result. 
At the Delta Norm window, the Limit is absolute 
checkbox determines whether a user-defined 
percentage or absolute difference of the previous 
sample result is taken. 
blank = current result within user-defined percentage or 
absolute difference of the previous sample result
-1 = current result outside on low side of user-defined 
percentage or absolute difference of the previous 
sample result
1 = current result outside on high side of user-defined 
percentage or absolute difference of the previous 
sample result

Field Description
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NS, DS, QS, and IS 
(cont’d)

Quality Control Severity
The QC severity value can equal a warning or 
moderate or severe control failure depending on how 
you group and define the severities relative to the 
following: 
• Westgard severity
• Instrument severity
• QC severity on type error
• QC severity on invalid reference
For information on setting method severities, refer to 
Autovalidation Tab‚ page 309. 
Instrument Flag Severity 
blank =No flag exists
1-999 = Flag exists. Severity level is user-defined. 
The following colors are displayed in the severity 
columns: 
• Red - Displayed when greater than or equal to 3. 

Severe severity outside of normal range. 
• Yellow - Displayed when equal to 2. High severity 

outside of normal range. 
• Green - Displayed when equal to 1. Moderate 

severity outside normal range. 
See Understanding Review and Edit Severity Columns‚ 
page 125. 

Field Description
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C Comment. 
An asterisk in the Comment field indicates that a 
comment is available. The expanded text associated 
with this comment is displayed in the Comment field of 
the Disposition section when the result is highlighted. 
When a type error result or ambiguous result displays 
an appropriate comment value displays in the 
Comment field. 
Some comment values can be manually edited; other 
comments are generated system comments that are 
hardcoded and cannot be edited. 

Instrument The instrument delivering the current result. 

Field Description
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Understanding Result Status
You can review results according to their status. A test result can have any of the 
following statuses: 

Status Description

1 Pending
(PND)

When a test request is created, its status 
is Pending. 

2 Rerun
(RRN)

A request is demoted from status Review 
to status Rerun when a manual Rerun is 
initiated for the request or an automatic 
rerun is initiated.

3 Scheduled
(SCH)

When the request is downloaded to an 
analysis instrument as a workorder in 
response to an instrument query, it is 
promoted to status Scheduled.

4  Review 
(REV)

A request is promoted to status Review 
when a result value gets assigned to it. A 
request can also be demoted to status 
Review from status Validated by 
executing the Invalidate command.

5 Validated
(VAL)

A request is promoted to status Validated 
when its result value is validated through 
manual or automatic validation.

6 Uploaded
(UPL)

A request is promoted to status Uploaded 
when it is successfully uploaded to the 
LIS, either explicitly by the operator or 
through automatic uploading.

7 Omitted 
(OMT)

A request enters status Omitted when the 
Omit command is executed on it.
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Understanding Review and Edit Severity Columns
The following severity columns exist: NS, DS, QS, IS. A value of blank displays in 
the severity columns when a request result is in normal range. Colors 
differentiate between different warning levels for test results. 
Consider the following scenarios: 
• If all the severity columns are blank, the test result value is displayed in black. 

No severity exists for the given test result. 
• If any of the severity columns contain a value of 1, the result and the severity 

column are displayed in green. Moderate severity for the given result is 
indicated. 

• If any of the severity columns contain a value of 2, the result and the severity 
column are displayed in yellow. High severity for the given result is indicated. 

• If any of the severity columns contain a value of 3, the result and the severity 
column are displayed in red. Severe severity for the given result is indicated. 

• If a test request has different severity values among the severity columns, the 
highest severity value determines the color of the test result. Consider the 
following severity values: NS=0, DS=2, QS=3, IS=0. If a test request has 
these severity values, the result is displayed in red and the QS column 
displays in red. Accordingly, the DS column displays in yellow and the NS and 
IS columns display without color. 
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Disposition Area 

Actions Description

Select Selecting a status from this drop down menu and 
selecting Apply, applies a selection arrow (>) next to 
each result with the chosen status in the first column 
of the Tests and Results area. This allows you to 
disposition all tests with the same status.
To disposition all tests in view in the Tests and 
Results area, select All from the Select field drop 
down menu and select Apply. 
A selection arrow displays next to each result in the 
first column of the Tests and Results area.
To remove the selection arrows from the results in 
view in the Tests and Results area, select None 
from the Select field drop down menu and select 
Apply. The selection arrows are removed from the 
first column of the Tests and Results area for each 
result.
To simultaneously clear selected results and select 
unselected results in view in the Tests and Results 
area, select Invert from the Select field drop down 
menu and select Apply. 

NOTE: To select a single result in the Tests and 
Results area, highlight the result and press Space 
Bar. 

Flags When a result is highlighted that contains an 
asterisk in the Flag column field of the Tests and 
Results area, the expanded text associated with this 
instrument flag displays in this Flag field. 
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Comment When a result is highlighted that contains an 
asterisk in the Comment column field of the Tests 
and Results area, the expanded text associated with 
this comment displays in this Comment field. 
When a type error result or ambiguous result 
displays, an appropriate comment displays through 
the Comment field. 
For example, when an ambiguous result as per 
comparator result is highlighted in the Tests and 
Results area, the following value displays in the 
Comment field: “Check defined ranges.” 
This “Check defined ranges” comment is hard 
coded and cannot be overwritten or deleted.  This 
comment is not uploaded to the LIS and is not 
printed on patient reports. This comment serves as 
an internal note for the laboratory.
Other comment values that display through the 
Comment field can be edited. 

Actions Description
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Validate (Scroll) Validates results of selected tests, changing the 
status from Review to Validated. 
The Validate (Scroll) button serves as both a Scroll 
button and a Validate button depending on whether 
all the pages associated with the test results for this 
sample display. The label on the Validate (Scroll) 
button displays initially as Scroll. After selecting the 
Scroll button, the remaining tests display and the 
label on the Validate (Scroll) button changes to 
Validate. 
In this dual function, the Validate (Scroll) button 
eliminates the need for manual scrolling through all 
of the pages of test results to activate the Validate 
button. 
When the Auto-Next after Validation parameter is 
selected on the Review and Edit tab of the system 
Options window, the next sample in the current 
sample query automatically displays after the 
current sample is validated. 
See Considering Validate Scroll Functionality‚ 
page 132. 

Rerun Submits selected tests for rerun, which changes the 
status from Review to Rerun.
When the Allow manual rerun all parameter is 
selected on the Review and Edit tab of the system 
Options window, all selected tests including those in 
status Validated and Uploaded are rerun. 
When Rerun is executed, the result value from the 
Current field displays in the Prev Run field. The 
current result value from the rerun displays in the 
Current field. 
See Rerunning a Test‚ page 134. 

Actions Description
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Rerun All The Rerun All button reruns all status Review tests 
that are in view in the Tests and Results area 
browser regardless of whether the tests are 
selected.
When the Allow manual rerun all parameter is 
selected on the Review and Edit tab of the Option 
window, tests in all statuses including statuses 
Validated and Uploaded and excluding status 
Omitted that are in view in the Tests and Results 
area browser are rerun. 

NOTE: LIS driven reruns always permit reruns of 
results in status Upload.
Omitted tests, which do not display in the Tests and 
Results area, are exempt from rerun. 
If any test request participating in a calculation is 
rerun, any dependent calculated result requests are 
automatically rerun along with it. 
When Rerun is executed, the result value from the 
Current field displays in the Prev Run field. The 
current result value from the rerun displays in the 
Current field. 
See Rerunning a Test‚ page 134. 

Actions Description
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Revert Reverts the result of a selected request back to the 
result value of a previous run. Only samples in 
Review status that have previous results can be 
reverted.
Reverting to a previous result actually creates a new 
result, which is a copy of the original result record. 
The reverted record, however, contains the 
following updated field values: 
• The user and time fields are updated with the 

reverting user and time values. 
• The comment field is updated with any auto-

generated comments appended with the 
reverted comment value. 

You cannot revert calculated results; however, in 
reverting the inputs to calculated results, these 
results are automatically recalculated. Validated and 
uploaded results cannot be reverted. 
See Reverting to a Previous Test Result‚ page 135. 

Upload Manually sends the validated results to the LIS. 
The Upload button is activated when at least one 
validated request is visible in the Tests and 
Requests section. Upon selecting the validated 
tests and selecting the Upload button, all selected 
results with a status of Validated are uploaded to the 
LIS. 
See Manually Uploading Validated Results to the 
LIS‚ page 136. 
You can also initiate the upload function for selected 
results by right-selecting and selecting the Upload 
option from the pop-up request menu. 

Actions Description



131

Flags The Flag button is activated only when instrument 
flags are associated with the current sample. 
Similarly a warning triangle displays in the upper 
right corner of the section Disposition section when 
instrument flags are associated with the current 
sample 
Upon selecting the Flag button, the Instrument 
Flags window for the current sample is displayed. 
On this window, lists of flagged tests that are 
grouped by instrument and by flag display. 
See Viewing Flag Information‚ page 137. 

Image The Image button is activated when the sample has 
an associated image result. Selecting this button 
activates the View Image function. 
For example, the image button is activated for 
hematology results that contain cytograms. Upon 
selecting the Image button, the cytogram image 
sent from the ADVIA 120/2120 system displays. 
See Viewing Images‚ page 138. 

Options The Options button initiates the display of the 
Request Query window. The Request Query 
window provides status, status range, test group, 
and instrument group parameters that restrict the 
test results displayed in the refreshed Tests and 
Results area.
See Viewing Request Query Information‚ page 139. 

Close Closes the Review and Edit window

Actions Description
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Disposition Buttons Functions
Validating Results of One or More Tests
A test can be validated only if it has a status of Review. You can validate all 
results with a status of Review, or you can select certain results to validate.
WARNING: If you attempt to validate a result that is already validated, the 
ADVIA CentraLink system allows the validation attempt without warning that the 
result is in the incorrect status for validation. 
By default, all tests with a status of Review have a selection arrow in the first 
column of the Review and Edit window. If each of these tests require validation, 
simply select Validate to change the status for all at once.

Considering Validate Scroll Functionality
When more test results for a sample ID exist than are in view in the Tests and 
Results area of the Review and Edit window, the Validate (Scroll) button is 
activated, the Scroll label displays, and the scroll functionality is enabled. Upon 
selecting this button, the next sequential test result associated with the sample 
automatically come into view in the Tests and Results area. The scroll 
functionality is enabled until all of the requests associated with a sample display 
in the Tests and Results area. Once all the requests display, the Validate label of 
the Validate (Scroll) button displays and the validate functionality is enabled. 
Upon selecting this button, all selected tests in Review status are validated. 
NOTE: Be careful when selecting the Validate (Scroll) button. If you accidentally 
select multiple times, it is possible to validate results for the next record. 

Auto Next on Validate
When you select the Validate button and the Auto-Next after Validation checkbox 
is selected on the Review and Edit tab of the system Options window, the next 
sample in the current sample query displays. 
NOTE: If the Auto-skip function is enabled, there may be a delay before the next 
sample in the current sample query displays. For details, refer to Auto Skipping 
Sample Records that Do Not Match Test Request Criteria‚ page 141.
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Auto Validation of Delivered Results 
If a result is obtained from an instrument, the result is said to be delivered by the 
method identified by the test plus instrument combination. If a result is entered 
manually, no auto validation rules are applied.
When a new result is assigned to a request, it is always subject to automatic 
range checking and delta checking. This yields the request's norm severity and 
delta norm severity, respectively. The request's QC severity is copied from the 
current QC value of the method delivering the result. The request's instrument 
severity is set to the maximum value of the associated instrument flag’s patient 
severity.
The severities obtained are now compared with severity limits to determine 
whether or not the result is automatically validated. If a method is available, the 
method determines the applicable severity limits. If a method is not available and 
the result is obtained through a calculation, the test determines the applicable 
severity limits. 
When a result is entered manually, no severity limits are available. Automatic 
validation only occurs when the defined severity limits are available.

Auto Validation of Calculated Results
Auto validation of calculated test results occurs when all input results are 
validated. The auto validation criteria can be applied to the calculated test result 
regardless of whether the input tests are coming from two different instruments. 
When a method is associated with the calculated test, the method’s auto 
validation criteria is used. Consider the following scenario: If requests in Review 
status receive a result through a given method and the request's norm, delta 
norm, QC, and Instrument severities are all below the respective norm severity 
limit, delta norm severity limit, QC severity limit and instrument severity limit, then 
the request is automatically validated. If any of the defined limits are left 
unspecified, no auto validation occurs.
When a method is not associated with the calculated test or the inputs for the 
calculated test come from more than one instrument, the following auto validation 
levels, which are defined on the Calculation tab of the Test window, are used: 
norm severity limit, delta norm severity limit, QC severity limit, and instrument 
severity limit. 
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Rerunning a Test
You can rerun tests by selecting the following buttons: 
• Rerun – The Rerun button submits selected tests for rerun. 
• Rerun All – The Rerun All button reruns all status Review tests that are in 

view in the Tests and Results area browser regardless of whether the tests 
are selected. 

Omitted tests, which do not display in the Tests and Results area, are exempt 
from rerun. 

NOTE: You can also manually initiate a rerun from a test request at the 
Review and Edit window by right-selecting the test request and selecting 
Sample > Rerun. In initiating this manual rerun, the Dispatch to LAS task 
must be running for the order to be downloaded to the LAS. 
NOTE: See Setting Up Advanced Reruns‚ page 157 for information on 
Advanced Reruns, which is available through right-selecting on a selected 
test result. 

When a test request participating in a calculation is rerun, any dependent 
calculated result requests are automatically rerun along with it. Consider the 
following:
• If a test is a component of a calculation defined in the ADVIA CentraLink 

system, such as Albumin for the A/G ratio, then the component test and the 
ratio test are both rerun when the ratio is scheduled for a rerun. The ratio test 
is automatically recalculated upon receipt of all component test results from 
the instrument. 

• If a test is a component of a calculation that is defined only at the instrument, 
the ADVIA CentraLink system is unaware of any connection between 
components and calculations and is unable to perform the component test 
when only the ratio is scheduled for a rerun. 

• Morphology flags associated with the previous result are updated by the 
system when the test is rerun.
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Upon completion of test reruns, the Current field result value is copied to the Prev 
Run field. The new result value for the current re-run displays in the Current field.

Considering Application Level Settings for Rerun
At the Review and Edit tab of the system Options window, you can select the 
following checkboxes: 
• Allow manual rerun all – Determines whether tests in all statuses, which 

includes statuses Validated and Uploaded and excludes status Omitted, are 
eligible for user initiated, manual rerun. 

NOTE: The ADVIA CentraLink software always accepts a request from the 
LIS to rerun a test request, up to and including those test requests with the 
status Uploaded, regardless of the Allow manual rerun all checkbox setting.

• Autovalidate reruns – Determines whether the results that are within normal 
range after a rerun are eligible for automatic validation. If this option is not 
selected, you must validate rerun results manually. 

NOTE: Any time a change is made to an application level setting that involves 
a user interface change, you must log out of the ADVIA CentraLink system 
completely and log back in again for the change to take effect. For example, if 
you select the Auto next on validate option on the Review tab of the system 
Options window, you must log out and log back in before the ADVIA 
CentraLink system automatically displays the next sample in a query when 
the current sample is validated. 
Any time a change is made to an application level setting that involves a 
communication change, the system administrator must stop and re-start 
services for this change to take effect. 

Enhancing Rerun Efficiency 
To maximize system performance during reruns, you are not required to enter 
comments prior to executing reruns or to acknowledge reruns upon completion of 
test requests. 

Reverting to a Previous Test Result
Display the Results of request window from the Review and Edit window: 
1. Select a result and select Revert.
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The Results of request window displays. 

2. Select the result to copy back into the Current column and select OK. 
NOTE: Reverting to a previous result actually creates a new result, which is a 
copy of the original result record. The reverted record, however, contains updated 
user, time, and comment field values. 

Manually Uploading Validated Results to the LIS
Depending on lab-specified criteria, when all tests on a sample have status 
Validated, the results are automatically scheduled for uploading to the LIS. With 
the Upload button, however, you can manually upload validated results within a 
sample. You can upload any result that is validated, even if all results in the 
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sample are not yet validated. The Upload button is not activated unless at least 
one test has a status of Validated.
Manually upload a validated result from the Review and Edit window: 
1. Select the Upload button. 

The Upload validated results window displays. 

 

Viewing Flag Information
The Flags button allows you to view all associated instrument flags. It is activated 
only if flags are associated with the current sample. 
To access the Instrument flags window from the Review and Edit window to view 
the instrument flags for a selected sample select the following button: 
1. Select the Flags button. 

Field Description

Include Uploaded If selected, matching requests are uploaded regardless 
of whether they were already uploaded. 
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The Instrument Flag window displays. On this window, lists of flagged tests 
that are grouped by instrument and by flag display. 

Viewing Images
The Image button allows you to view any images associated with the selected 
result. 
To access the image associated with a selected result select the following button: 
1. Select the Images button. 
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The associated image displays. 

Viewing Request Query Information 
Upon display of one of the samples on the Review and Edit window, all the tests 
of the sample display. 
To limit the display of requests within the current sample to those within a test 
group, select the Options button at the Review and Edit window. The Request 
Query window displays. 
The request query parameters restrict the test results displayed in the Tests and 
Results area of the refreshed Review and Edit window. 
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Access the Request Query Window
At the Review and Edit window, access the Request query window: 

1. Select the Options button. 
The Request query window displays. 

Fields of the Request Query Window 

2. Select OK. 

Field Description

Status from and to Restricts the result set to a specific status range. 
For example, if you are not interested in viewing 
requests already validated, specify the following status 
in the Status from and to fields respectively: Pending 
and Review.
To view only Omitted results, specify Omitted in both 
the Status from field and the to field. 

Test group Restricts the result set to requests belonging to the 
specified test group. 
On re-display of the refreshed Review and Edit window, 
only the test requests within the current sample that 
belong to this test group display. 

Instrument group Restricts the result set to requests belonging to the 
specified instrument group. 
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The Review and Edit window displays. The results that display in the Test and 
Results area are restricted to meet the specified request query parameters. 

Auto Skipping Sample Records that Do Not Match Test Request Criteria
When you enter test request criteria to the Request query window, you further 
restrict the test results that display for the sample(s) that met the sample query 
criteria entered to the Sample Query window. 
When the Auto-skip sample feature is enabled on the Review and Edit tab of the 
system Options window, those sample records with result records that do not 
match the test request query criteria and would otherwise display as empty 
sample records on the Review and Edit window are skipped. The empty sample 
records are skipped and the next sample record that contains result records that 
match the test request criteria displays. By default, the Auto-skip sample feature 
is enabled on the Review and Edit tab of the system Options window. 

If the Auto-skip 
sample feature...

Then...

is enabled those sample records with result records that do not 
match the test request query criteria do not display as 
empty sample records on the Review and Edit window. 
These empty sample records are skipped, and the next 
sample record that contains result records that match 
the test request criteria displays. 
In addition to automatically displaying only those 
sample records with result records that match the test 
request criteria entered on the Request query window, 
the Auto-skip feature also skips the display of empty 
sample records when you navigate as follows:
• Select the Next page/Previous page or Next record/

Previous record buttons of the toolbar. 
• Select the Validate button on the Review and Edit 

window.
• Press the Page Up or Page Dn buttons on the 

keyboard. 
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After 5 sample records with non-matching result records are automatically 
skipped, a message displays informing you of skipped records. At any time 
during the auto-skip process, you can stop the process of automatically skipping 
records by pressing <CTRL><BREAK>. 

Right-Selecting Functions
Viewing Results of Requests 
Although the most current 2 results display on the Review and Edit window for a 
given sample, every test request can have multiple result records associated with 
it. You can view each of the result records associated with a test request on the 
Results of request window. New result values are uploaded from an instrument, 
or they can be entered manually. 
A new result value for a given test request is saved as a new record when it is 
received within the sample reuse period, which is a configurable time period, 
known as the sample reuse period. 

Configurable Sample Reuse Period
The value for this configurable time period is expressed in days and is defined in 
the Sample reuse period field at the More tab of the system Options window. If no 
day value is specified and the Sample reuse period field value is populated with 
the ? symbol, the default value of 30 is used. The sample reuse period values 
can range from 1 to 365. 

is not enabled those sample records with result records that do not 
match the test request query criteria display as empty 
sample records on the Review and Edit window. 
You must manually navigate past these empty sample 
records by doing one of the following:
• Selecting the Next page or Next record buttons of 

the toolbar. 
• Pressing the Page Up or Page Dn buttons on the 

keyboard. 

If the Auto-skip 
sample feature...

Then...
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When the ADVIA CentraLink software receives a new result, it verifies whether 
the elapsed time period between the last posted result date plus the Sample 
reuse period value is greater than the date of the new result.  
(Last result date) + Sample reuse period > Date of new result 

If the last result date + 
Sample reuse period...

Then the new result value is...

is greater than the date of 
the new result

saved. 
The last result date is updated with the current 
date. 
You can view the new result value in the Results of 
request window; the last result date does not 
display on the window, but is stored in the Sample 
table. 

is equal to or less than the 
date of the new result

not saved.
An error message is logged in the instrument 
Service log.
The following comment is added to the sample 
specifying that results were discarded due to 
results extending beyond the Sample reuse 
period: “Results discarded – sample reuse time 
has elapsed for sample <Sample.Identifier> 
(<Instrument.Name>-<CurrentDateTime>).”
This comment displays in the Sample Comment 
field of the Review and Edit window. 
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At the Review and Edit window, access the Results of request window: 
1. Right-select a result and select Related > Result.

The Results of request window displays. 

NOTE: If you right-select a result of the Results of request window, the View 
result option is available from the dropdown menu. This View result option 
allows for you to view either hematology results that contain cytograms as a 
cytogram image or to view electrophoresis results of type Graph as a 
graphical display. When the Upload graphs option on the LIS 2 tab of the 
systems Option window is selected, electrophoresis results are uploaded to 
the LIS. While electrophoresis is supported, the functionality is not currently 
used in the ADVIA CentraLink software. 

2. To access the details of a listed result, double-select the result. 
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The Result window displays. 

General Tab 

Field Description

Status The status of the test request:
• Pending - Status when a test request is 

downloaded to an instrument as a workorder in 
response to an instrument query. A value is 
expected from the instrument that queried for 
the sample. 

• Available - Status when a result value is 
assigned to a test request. 
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Schedule user Reference to the user who created the result 
record that exists in status Scheduled. As this is 
typically performed by a background process, the 
user is usually set to batch. 

Schedule time The date and time when the result record was 
created in status Scheduled. 

Method Reference to the method record, and thereby the 
associated instrument and test, through which the 
result was obtained. 
For manually entered results, this field is not 
populated. 

Aspiration time Date and time the sample was aspirated at the 
instrument. 

Test completed time Date and time in which the test was completed at 
the instrument. 

Availability user Reference to the user who entered the result 
record. 
For values obtained from instruments by a 
background process, the user is typically set to 
batch. 

Availability time Time when the result value was stored to the 
database. 

Value Raw text value supplied by the user or by the 
instrument. Unlike the string value associated with 
the request record, no rounding or expansion is 
applied to this value. 

Auto dilution coefficient Dilution coefficient uploaded by the instrument 
with the result. 

Field Description
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Auto dilution condition Dilution condition uploaded by the instrument with 
the result.

Manual dilution coefficient Value by which results are multiplied after a 
manual dilution. 

QC severity QC severity value of the associated method, at the 
time the value was copied from the method.

Reagent information When a patient result is received from an 
instrument and ADVIA CentraLink driver that 
support the upload of reagent information, the 
reagent information is saved directly to this field. 
The reagent information can consist of the reagent 
lot number, reagent expiration date, and the 
reagent sequence number. 
The reagent information value stored in this field 
can also be inherited from the Reagent information 
field of the Method; however, reagent information 
received at the result level has priority over global 
reagent information stored at the Method.
If the Reagent information field on the LIS 2 tab at 
the systems Option window is enabled, result 
specific reagent information is uploaded to the LIS. 

Field Description



 

148 ADVIA CentraLink Operator’s Guide

Comments Tab 

Field Description 

Instrument comment Comment uploaded by the instrument along with the 
result value. 

Parse comment Comment generated by the result value parser. 

Range comment Comment generated during automatic application of 
norms and delta norms. 

User comment Comment a user added to the Edit request comment 
window. 
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Omitting a Test
The omit function allows you to cancel any further processing, including 
reporting, for the selected test. The test result status changes to Omitted. You 
cannot omit records that were uploaded. 
If a request participating in a calculation is omitted, the calculated result request 
is automatically omitted. 
If a component test is omitted, the ratio test is automatically omitted. If a ratio test 
is omitted, the component tests remain available. Select only those tests that you 
want to omit. 
Access the Omit window from the Review and Edit window:
1. Right-select the selected test and select Omit. 

The Omit window displays. 

2. At the Omit window, type a comment into the Note field to record the reason 
the test was omitted. 

3. Select OK. 

Viewing Omitted Results
1. Open the Review and Edit window for the sample with Omitted results.
2. Select View > Query > Reopen on the menu bar or select the Options button 

on the lower left of the Review and Edit window. 
The Request Query window displays.

3. At the pulldown menus at the Status From and To fields, select Omitted and 
select OK. 
The results display on the Review and Edit window.
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Viewing the Omission Note through the Request Window
1. At the Review and Edit window, double-select the selected test. 

The Request window displays. 
2. Select the Audit tab. 

The text populates the Omission note field. 

Invalidating Results
To change the status of a request from Validate back to Review, select one or 
more results with status Validate, right-select on the Review and Edit window, 
and select the Invalidate option.
If any request participating in a calculation is invalidated, the calculated result 
request is automatically invalidated with it.

Viewing Results Graphically 
The View Result function allows you to view either hematology results that 
contain cytograms as a cytogram image or to view electrophoresis results of type 
Graph as a graphical display. When the Upload graphs option on the LIS 2 tab of 
the systems Option window is selected, electrophoresis results are uploaded to 
the LIS. 
NOTE: While electrophoresis is supported, the functionality is not currently used 
in the ADVIA CentraLink software.

Viewing QC Results for a Test 
When reviewing a sample, you can investigate a quality control severity by 
navigating from the Review and Edit window to the QC Results window. 
Access the QC Results (Across controls view) window to see the QC results of a 
selected test on the Review and Edit window: 
1. Right-select the selected test and select View QC. 
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The QC Results window displays the relevant QC results. 

Example: A QC severity error on a glucose test for an ADVIA 1650_2 displays on 
the Review and Edit window. The glucose test is defined in the ADVIA CentraLink 
system with three different QC levels for glucose. Since the last closeout, these 
three levels were run twice each. To investigate the quality control implications, 
select this glucose test on the Review and Edit window, right-select and select 
View QC. The QC Results Across Controls View window displays all the QC 
results for this glucose test on the Advia 1650_2 instrument since the last 
closeout. You can view the entire control history for this assay and instrument. 
See Understanding Quality Control‚ page 172 for information on Quality Control 
functionality. 
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Editing Test Results
You can manually edit a test result. If the edited result value exceeds the normal 
range, the severity fields are updated with the appropriate severity value; the 
color of the severity column and of the result value changes according to the 
severity. 
Access the Edit result window from a selected test on the Review and Edit 
window: 
1. Right-select the selected test and select Edit Result. 

The Edit Result window displays. 

NOTE: Editing results causes ratios to be recalculated when the test is defined as 
a component of a ratio test. For example, if you manually edit an RBC result, the 
HCT result is recalculated since the RBC value is a component of the HCT ratio 
test.

Appending a Comment to a Request
You can add or edit a user comment for the result associated with the request. 
The comment can be either a free text comment or a coded comment, which 
when updated through the Edit Comment for Request window is expanded into 
the text associated with the comment code. 
The comment field is dynamic-text enabled and is linked to the Request table. 
Dynamic text is the mechanism used by the ADVIA CentraLink system to 
dynamically expand text segments by substituting MISPL content or references 
to text records. Text records are reusable text modules that can be referenced 
from any dynamic text enabled field. 
For a comment code to expand into text, you must define the text for a comment 
and associate it with the comment code. 
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Define the text for a comment and associate this text with a comment code: 
1. At the menu bar, select Start > System Management > Texts > By 

Mnemonic. 
The Text Record browser window displays. 
Select the New icon and the Text editor window displays. 

Field Description 

Mnemonic The code that uniquely identifies the comment text. 
The maximum number of characters for the Mnemonic 
field is 60 characters.
For example, enter the code RR. This is the code that is 
associated with the text: Rerun Request. 

Class Classification string for use in queries. 

Description Describes the text. 
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2. To associate the comment text with the comment code, select OK. 
Append a coded comment to a test result on the Review and Edit window: 
1. Right-select the selected test and select Edit Result Comment. 

The Edit Comment window displays. 

2. In the comment field of the Edit Comment window, enter a forward slash:(/) 
followed by the comment code, which was entered to the Mnemonic field of 
the Text editor window. In this example, enter the value ‘/RR.’

Table Refers to the table to which the comment text is linked.
The maximum number of characters for the Text field is 
31921 characters.
Mandatory field entry. 

Text This is the comment text that is associated with the 
comment code, otherwise referred to as the mnemonic, 
and displays as a comment through the Comment field 
of the Review and Edit window. 
For example, enter the text: Rerun Request. This is the 
comment text that is associated with the code RR. 

Start / End Dates Dates specifying the time period in which the code and 
associated text can be used. 

Field Description 
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The forward slash is the mechanism through which the ADVIA CentraLink 
system recognizes that a coded comment follows. 

3. Upon selecting Update, the ADVIA CentraLink system queries the table 
defined in the Text window and accesses the Text associated with the coded 
comment. 
The expanded comment text displays in the Comment field of the Review and 
Edit window. The Edit Comment window displays the following: {<RR}. The 
coded comment is stored to the database.
Once the comment text is expanded in the Edit Comment window, you can 
add free text before or after the comment. 

You can view this expanded comment through the Comment tab of the Request 
window by double-selecting the request. 

Considering Application Level Settings for Comment Upload to LIS
At the LIS2 tab of the system Options window, you can select the following 
checkboxes: 
• Upload result comments – Determines whether the result comment is 

uploaded to the LIS on a patient result upload. 
• Expand text on upload – Determines whether the coded comments are 

expanded prior to upload to the LIS on a patient result upload or a QC result 
upload. 

Other LIS2 tab parameters on the system Options window include the following 
comments: 
• Upload instrument flags – Determines whether instrument flags are uploaded 

to the LIS on patient result upload. 

NOTE: If this checkbox is not selected, invalid results could potentially be 
uploaded to the LIS. 

• Upload patient comments – Determines whether patient comments are 
uploaded to the LIS on patient result upload. 

• Upload sample comments – Determines whether sample comments are 
uploaded to the LIS on patient result upload.

• Upload QC result comments – determines whether QC result comments are 
uploaded to the LIS on QC result upload. 
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• Upload parse comments – Determines whether parse comments, which are 
generated by the result value parser, are included with result and QC result 
comments uploaded to the LIS on patient result upload or QC result upload. 

Specifying a Dilution Factor
You can specify an auto dilution coefficient and auto dilution condition for 
requests in Pending or Rerun status through the Set auto dilution window and for 
requests in Review status through the Advanced rerun window. 
If the auto dilution coefficient or auto dilution condition values are specified on 
these windows, the corresponding values assigned to the request from the LIS 
are overwritten. You cannot revert back to the LIS values unless you manually 
reenter the values through the Set auto dilution window. 
When an auto dilution coefficient or auto dilution condition value or both are 
specified, these values are downloaded upon workorder download in response to 
the instrument query as long as dilution download is supported by the instrument 
protocol. When specified, the workorder message contains the auto dilution 
coefficient or auto dilution condition values from either the LIS or those manually 
entered through the Set auto dilution or Advanced rerun windows. 

Setting Up Auto Dilution
You enter parameters to the Set auto dilution window for those tests in which you 
want the initial test run to be diluted. Unlike a dilution that might occur during an 
advanced rerun on a test that was processed at least once, an auto dilution 
configured on the Set auto dilution window is a dilution that occurs the first time 
the test request is processed.
For requests in Pending and Rerun status, you can specify an auto dilution 
coefficient and auto dilution condition through the Set auto dilution window. 
On the Set auto dilution window, the specified auto dilution coefficient and 
condition parameters apply only to the highlighted test request that exists in 
Pending or Rerun status on the Review and Edit window and from which the Set 
auto dilution window is accessed. 
These parameters do not apply to multiple records. Instead the parameters are 
test request specific and are set at the request level. As such, the parameters 
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apply only to the highlighted test request on the Review and Edit window, not to 
all of the selected records. 
NOTE: Your local technical support provider can implement a MISPL site function 
to automatically apply the desired dilution based on your workflow. 
From the Review and Edit window, access the Set auto dilution window: 
1. Right-select the selected test and select Setup auto dilution. 

The Set auto dilution window displays.

Setting Up Advanced Reruns
You enter parameters to the Advanced reruns window for those tests that have 
already been processed at least once. Unlike a first time auto dilution that would 
be configured on the Set auto dilution window, an auto dilution configured on the 
Advanced rerun window is a dilution that is defined for a test request that was 
processed at least once and is being rerun. 
For requests in Review status, you can specify an auto dilution coefficient and 
auto dilution condition through the Advanced rerun window. The advanced rerun 

Field Description

Coefficient Depending on the instrument, leave as the default ? 
symbol or enter the desired dilution coefficient to be 
included in the workorder downloaded to the 
instrument. 

Condition Depending on the instrument, leave as the default ? 
symbol or double-select to select from a list of pre-
defined Dilution conditions to be included in the 
workorder downloaded to the instrument. 
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feature allows for entry of a manual or automatic dilution factor and for 
instrument-specific reruns. 
NOTE: The Advanced Rerun function is multi-record enabled. The Advanced 
Rerun applies to all selected requests on the Review and Edit window, not just 
the highlighted test request. 

Manual Dilution
To accommodate the concept of manual dilutions for reruns, you must specify a 
Dilution type of Manual at the Advanced Rerun window. For the test request, you 
enter a dilution coefficient, also known as a factor.  
The condition field is not used for a Manual Dilution and the field displays 
containing a gray ? symbol. In selecting a Dilution type of Manual, the Dilution 
coefficient field is not downloaded to the instrument with the workorder. As such, 
the dilution must be performed manually at the instrument to reflect the dilution 
coefficient field value entered on the Advanced rerun window. The actual dilution 
completed on the sample must correspond to the manual dilution coefficient 
value. 
When the ADVIA CentraLink software receives a result for a manual dilution test 
from an instrument, the received result is multiplied by the manual dilution 
coefficient value that was entered on the Advanced Rerun window.
Auto Dilution
To accommodate the concept of automatic dilutions for reruns, you must specify 
a Dilution type of Auto at the Advanced Rerun window.
In selecting a Dilution type of Auto, the Dilution coefficient and condition fields are 
downloaded to the instrument with the workorder. The auto dilution occurs 
automatically at the instrument without manual intervention. The actual dilution 
completed on the sample directly corresponds to the dilution coefficient value that 
was downloaded from the ADVIA CentraLink software. 
When the result is uploaded from the instrument to the ADVIA CentraLink 
software, the result is not altered by the ADVIA CentraLink software. 
In addition, your local technical support provider can implement a MISPL site 
function to automatically apply the desired dilution based on your workflow. 
You can also specify automatic dilutions on first dilution requests through the Set 
auto dilution window. See Setting Up Auto Dilution‚ page 156. 
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NOTE: The Instrument field on the Advanced Rerun window, which is designed to 
explicitly specify the instrument where the rerun is to be performed, is scheduled 
to be supported in a future release of the LAS software. 

On the Advanced rerun window, the specified auto dilution coefficient and 
condition parameters apply to each of the test requests that exist in Review 
status and that are selected on the Review and Edit window prior to accessing 
the Advanced rerun window. 
These parameters are not test-request specific. Instead the parameters are multi 
record enabled. As such the parameters apply to all selected records on the 
Review and Edit window, not just to the highlighted test request. 
NOTE: When specifying an auto dilution condition and or coefficient using the 
Advanced Rerun window, select only one test request. 

Access the Advanced rerun window from the Review and Edit window: 
1. Right-select the selected test and select Advanced Rerun. 
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The Advanced rerun window displays.

Field Description

Instrument Instrument to which you explicitly target the rerun. 
This instrument overrides the default LAS rerun routing. 

NOTE: The Instrument field on the Advanced Rerun 
window, which is designed to explicitly specify the 
instrument where the rerun is to be performed, is 
scheduled to be supported in a future release of the 
LAS software. 
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Dilution type Select one of the following 3 dilution types: 
• Manual - Manual dilution is specified. When the 

result is uploaded from the instrument after a 
manual dilution, the ADVIA CentraLink software 
multiplies the instrument result by the dilution 
coefficient value. 

• Auto - Auto dilution is specified. For auto dilutions, a 
dilution factor Is downloaded to the instrument with 
the workorder. The dilution occurs automatically at 
the instrument without manual intervention. When 
the result is uploaded from the instrument after an 
auto dilution, the ADVIA CentraLink software does 
not modify this instrument result value. 

• None - While no dilution is specified, the rerun is 
targeted to occur on the instrument specified in the 
Instrument field. The instrument targeted rerun 
occurs without dilution. 

NOTE: The Instrument field on the Advanced Rerun 
window, which is designed to explicitly specify the 
instrument where the rerun is to be performed, is 
scheduled to be supported in a future release of the 
LAS software.

Field Description
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Dilution coefficient Manual Dilution
When dilution type of Manual is specified prior to rerun, 
the dilution coefficient value indicates how much the 
sample must be diluted.
After rerun, this value is multiplied against the result 
received from the instrument to correct the result for 
dilution. 
For example, you enter the value 2 for the manual 
dilution coefficient. Prior to rerun, the sample must be 
manually diluted with an equal amount diluent. After 
rerun, the incoming instrument result is automatically 
multiplied by 2 to correct for dilution. 
The specified manual dilution coefficient is not 
communicated to the instrument for automatic onboard 
dilution.
The dilution coefficient must be at least 1. 
Upon entering a change to the Dilution coefficient field 
for a manual dilution, a message displays warning that 
after upload from the instrument, the result will be 
multiplied by the Manual dilution coefficient. You are 
prompted to select Yes to confirm that after upload from 
the instrument, the result will be multiplied by the 
Manual dilution coefficient. 
Auto Dilution
When dilution type of Auto is specified, the dilution 
coefficient value is downloaded with the workorder to 
the instrument.
The instrument dilutes the sample as per the value in 
the dilution coefficient field without manual intervention. 
When the result is uploaded from the instrument after 
an auto dilution, the ADVIA CentraLink software does 
not modify this instrument result value. 

Field Description



163

You can also view manual and auto dilution data through the Dilution tab on the 
Request window by double-selecting the request. 

Dilution condition This field is enabled when you select Dilution type, 
Auto. 
Certain instruments require the use of a dilution 
condition. Depending on the instrument in which the 
dilution occurs, double-select in the Dilution condition 
field and select from a list of available values for the 
auto dilution condition. 

Comment Allows for entry or free text comments or coded 
comments. 

Field Description



 

164 ADVIA CentraLink Operator’s Guide

Viewing Test Request Information
View the details of a test request on the Review and Edit window: 
1. Double-select the selected test. 

The Request window displays.

The top part of the Request window displays the following fields: 

Field Description

Test Requested test name.

Origin The origin of the request can be External when the 
LIS downloads the order for the request, Internal 
when the test was requested through the 
ADVIA CentraLink system manual order entry, 
reflex testing, or a component from a ratio test, or 
Unsolicited when a test result was received from 
the instrument without a request available in the 
ADVIA CentraLink system. Normally the origin is 
External.
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The bottom part of the Request window consists of six tabs. 

Result Detail tab
Upon display of the Request window, the Result Detail tab is activated. The 
Result Detail tab displays associated result aspects by name (Aspect) and Value. 
Aspects include ALGC (allergen code), CSN (country-specific allergen), CLSS 
(allergy class), INDX (result index value), and COFF (Cut off).

Status Test request status: Pending, Rerun, Scheduled, 
Review, Validated, Uploaded, or Omitted. 

Instrument The instrument from which the result is expected 
or the instrument delivering the result. 

Patient History time This equals the sample collection time, or when 
the collection time is not available, the sample 
creation time. The time specified in this field is 
used for delta checking if, at the application level, 
the previous result origin is set to “local” in the 
ADVIA CentraLink system database.

Aspiration time Time when the instrument aspirated the sample. 

String value Text representation of the result value. Rounding 
for numerical tests is indicated. 

Field Description
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Dilution tab 

Field Description

Coefficient The dilution coefficient as requested through the 
workorder downloaded from the LIS or as 
specified using the Advanced rerun or Set auto 
dilution functions. 

Condition The dilution condition, such as Neat, Down, or Up, 
as requested through the workorder downloaded 
from the LIS or as specified using the Advanced 
rerun or Set auto dilution functions. 

Result coefficient The dilution coefficient as reported by the 
instrument. 

Result condition The dilution condition (Neat, Down or Up) as 
reported by the instrument. 
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Manual coefficient The manual coefficient is the manual dilution 
coefficient specified on the Advanced rerun 
window. 
When a result for the request is received from the 
instrument after manual dilution, the manual 
dilution coefficient is multiplied against the result. 
This manual coefficient value and the calculated 
result value are stored in the result record. Then, 
the manual dilution coefficient value is cleared to 
prevent it from being applied to subsequent 
results. 

Result manual coefficient Contains the manual dilution value used to obtain 
the current result value. 

Field Description
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Severity Tab

The Severity tab includes the following fields: 

Field Description

Norm Displayed when the result is outside the norm ranges. The 
scale of the severity number reflects your range severity 
definitions.
It is positive when the result is above the high limit, or 
negative when the result is below the low limit.

Delta norm A delta check severity is assigned only if a previous sample 
result matching the same patient and test can be found and, 
depending on how the delta norm is defined, if the maximum 
percent difference or absolute difference is exceeded. 

QC The QC severity value can equal a warning, moderate or 
severe control failure depending on how you group and define 
the severities relative to the available Westgard rules. 
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Comment tab
The Comment field of the Comment tab includes free text that is received from 
the LIS with the request.

Instrument Automatically set to the highest severity of the associated 
patient severity instrument flags. 

NOTE: If the Patient severity flag value on the Instrument Flag 
window is greater than this instrument severity value, then the 
Patient severity flag value on the Instrument Flag window 
overwrites this instrument severity value. 

Aggregate An aggregate of the other four severities. It is automatically 
set to their highest absolute value. If this aggregate value is 
different from zero, the result in Review and Edit is red.

Field Description
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Audit tab

The Audit tab includes the following fields: 

Field Description

Validation time Date and time the result was validated by the 
validation user. 

Upload time Date and time the result was uploaded to the LIS 
by the Upload user. 

Omission time Date and time the request was omitted by the 
Omission user. 

Omission note Contains the reason for omission, if applicable. 

Validation user User who initiated the validation. 

Upload user User who initiated the upload. 



171

LIS Previous Result Tab
The LIS tab includes the following fields: 

Omission user User who initiated the omission. 

Field Description

Field Description

Date/Time Lists the date and time in which each previous 
result value for the request was transmitted by the 
LIS. 

Result value Sorted in order of the most recently received 
result, lists all previous results transmitted by the 
LIS for the request. 
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Understanding Quality Control 
The Quality Control (QC) function allows you to view and print the QC data 
collected from all connected instruments. The data can represent control samples 
or patient samples. In either case, each group of QC results pertaining to a given 
sample is represented by a dedicated QC population to which you can apply 
Westgard rule-based control checking and define hold upon failure criteria. You 
can view the QC results of a sample in numerical-tabular format or Levey-
Jennings graphical format through the QC Results (Across controls view) window 
and through the QC Populations window. You can generate printed reports that 
contain graphs and numerical data and statistics by lot or by population.
Control-Based QC Results
Control-based QC results are obtained from tests on samples drawn from QC 
material. They are received in populations identified by instrument and QC lot. 
For each QC lot record that you create, you must create population records to 
hold the target values and ranges per test. You can access other populations 
using the QC Lot window.
QC results are included in Westgard checking when they have a numeric value 
other than unknown and an Instrument Severity of 0. 
QC results that contain a supported comparator can be configured to participate 
in Westgard checking, however, these results do not participate in statistics. 
Patient-Based QC Results
Patient-based QC results, also called moving average results, are obtained by 
averaging test results from patient samples. They are received in populations 
defined by instrument and patient species. Moving average populations are 
created automatically as incoming results are stored.
Patient results uploaded from an instrument are used for patient-based QC only 
when the Check moving average checkbox of the Method window is selected. 
When selected, Bull's algorithm smooths the incoming data and generates a new 
QC result per instrument batch. You can influence the smothing level by 
increasing the value of the Moving average batch size field on the Instrument 
window. The larger the batch, the fewer the number of QC results generated and 
the less they vary.
Patient results that contain a comparator do not participate in moving averages. 
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QC Lots
The QC Lot window provides access to the QC Lot table, which stores records 
representing quality control lots. All QC tests performed on the same QC material 
are grouped into a QC lot. All QC Lots must be defined in the ADVIA CentraLink 
system; otherwise, results for these QC lots are ignored. 
Access the QC Lot window: 
1. At the menu bar, select Start > Routine > Quality control > QC lots > By 

name, lot number. 
The QC Lot query window displays. 

2. To initiate the query and populate the QC Lots browser with the relevant QC 
Lots, select OK. 

Field Description 

Name The name of the QC lot. 

Include expired If selected, expired QC lots as well as current QC lots 
are included in the display on the QC Lots browser. 
If not selected, only current QC lots are included in the 
display. 
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Upon display, the QC Lots browser is automatically sorted by Name followed 
by Lot Number. 

3. To access the QC Lot editor window, double-select a lot on the QC Lots 
browser window. 
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The QC Lot editor window displays. 

Field Description

Lot Number Unique identifier of the QC lot. 

Name Name of the QC lot. 

Level Value that describes the lot level. Required for Bio-Rad, 
a manufacturer of control material, and other 
manufacturers. 
This alphanumeric field has a default value that 
displays as the ? symbol. 

NOTE: This field must be populated with a QC lot level 
value, if you plan to export QC results using the Bio-
Rad point data format. If a level value is not entered, an 
error message displays informing you that the lot level 
is empty. 
See Exporting QC Populations to Text and XML Files‚ 
page 189. 

Description Free text area for describing the QC lot. 
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Adding a New QC Lot
1. At the menu bar, select Start > Routine > Quality control > QC lots > By 

name, lot number. 
The QC Lot query window displays. 

2. At the QC Lot query window, select OK.
The QC Lots browser window displays. 

3. At the QC Lots browser window, select New on the editing toolbar. 
The QC Lots editor window displays. 

4. Enter the lot number. 
The number must match the number entered at the instrument.

5. Type in the new name, level, description, and dates for the new QC lot.
NOTE: You must fill in all fields accurately to avoid unmatched results. 
Ensure that the Expiration date is later than the Start date.

6. Select OK. 

Specifying Test and Instrument Parameters for a QC Lot
Once QC lots are established, you can specify test and instrument parameters for 
each QC lot. In grouping a QC lot with test and instrument parameters and 
specifying target values and deviations, you allow for the QC results to be 
associated with a QC population that accumulates statistics. 
Specify test and instrument parameters for a QC lot from the QC lots window:
1. Right-select the selected lot that requires test and instrument parameters and 

select Populations. 
The QC populations query window displays. See QC Populations‚ page 177 
for more information. 

Start Date Start date before which the lot cannot be used. 

Expiration Date End date after which the lot cannot be used. 

Field Description
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Automating QC Result Upload to the LIS
The system can be configured for automatic upload of raw QC data to the LIS by 
scheduling this function on all QC lots. 
The ADVIA CentraLink system comes pre-configured with an upload command. 
Regardless, you must define a task and associate the command with a task 
scheduler. See Scheduling Tasks‚ page 378. 

QC Populations 
The QC Populations window provides access to the QC population table, which 
stores records representing statistical populations of QC results sharing the same 
instrument, test, and either QC lot, if the result is control based, or species, if the 
result is patient based. 
All QC results associated with the same QC test of a specific QC lot or species 
are grouped in a QC population. The QC population maintains statistics of the 
values of its contained results. 
To contribute to the statistics, QC results must meet the following criteria:
• The result must have a numeric value.
• The result value must be within the range defined by the Ignored deviation 

count. Any result value outside the ignored deviation count value is not used 
in statistics. 

• The result cannot be flagged by an undefined flag or by a flag with a severity 
greater than zero.

• The result must not be omitted. 

You can see a graphical display of these statistics through the Levey-Jennings 
graph. 
Populations can be manually or automatically created within the 
ADVIA CentraLink software. If you do not manually create populations prior to 
processing controls, populations are automatically created upon receipt of the 
first QC result for the respective method and control lot being used. If you choose 
to have your populations automatically created, you must still manually specify 
the target and reference mean and deviation in order for Westgard checks to be 
applied and for QC results to affect autovalidation of patient results.



 

178 ADVIA CentraLink Operator’s Guide

QC populations can be accessed from the main menu, from the Method window, 
and from the QC Lot window. When accessed from the main menu or the QC Lot 
window, the QC population window displays first. 
Access the QC Populations window from the main menu: 

1. At the menu bar, select Start > Routine > Quality Control > QC 
populations.
The QC population query window displays. You can also access the QC 
population query window from the QC Lots window by right-selecting a lot 
number row and selecting Populations. 

Field Description

Test Limits QC data to a specific test. Double-select the field 
to select from a list.
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2. To submit the entered criteria, select OK. 

Instrument group Limits QC data to a specific instrument group. Double-
select the field to select from a list.
When a value is entered into the Instrument group field, 
the Instrument field is disabled. 

Instrument Limits QC data to a specific instrument. Double-select 
the field to select from a list.
When a value is entered into the Instrument field, the 
Instrument group field is disabled. 

Type Select one of the following: 
• Any – does not restrict the result set to type. 
• Control – restricts the result set to populations 

referencing a QC lot. Entering a value to the QC Lot 
field enables additional restriction to the specified 
QC Lot. 

• Patient – restricts the result set to moving-average 
populations referencing a species. Entering a value 
to the Species field enables additional restriction to 
the specified species. 

QC lot Limits QC data to a specific control lot. Double-select 
the field to select from a list.

Species Limits QC data to a specific species. Double-select the 
field to select from a list.

MISPL Filter Limits QC data to a specific special function. Double-
select the field to select from a list.

Field Description
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The QC Populations browser displays. Depending on the criteria you entered, 
this browser displays a range of QC populations. 

3. To view the details of one of the listed QC Populations, double-select on any 
entry. 
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The QC Population editor window displays. 

Field Description

Method Test Method test identifies the test associated with the 
the method to which the population applies. 
When inserting a new QC population, first specify 
the test with the instrument field unspecified. 
Setting the test restricts instrument lookup to only 
those instruments that support the test. 
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Method Instrument Method instrument identifies the instrument 
associated with the method to which the 
population applies. 

Moving average Moving average indicates whether this is a patient-
based population. 
When selected, this moving average checkbox 
specifies that a species, not a QC Lot, is grouped 
with the test and instrument within the QC 
population. 

Target value The target value for the control product.
NOTE: 
When setting the target value to assign population 
reference values, the specified value should be 
within the range of the assay. A reference value 
outside the assay range will cause a severity to be 
generated for an invalid reference result if a 
control result with a comparator (< or >) is 
received.

Target Deviation (1SD) The target deviation for the control product. 

NOTE: If the manufacturer supplies the deviation 
as 2SD, you must divide that number by 2 to 
derive the 1SD value.

Cumulative N The number of results for this test that were closed 
out.

Current N The number of results for this test that have not 
been closed out.

Field Description
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 Ignored deviation count If the difference between a new QC result and the 
reference value is ≥ the ignored deviation count 
times the reference deviation, the new QC result 
does not contribute to the population statistics.
Example: QC population for test WBC 
Reference value: 3.4
Reference deviation: 0.225 
Ignored deviation count: 2. 
QC result: 3.9 
[3.9 (QC result) - 3.4 (Reference value)] ≥ 
[2 (Ignored deviation count) * 0.225 (Reference 
deviation)]. 

Last close out time The date and time when the population was last 
closed out. 

Reference value Used for Westgard checking. This can be set to 
either the Target value or the Mean. To set this, 
right-select the editor and select Set Reference. 
In the Source field, select Target, Current 
Statistics, or Cumulative Statistics.
NOTE: Reference values should be defined with 
values within the range of the assay. A reference 
value outside the assay range will cause a severity 
to be generated for an invalid reference result if a 
control result with a comparator (< or >) is 
received.

Reference deviation Used for Westgard checking. You can set either 
the Target deviation or the Standard deviation. To 
set this, right-select the editor and select Set 
Reference. In the Source field, select Target, 
Current Statistics, or Cumulative Statistics. 

Field Description
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Viewing QC Results for a Population
View QC results for a population from the Results of QC Population window: 
1. Right-select the selected population and select Related > Results. 

The Results of QC population window displays. From this window, you can 
investigate the date and time the QC was assessed, the QC value, and the 
QC severity. 

Viewing a Levey-Jennings Graph
View a Levey-Jennings graph from the QC Populations window: 
1. Right-select the selected population and select Levey-Jennings graph. 
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The Levey-Jennings graph displays.

About the Levey-Jennings Graph
The Levey-Jennings graph displays all QC results in chronological sequence that 
were obtained in the date interval specified using the Since and Until fields. 
These QC results are displayed at equidistant X axis intervals. 
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Levey-Jennings graphs display the following: 
• comparator results with a half-open straight line. 

• instrument log events associated with an instrument and a method and for 
which a QC population exists with a dotted vertical line. Refer to Instrument 
Logs‚ page 291. 
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NOTE: To prevent legibility issues, limit the amount of text for display on the 
Levey-Jennings graph. 

You can modify the display, as described in this section. 
The graph area is color-coordinated to QC standard deviations (SDs): 
• Green band: the green band lies between +/- 2 SD of the reference value.
• Yellow band: the yellow band lies between 2 to 3 SD and -2 to -3 SD of the 

reference value.
• Red band: the red band lies above 3 or below -3 SD of the reference value.

Plotting characters are color-coordinated to reflect severity:
• Green plotting dots are for values that have not violated a Westgard rule; 

that is, the severity check of a QC result is zero. 
• Red plotting dots are for values that have violated a Westgard rule. 
• White plotting dots are or values that are omitted. 

The default Westgard rules are as follows:

TIP: Rest your mouse on a plotting dot to see detailed information about it.
- X = sequential number of the value
- Y = value of point
- Test

1-2s A control result exceeds the reference value (mean) plus or minus 2 SDs.

1-3s A control result exceeds the reference value mean plus or minus 3 SDs.

2-2s Two consecutive control results fall on the same side of the reference 
value mean plus or minus 2 SDs.

4-1s Four consecutive control results fall on the same side of the reference 
value mean plus or minus 1 SD. 

10-x Ten consecutive control results fall on the same side of the mean and are 
within 1 SD of the reference value mean. 

R-4s Two consecutive control results that are on opposite sides of the 
reference value (mean) plus or minus 2SD apart.
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- Assessed time
- Severity
- Cumulative Westgard errors up to that point

The target value and target deviation displayed are values defined on the QC 
population window. The cumulative and current N, Mean, SD, and CV% 
displayed are the actual calculated statistics. 
Change the date interval:
1. Type in a start date in the Since field using the format M/D/YY.
2. Type in an end date in the Until field using the same date format.
3. Select Draw to display the new data for the new date range.
NOTE: Double-selecting either of date fields opens a calendar from which you 
can select the date.

The Button Bar on the Levey-Jennings Graph
The Levey-Jennings Graph includes tools that let you modify the graph.

Button Name Description

Print Displays a print window from which you can select 
a printer, set print options, and print the graph. 

Zoom in Double the zoom factor of the graph. 

Zoom out Divide the zoom factor of the graph by 2. 

Reset zoom Restore the zoom factor to 1:1. 

Free zoom The mouse cursor changes into a magnifying 
glass, and if you select somewhere in the drawing 
area, the screen is zoomed around that point. 

Zoom 
window 

The mouse cursor changes into a drawing cross 
and you can draw a rectangle on the screen. When 
the mouse button is released, the graph is zoomed 
to that rectangle. 
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Exporting QC Populations to Text and XML Files
You can export QC population data as an XML file or as a text file in either the 
Bio-Rad point data or summary data format to ensure that the QC data is 
recognized by most third party QC software. 
You have the ability to select one control population or multiple control 
populations at a time for export. All information for a control population, which 
includes lot number, expiration date, target, target deviation, and test value, can 
be exported in one step. 
NOTE: You can group Bio-Rad text formats by instrument, lot number, and test 
and, you can sort them by date and time and by lot level. 

Group/split 
the data sets

Not applicable in the ADVIA CentraLink system. 

X options Displays a window where you can set all X axis 
options. 

Y options Displays a window where the user can set all Y 
axis options. 

General 
options 

Displays a window where the user can set all 
general options.

Show/Hide 
the legend 

Toggles the display of the legends.

About Displays the About box. 

Button Name Description
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Access the Export window from the QC Population editor window: 
1. Right-select the selected population and select Export. 

 

Field Description 

Accessed From Specify the starting time frame from which QC data is 
accessed for export. 
You can select from the dropdown menu and specify a 
date value or choose from among listed relative date 
values. By selecting Other, you can customize your 
own entry by entering a number, a time interval of day, 
week, month, quarter, or year, and by specifying 
whether this is in the past or the future. 

NOTE: Ensure that the Accessed From value is older 
than the Accessed To value. An invalid date range 
prevents the successful export of QC data. 
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Accessed To Specify the ending time frame to which QC data is 
accessed for export. 
You can select from the dropdown menu and specify a 
date value or choose from among listed relative date 
values. By selecting Other, you can customize your 
own entry by entering a number, a time interval of day, 
week, month, quarter, or year, and by specifying 
whether this is in the past or the future. 

NOTE: Ensure that the Accessed To value is more 
recent than the Accessed From value. An invalid date 
range prevents the successful export of QC data.

Include omitted If selected, omitted results are exported with the QC 
population data. 
If not selected, omitted results are not exported with the 
QC population data. 

Folder Target folder for the output files. The files are named 
automatically and includes a prefix, which is dependent 
upon the selected Format, and a time stamp.

Field Description 
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Format Select from the following options: 
• XML – All summary data (lot number, expiration 

date, target, target deviation, and test value) are 
exported at the same time as the point data. An 
output file can contain multiple population records 
each with multiple result records.

NOTE: If the specified Accessed From value is 
more recent than the specified Accessed To value 
and you choose XML as the format type, the export 
process initiates upon selecting OK, an output file is 
created, but the output file does not contain QC 
results. No error message displays. 

• Bio-Rad point data – Results are output one per line 
with the following data per result: Instrument Name, 
Lot Number, Test Name, AssessmentDate, 
AssessmentTime, Lot Level, QC String Value. Non-
numerical results are skipped.
NOTE: To successfully export data in the Bio-Rad 
point data format, a lot level must be specified on 
the QC Lots editor window. 
NOTE: If the specified Accessed From value is 
more recent than the specified Accessed To value 
and you choose Bio-Rad point data as the format 
type, the following error message displays when 
you select OK: Nothing to Export. 

Field Description 
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2. To initiate the export, select OK. 
Upon export completion, a confirmation message displays.

Evaluating QC Results 
You can obtain QC results in the following ways: 
• Uploaded directly from instruments. These results are associated with a 

method and with a QC lot. 
• Calculated from uploaded results. These results are associated with a 

method on a calculated test and with a QC lot. 

NOTE: To be used in a calculation, input QC results must share instrument, 
QC lot, and assessment time.

• Generated by the patient Moving Average algorithm. These results are 
associated with a method and with a species.

QC Results have the following three associated severities: 
• Westgard severity
• Instrument severity 
• Method severity

To investigate a QC issue, you might have to consider several QC populations. 
Querying provides you with a comprehensive view of QC results because you 
can access results from across different populations, control lots, or species. 

Bio-Rad summary data – Bio-Rad summary data is 
always generated to cover a period of one month. The 
mean, standard deviation, and number of points is 
exported as opposed to the QC string value of the point 
data. In this format, populations are output one per line, 
with the following data per population: Instrument 
Name, Lot Number, Test Name, Minimal Assessment 
Date, 12:00, Lot Level, Selection Mean, Selection 
Standard Deviation, Selection Numeric Count. Non-
numerical results are skipped. 

Field Description 
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Results are displayed on the QC Results (Across controls view) window. You can 
also access a specified result set through the QC Results window. 

Accessing the QC Results (Across controls view) Window
You can navigate directly to the QC Results (Across controls view) window from 
the Review and Edit window, from the QC icon of the QC menu, or from the Start 
menu. 
When you navigate from Review and Edit, the method and instrument are 
preassigned since you navigate from a selected test and instrument. 
When navigating from the QC icon or the Start menu, the fields on the QC 
Results (Across controls view) window are not populated. When you enter criteria 
to the Query Parameters section and select Apply, results matching the entered 
criteria display. 

QC Result Parsing
QC results with a supported comparator are parsed into a numerical value and a 
comparator as is done with patient results.
QC results with a comparator are handled as numeric results and can be 
configured to participate in Westgard checking. 
Consider the following examples: 
• Result sent by instrument is “<0.02”: This value is saved to the database as 

QCResult.NumericValue = 0.02, QCResult.StringValue = <0.02 and 
QCResult.Comparator = <. 

• Result sent by instrument is “>10.0”: This value is saved to the database as 
QCResult.NumericValue = 10.0, QCResult.StringValue = >10.0 and 
QCResult.Comparator = >. 

NOTE: Patient results with an associated comparator, which could be rendered 
after applying method detection limits, are not eligible to contribute to the moving 
average.

Type Error QC Result
A type error QC result occurs when the type of the result value cannot be 
converted to the type of the corresponding test.
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On receipt of an unexpected non-numeric value, the Westgard severity is set to 
0, the Method severity is set to the value in the QC severity on type error field on 
the Autovalidation tab of the Method window, and Type error checkbox is 
selected at the QC Results window. 

Invalid Reference QC Result
A QC Result is considered an invalid reference when the QC result numeric value 
contains a comparator and the QC result is not definitively on the same side of 
the population reference value. The population reference value and reference 
deviation must be specified for a QC result to be considered an invalid reference. 
On receipt of an unexpected invalid reference QC result with comparator, the 
Westgard severity is set to 0, the Method severity is set to the value in the QC 
severity on invalid reference field on the Autovalidation tab of the Method 
window, and the Invalid reference checkbox is selected at the QC Results 
window. 

Consider the following example for a QC population with reference value of 0.495 
and a reference deviation defined. 
• QC result value <0.5 is considered an invalid reference because the actual 

value may be on either side of the reference value. 
NOTE: It is the reference value rather than the reference deviation that 
determines if a result is an invalid reference. 

• QC result value <0.1 is not considered an invalid reference because it always 
falls on the low side of the reference value.

Although QC results that contain a comparator can be configured to participate in 
Westgard checking, these results do not participate in statistics. Accordingly 
patient results that contain a comparator do not participate in moving averages.
Levey-Jennings graph displays comparator results with a half-open straight line.
Access the QC Results (Across controls view) window: 
1. At the menu bar, select Start > Routine > Quality control > QC results. 

You can also select the QC icon on the toolbar. 
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The QC Results (Across controls view) window displays. 

The QC Results (Across controls view) window is comprised of three areas: 
• Query parameters
• Result browser
• Statistics
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Query Parameters Area
The Query Parameters area of the QC Results (Across controls view) window 
allows for you to enter search criteria that restricts the result set that is displayed 
in the result browser area. 

Field Description

Test Restricts the result set to those referencing the 
specified test. This value also restricts a specified 
instrument to those having the specified test 
available.

Instrument Restricts the result set to those referencing the 
specified instrument. This value also restricts a 
specified test to those available on the specified 
instrument.
When a value is entered into the Instrument field, 
the Instrument group field is disabled. 

Instrument group Restricts the result set to those referencing the 
specified instrument group. 
When a value is entered into the Instrument 
group field, the Instrument field is disabled. 

From and To From and To values restrict the result set to those 
assessed between the specified dates and times. 
These fields have the calendar functionality and 
time fields. 
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To initiate the query and populate the result set in the QC Results browser, select 
Apply. 

Type The type of control result. The options are as 
follows: 
• Control – Restricts the result set to those 

obtained from QC material, which references 
a QC lot. 

• Patient – Restricts the result set to only those 
obtained from a moving average of patient 
results, which references some species.

• Any – No type restriction imposed on the 
result set.

Lot Restricts the result set to only those referencing 
the specified QC lot.

Species Restricts the result set to those referencing the 
specified species. 

Include Closed Out Determines whether results that have already 
been closed out are included in the result set.

Sort by Determines the relative order of importance of 
the following fields for sorting the result set in the 
browser: test, instrument, assessment time, and 
lot number. 
The last sort by value you specify is applied 
automatically in your next session.
Select from the following sort by selections: 
• Test-Lot-Assessed-Instrument
• Test-Instrument-Assessed-Lot
• Test-Lot-Instrument-Assessed

Field Description
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Result Browser Area
The Result Browser area of the QC Results (Across controls view) window 
displays the results that match the search criteria entered in the Query 
Parameters area. 

Field Description

Test This column is highlighted when the associated method 
is determined to be critical as per processing the result. 

Instrument This column is highlighted when the associated method 
is determined to be critical as per processing the result. 

Lot/Species Either the QC lot or the species displays. 

Assessed Date and time the result was processed.

C Contains an asterisk when a comment is associated 
with the result. The expanded comment is displayed at 
the bottom of the screen when the result is highlighted 
in the browser.

String Value This column is highlighted when the associated method 
is determined to be critical as per processing the result. 

QC results with a supported comparator are parsed into 
a numerical value and a comparator as is done with 
patient results. 
The String Value field contains the complete string: 
comparator and numeric value. 
The Comparator field contains the comparator; the 
Numeric value field contains the numeric value. 

F Contains an asterisk when a flag is associated with the 
result. The expanded meaning of the flag is displayed 
at the bottom of the screen when the result is 
highlighted in the browser.
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MS This Method Severity field value is set to the highest 
absolute value of the following QC severities:
• Westgard severity

NOTE: If a QC result has an associated flag and the 
instrument flag control severity is greater than zero, 
Westgard checks are not performed and no 
Westgard severities are applied. In this case, the 
Method Severity field value is set to the instrument 
flag control severity even if the flag has a lower 
severity than the Westgard severity for the violated 
Westgard rule. 

• QC severity on type error 
• QC severity on invalid reference
Type errors occur when the received result value 
cannot be converted to the result type of the 
corresponding test.
On receipt of an unexpected non-numeric value, the 
Westgard severity is set to 0 and the QC severity on 
type error is applied. 
Invalid reference error occurs when the QC result 
numeric value contains a comparator and the QC result 
is not definitively on the same side of the population 
reference value. 
QC results with an associated flag where the 
instrument flag control severity is greater than the value 
specified within the QC maximal instrument severity 
field on the More tab of the system Options window are 
automatically omitted.
This MS value can be reset using the Reset Severity 
function. See Resetting QC Severity‚ page 205. 
See Understanding Color Display in the Result 
Browser‚ page 201 for details on color assignments. 

Field Description
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Understanding Color Display in the Result Browser 
The method QC severity column (MS) has the same color coding specifications 
as the severity columns on the Review and Edit window. The colors differentiate 
between different severities assigned to the test results. 
Consider the following severity and color coding specifications: 
• When the QC severity of the method is 1, the background of the MS column 

displays as green. Green signifies moderate severity. 
• When the QC severity of the method is 2, the background of the MS column 

displays as yellow. Yellow signifies high severity.
• When the QC severity of the method is 3 or greater, the background of the 

MS column displays as red. Red signifies severe severity.

When the method QC severity of a QC result exceeds the method QC severity 
limit, the following column backgrounds display in red: test, instrument, and string 
value. 

Levey-Jennings 
-3, -2, -1, 0, +1, +2, +3

These columns display the relative position of the value 
with respect to its population's reference value and 
reference deviation. Colors have the same meaning as 
in the QC Population Levey-Jennings graph: 
• The backgrounds between the -2 to +2 deviation 

columns display in green. 
• The backgrounds between the -2 to -3 deviation 

column and between the 2 to 3 deviation column 
display in yellow. 

• The backgrounds of the -3 deviation column and of 
3 deviation column display in red. 

The deviation values are represented as either dots or 
arrows. Arrows are used for outliers farther than 4SD 
from reference. The dots and arrows are either 
displayed as solid or outlines. An outlined dot or arrow 
is displayed when a result is omitted. 

Field Description



 

202 ADVIA CentraLink Operator’s Guide

Red also displays within the Current column of Review and Edit with a type error 
QC result or an invalid reference QC result with comparator.
• A type error QC result occurs when the type of the result value cannot be 

converted to the type of the corresponding test. 
• An invalid reference QC result occurs when a comparator of a numeric result 

is inconclusive regarding the relative position of the value with respect to the 
population reference value. 

When the QC severity exceeds the QC severity limit, the test, instrument, and 
string value columns continue to display in red until the QC problem is addressed 
and the Reset Severity function is executed. 

Statistics Area
The Statistics area of the QC Results (Across controls view) window allows for 
you to see population statistics for the QC result selected within the Result 
Browser area.
To contribute to the statistics, QC results must meet the following criteria:
• numeric value
• empty comparator field
• not omitted
• exist inside the range defined by the qc population Ignored deviation count
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Field Description

Comment Any comment that has been associated with the 
selected control result. 
NOTE: When a comparator QC result does not 
contribute to Westgard checks, 1 of 2 comments 
displays depending on whether the Include 
comparator QC results checkbox is selected for 
the individual Method on the Method window or 
globally on the Setup Westgard window: 
• When a QC Result is a comparator result and 

the Include comparator QC results checkbox is 
not selected, the following comment displays: 
"Comparator result; not participating in WG 
checks." 

• When a QC Result is a comparator result and 
the Include comparator QC results checkbox is 
selected, but the result is determined to be an 
invalid reference, the following comment 
displays: "Undefined reference result; not 
participating in WG checks."

Either of these additional comments are added to 
the existing comments. Neither of these additional 
comments is uploaded to the LIS nor is it listed on 
reports. 
Refer to Westgard Tab‚ page 312.

Flags The expanded meaning associated with the 
flagged result displays in the Flag field when the 
result is highlighted in the QC Result browser. 
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Target Value The target value of the QC population for the 
selected QC result.  

NOTE: The evaluation of the QC result for 
Westgard checks is performed against the QC 
population reference value and deviation and not 
the Target value and deviation. 

Target Deviation The target deviation value of the QC population for 
the selected QC result.  

NOTE: The evaluation of the QC result for 
Westgard checks is performed against the QC 
population reference value and deviation and not 
the Target value and deviation. 

N The number of QC results contributing to the 
statistics of the QC Population of the selected QC 
result. 

Mean The mean value of the statistics of the QC 
Population of the selected QC result. 

SD The standard deviation of the statistics of the QC 
population of the selected QC result. 

CV % The coefficient of variation of the statistics of the 
QC population of the selected QC result. 

Current This row displays the current statistics of the QC 
population of the selected QC result. 

Cumulative This row displays the cumulative statistics of the 
QC population of the selected QC result. 

Field Description
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Statistics Area Button

Resetting QC Severity 
The Reset Severity function is initiated when the problem that caused the 
method’s QC severity is addressed. Once initiated, the reset severity function 
resets the method’s QC severity field to zero and triggers a new QC result action 
record that is associated with the QC result record referencing the method. 
After the method QC severity of a given QC result exceeds the method QC 
severity limit, the test, instrument, and string value columns of all subsequent QC 
results remain red until the QC control problem is addressed and the Reset 
Severity function is executed.
Once a method displayed in red is highlighted, the Reset Severity button is 
selected, and the method QC severity of the new QC result does not exceed the 
method QC severity limit, the test and instrument columns no longer display in 
red. Instead the columns display with a white background. The string value 
column, however, retains the red background as a permanent indication of the 
QC result’s method QC severity exceeding the method QC severity limit. The MS 
column background also retains the red background. 
NOTE: Failure to reset a QC severity to zero results in the continued reporting of 
a QC severity error on all subsequent instances of that test on the affected 
instrument.

Resetting the QC Severity from the QC Results (Across Controls View) 
Window
Reset the QC severity from the QC Results (Across controls view) window: 
1. Select the Reset Severity button. 

Date range When a date range is specified in the From / To 
fields of the Query Parameters section, this row 
displays the statistics of the QC results that 
correspond to the entered date and time for the 
QC population of the selected QC result. 

Field Description
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The Reset QC Severity window displays and is automatically populated with 
the Instrument and Test value of the QC result highlighted in the QC Results 
browser and is the instrument and test reference for the method for which you 
are clearing the severity. 

2. Enter a comment. 
3. Select OK.
NOTE: The change is not automatically reflected in the QC Results (Across 
Controls View) window. To display the reset severity, press F5 to refresh the 
window or close the window and reopen it.

Resetting the QC Severity from the Instruments Browser
1. Select the Instruments icon on the toolbar.

The Instruments browser window displays. 
2. Right-select the selected instrument that has the associated QC severity that 

you want to reset and select Related > Tests.
3. Select the test that has the associated QC severity you want to reset.
4. Right-select the selected test and select Reset QC Severity. 
5. Enter a comment and select OK. 

The QC severity of the selected test on the selected instrument is reset to 
zero.
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Right-Selecting Functions
Viewing QC Results 
You can access the result record of any QC result that displays in the QC Result 
browser. The result record provides detail information on result values, severity 
flags and includes the following tabs: Failed Westgard checks, Comments. 
You can access the QC Results window from the QC Results (Across controls 
view) section and from the QC Population window. 
To access the QC Results window from the QC Results (Across controls view) 
section: 
1. Double-select a QC result.
To access the QC Results window from the QC Population editor window:
1. Right-select at the QC Population editor window and select Related > 

Results.
2. At the Results of QC Population window, double-select a QC Result. 
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The QC Result window displays with the Failed Westgard Checks tab 
selected.

Field Description 

Population QC lot The QC Lot value indicates that the result is part of a 
control population. Specifies the QC lot from which the 
result was obtained. 

Population species The species value indicates that the result is part of a 
patient moving average population.

Assessment time  The date and time when either a control-based, QC lot 
result was assessed on the instrument or a patient-
based, moving average result was generated.
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String value The string representation of the result value. It can 
contain non-numeric QC values.

Numeric value The numeric representation of the result value.

Type Error The checkbox is automatically selected when a type 
error QC result occurs. 
Type error QC results occur when the type of the result 
value cannot be converted to the Control data type of 
the corresponding test. 

Invalid reference The checkbox is automatically selected when an invalid 
reference QC result with comparator occurs. 
Invalid reference QC result occurs when the 
comparator of a numeric result is inconclusive 
regarding the relative position of the value to the 
population reference value. The term “invalid reference” 
suggests that the comparator was used with a numeric 
value that could be interpreted as a result that may be 
on either side of the population reference value. 

Westgard severity Determined by the severity assigned to the Westgard 
check that was violated for this result. The severities 
are assigned in the Westgard setup sub-tab of the 
Advanced tab of the Method window. 

NOTE: If a QC result has an associated flag and the 
control severity that was defined for that flag is greater 
than zero, Westgard checks are not performed and no 
Westgard severities are applied even if the flag has a 
lower severity than the Westgard severity for the 
violated Westgard rule. 
See Configuring Instrument Tests (Methods) and Flags‚ 
page 300 and Configuring Westgard Rules‚ page 315. 

Field Description 
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Method severity The Method severity is the highest QC severity 
received on a result since the last QC reset. A QC 
result severity is determined by the highest absolute 
value of either the Westgard severity, the instrument 
severity, the QC severity on type error fields. If the QC 
severity of a result exceeds the current method 
severity, this value is copied into the Method severity 
field. 

NOTE: If a QC result has an associated flag and the 
control severity that was defined for that flag is greater 
than zero, Westgard checks are not performed and no 
Westgard severities are applied, even if the flag has a 
lower severity than the Westgard severity for the 
violated Westgard rule. 
See Configuring Instrument Tests (Methods) and Flags‚ 
page 300. 

Field Description 
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Instrument severity Automatically set to the highest severity of the 
associated control severity instrument flags. 
If a result has an associated flag and that flag's control 
severity is greater than zero, the result is automatically 
excluded from Westgard checks. For results with an 
associated flag and the flag's control severity is greater 
than zero and higher than the value specified in the QC 
maximal instrument severity field on the More tab of the 
system Options window, these results are automatically 
omitted and excluded from the population’s current 
statistics.

NOTE: If the instrument severity flag is not relevant to 
QC results, set the Control severity at the Instrument 
Flag window to 0. If the instrument severity flag is 
relevant to QC results, set the Control severity at the 
Instrument Flag window to equal the highest value of 
the Westgard rules applicable to that method.
If an unknown flag is received, the field value is set to 
-5. 
See Setting Instrument Flags‚ page 300. 

Omitted The checkbox is automatically selected when a result is 
omitted. 

Uploaded The checkbox is automatically selected when the result 
is uploaded to the LIS.

Field Description 
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Reagent information When a QC result is received from an instrument and 
ADVIA CentraLink driver that support the upload of 
reagent information, the reagent information is saved 
directly to this field
The reagent information can consist of the reagent lot 
number, reagent expiration date, and the reagent 
sequence number. 
The reagent information value stored in this field can 
also be inherited from the Reagent information field of 
the Method; however, reagent information received at 
the result level has priority over global reagent 
information stored at the Method.
If the Reagent information field on the LIS 2 tab at the 
systems Option window is enabled, result specific 
reagent information is uploaded to the LIS. 

1-2s, 1-3s, 10-x, 2-2s,
4-1s, R-4s 

If selected, the check boxes indicate the available 
Westgard checks that the result failed.

Field Description 
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The Comment tab consists of the following fields:

Accessing QC Result Flags
Access the QC Results Flags window from the QC Results (Across controls view) 
window: 

Field Description 

Instrument comment Comment received with the result from the instrument. 

Parse comment Comment generated by the system. Parse comments 
are comments separated by commas.

User comment Free flow text area. 
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1. Right-select the selected QC result and select Related > Flags.
The Flags of QC result browser window displays. 

2. To populate the QC Result Flag window, double-select on an entry. 
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The QC result flag displays. 

 

Interpreting Non-Numeric QC Results
You can store and save non-numeric QC results. They are not eligible for 
Westgard checking. These non-numeric QC results are excluded automatically 
from the population’s current statistics. Upon this exclusion, an automatic action 
comment is generated, for example “Auto omit of non-numeric result by 
‘sysman’.” 
NOTE: You do not have the ability to re-instate the non-numeric QC results. 

Non-numeric QC results are assigned the QC severity on type error configured 
for the method unless the QC data type is defined as string. 

Field Description 

QC result population 
QC lot

References the applicable QC lot. 

QC result population 
species

References the applicable species. 

QC result assessment 
time

References the date and time that the result was 
accessed. 

Instrument flag References the instrument flag defined on the 
instrument. 
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Non-numeric QC results are excluded from the statistics but they are not auto 
omitted. 
In the QC Results (Across controls view) window, non-numeric results are not 
assigned a point in the Levey-Jennings -3 to +3 fields. 

Omitting a QC Data Point
You can omit individual QC data points from the Current data set. Omitted data 
points are not included in the QC statistics (N, Mean, SD, and CV). 
NOTE: You cannot omit a data point that has already been closed out. Data 
points that were uploaded cannot be omitted. Data points that were calculated 
cannot be omitted.

1. In the QC Results (Across Controls View) window, display the QC information 
for the data point that you want to omit. 
See Accessing the QC Results (Across controls view) Window‚ page 194 for 
detailed instructions.

2. Select the data point that you want to omit. 
3. Right-select the selected data point and select Omit.
4. In the Omit window, enter a comment. 

A comment is mandatory whenever you omit a result.
5. Select OK.

Reinstating an Omitted QC Data Point
1. In the QC Results (Across Controls View) window, display the QC information 

for the data point that you want to reinstate. 
2. Select the data point that you want to reinstate. 
3. Right-select the selected data point and select Reinstate.
4. In the Omit window, enter a comment. 

A comment is not mandatory to reinstate a result.
5. Select OK.
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Auditing a QC Data Point
You can see a record of all actions that were taken on a QC data point.
1. In the QC Results (Across Controls View) window, display the QC information 

for the data point you want to audit. 
2. Select the data point that you want to audit. 
3. Right-select the selected data point and select Related > Actions. 

The Actions on QC Results browser window displays all actions that were 
taken on the selected data point.

Adding a Comment to a QC Data Point
You can add a comment to a QC data point.
1. In the QC Results (Across Controls View) window, display the QC information 

for the data point you want to comment on. 
2. Select the data point about which you want to comment. 
3. Right-select the selected data point and select Edit Comment. 
4. Enter the comment you want and then select Update. 

The comment text displays in the Comment field at the bottom of the window.

Uploading QC Results to the LIS
You can upload control-based QC data to the LIS. By default this upload is by 
population. You can configure it to upload by lot. 
QC results associated with the QC lot that were not uploaded before are 
uploaded. The upload message has the same structure as a sample result 
upload. With the QC upload, however, the sample ID is replaced with the QC lot 
number.
Upload to the LIS is intended primarily for archiving purposes. Any LIS intending 
to perform its own QC checking on data received from the ADVIA CentraLink 
system must take into account that data is uploaded in batches, not in real time, 
as they come in from the instruments. The upload to the LIS is a batch-enabled 
process. QC upload messages typically contain many results for the same test, 
each identified with an instrument and an assessment time stamp.
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Upload QC results by lot to the LIS from the QC lots window: 
1. Right-select the selected lot and select Upload results. 

The Upload results window displays. 

Field Description 

Max Days Specifies the maximum number of days back from the 
current day from which to collect results.This value 
limits the size of upload messages. If left unspecified, 
no day limit applies.

NOTE: If this is the very first time that QC data are 
being uploaded, select 1 for 1 day in the Max Days field 
to limit the amount of QC data uploaded to the LIS and 
to avoid impacting communication with a large amount 
of data at one time. 

Include not closed out If selected, QC results that are not closed out are 
eligible for upload. 
If not selected, QC results that are not closed out are 
not eligible for upload. 
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Closing Out QC
Performing the QC Close Out procedure removes all QC data from the Current 
QC calculations and includes the closed-out data in the Cumulative QC 
calculations.

Closing Out QC for All Instruments
1. At the menu bar, select Start > Routine > Quality Control > QC Close Out. 

The following message displays: “Do you want to close out all the Daily QC?” 
2. Select Yes.

Closing Out QC for a Single Instrument
1. At the menu bar, select Start > Configuration > Instruments. 

The Instrument browser window displays. 
2. Select the instrument that you want to close out.
3. Right-select the selected instrument and select QC Close Out. 

The following message displays: “Do you want to close out all the Daily QC?” 
4. Select Yes.

Group message by lot If selected, a single message containing all eligible QC 
results associated with the QC lot is sent to the LIS. 
If not selected, separate messages for each QC 
population are sent to the LIS. 

NOTE: If the number of results in one single message is 
greater than 10000 results, selecting this checkbox and 
thereby grouping the QC result upload on a single 
message can impact communication performance. If 
this is the very first time that QC data are being 
uploaded, the recommendation is to group by QC 
Population. 

Field Description 
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Importing ADVIA 120/2120 QC Data
1. Place the ADVIA 120/2120 QC floppy disk into the disk drive. 
2. At the menu bar, select Start > Routine > Quality Control > ADVIA 120 QC 

Configuration Import. 
The ADVIA 120 QC Import window displays. 

3. Double-select the Data file field to specify the data file name. 
The Control file field is automatically populated. Do not change this value.

4. Optionally you can enter the Name of the supplier and a Description.
5. Double-select the Instrument field and select from the list.
6. Select OK. 

Generating QC Reports 
You can generate the following QC reports: 
• QC lots
• QC populations
• QC results
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Generating QC Lot Reports 
The QC Lot Reports window allows you to generate text or HTML reports on QC 
populations by lot. 
Data in the heading section of the generated report consists of the name of the 
QC lot and can include current, cumulative, and date range statistics. 
When the From and To date range parameters are specified on the Reports 
window, the current, cumulative, and date range statistics are displayed in the 
report heading. 
When the From and To date range parameters are not specified on the Reports 
window, no date range is displayed in the heading and the current and cumulative 
statistics are displayed at the bottom of the report. 
Generate a QC Lot report from the QC Lot window: 
1. Right-select the selected lot and select Report. 

The Report window displays. 
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Field Description

Format Select HTML or Text. 
The text format requires a line width of up to 132 
characters. Ensure that your Windows font or page 
orientation settings are properly set to avoid text 
wrapping. 
Graphs are available in HTML format only. The graphs 
might not display properly when scrolling during 
preview.

Instrument The instrument from which you want to include QC 
populations in the report. 
When a value is entered into the Instrument field, the 
Instrument group field is disabled. 

Instrument group The instrument group from which you want to include 
QC populations in the report. 
When a value is entered into the Instrument group field, 
the Instrument field is disabled. 

From and To Delimit the from and to dates and time. Only QC results 
assessed within the specified time frame are used in 
the report. 
You can enter a range of dates and times or you can 
select the dates from the Calendar window. 
Entering a date range determines whether current, 
cumulative, and report statistics are displayed in the 
report heading. 

Sort by Select Instrument or Test. 
The Sort by field determines the sequencing of the QC 
populations displayed in the report. 

Preview If selected, a preview of the report is displayed on 
screen prior to printing. 
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Generating QC Population Reports 
The QC Populations Reports window enables you to generate text or HTML 
reports on QC populations. 
You can generate a QC Population report containing Levey-Jennings graphs, and 
you can direct its output to screen or to a printer. You can run the report on a 
selection of more than one population at once.
The header section of the report includes Target value, Target deviation, and 
From and To date range when the From and To date range parameters are 
specified on the Report window. 
The N, Mean, SD and CV% statistics are displayed for Date range, Current, and 
Cumulative. When a date range is not specified on the Report window, the Date 
Range statistics fields are bland. Depending on the close out data, the Current 
and Cumulative statistics fields could be blank. 
In the graph section, the background colors are displayed as follows: 
• The backgrounds between the -2 to +2 deviation columns display in green. 
• The backgrounds between the -2 to -3 deviation column and between the 2 to 

3 deviation column displays in yellow. 
• The backgrounds of the -3 deviation column and of 3 deviation column 

displays in red. 

The deviation values are represented as either dots or arrows. Arrows are used 
for outliers farther than 4SD from reference. The dots and arrows are either 
displayed as solid or outlines. An outlined dot or arrow is displayed when a result 
is omitted. 
In the bottom, tabular section, the comment column contains result comments 
and action comments like Omit and Reinstate. When applicable, the comments 
are expanded. 
Generate a QC Population report from the QC Population window: 
1. Right-select the selected population and select Report.

Printer The printer to which the output of the report is directed. 

Field Description
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The Report window displays. 

Field Description

Format Select HTML or Text. 
The text format requires a line width of up to 132 
characters. Ensure that your Windows font or page 
orientation settings are properly set to avoid text 
wrapping. 
Graphs are available in HTML format only. The graphs 
might not display properly when scrolling during 
preview.

From and To Delimit the from and to dates and time. Only QC results 
assessed within the specified time frame are used in 
the report. 
You can enter a range of dates and times or you can 
select the dates from the Calendar window. 
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Generating QC Result Reports
You can generate a QC report using the generic print function. 
This generic print function generates simple multiple-record text reports with 
dynamic content that is applicable to the selected records. 
Generate a QC Result report: 
1. At the menu bar, select Record > Print. 

The online report displays. 

Sort by Select Instrument or Test. 
The Sort by field determines the sequencing of the QC 
populations displayed in the report. 

Preview If selected, a preview of the report is displayed on 
screen prior to printing. 

Printer The printer to which the output of the report is directed. 

Field Description
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Manually Entering a Result
Manual result entry is available when you must enter results from a non-
connected instrument. 
Access the Result entry window: 
1. At the menu bar, select Start > Routine > Result entry. 

You can also select the Result entry icon on the toolbar. 
The Result entry window displays. 
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Field Description 

Instrument The instrument on which the tests are scheduled. 
Double-select the ? symbol of the Instrument field to 
display a list of instruments. 
When an instrument is selected, the Test selection area 
below the Test field is automatically populated with the 
tests defined on the instrument. 

Worklist When an instrument value populates the instrument 
field and you double-select the ? symbol of the Worklist 
field, the worklists for the associated instrument display 
in the Worklists for instrument browser window. 
Upon double-selecting a worklist, the selected worklist 
value populates the Worklist field and all of the samples 
associated with this worklist are listed and display in the 
Sample selection area below the Sample ID field. 

Create new If selected, the tests and samples selected on this 
window will be stored as a new worklist for the selected 
instrument. 

Test The tests scheduled to the instrument. 
If you double-select the ? symbol of the Test field, the 
tests defined for the associated instrument display in 
the Test browser window. Upon double-selecting a test, 
the selected test value populates the test field. 

Test selection area Displays the tests defined to the instrument. 
When an instrument value populates the Instrument 
field, the Test selection area is automatically populated 
with the tests defined on the instrument. 
Within this area, you can select the applicable tests. 
To delete a test from the list, select the test and select 
Clear. 
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2. Select OK. 

Clear To clear the Test selection list area, select Clear. 

Sample list Select Sample list to enable sample lookup in the 
Sample ID field. 

Sample ID Double-select to display a list of samples. Select a 
sample ID, then OK. Repeat as needed to select more 
samples.

Clear button Select to clear the selection in the Sample ID field.

Collected from / to Double-select to display a calendar or enter a date and 
time interval to limit the samples selected in MM/DD/YY 
format.

Max samples Enter a number to set the maximum number of entries 
in the Result Entry window. 

Grid type The style in which the result entry grid displays:
• Standard - All selected tests display next to each 

other.
• Tiled - New rows are automatically added within the 

associated area when the number of tests exceeds 
the space allotted for one row of tests. 

• Dynamic - Each test displays vertically. The test 
name displays next to the associated result. 

Field Description 
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The Result entry window displays.
NOTE: The Result entry display type depends on the Grid type selected. You 
cannot invert selection in grid mode. The entire grid is always selected. 

3. To move to any cell, press TAB. 
4. Type in the appropriate value in each cell. 

After you enter a value and press TAB, the value becomes read-only. 
Continue until all values are entered. 

5. Select Close. 

Printing a Worklist 
1. At the Result entry grid display, select Print from the tool bar or select the 

Print icon. 
The Worklist printing window displays. 

Field Description

Report type The generated worklist can be of the following types: 
Full - All rows and columns of the worklist display.
Rows - Only rows of the worklist display. 
Columns - Only columns of the worklist display. 

Printer Reference to the printer to which the generated worklist 
is output. 
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Set as default If selected, the specified Report Type is saved as the 
default. 

Preview If selected, a preview of the worklist is displayed on 
screen prior to printing. 

Field Description



231

Manually Entering a Workorder
The ADVIA CentraLink system allows you to enter test orders manually to create, 
supplement and correct workorders:
• Create a new workorder. 
• Supplement the order entry process from the LIS. You can order requests by 

panel (battery/Profile) or as a a single test. 
• Correct a workorder. 

Creating a New Workorder
1. At the menu bar, select Start > Routine > Order entry. 

You can also select the Order entry icon on the toolbar. 
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The Order Entry window displays. 

2. Type the Sample ID. 
The ADVIA CentraLink software supports Sample IDs with a maximum of 16 
characters.
NOTE: Use caution when using sample ID values consisting of 16 uppercase 
alpha characters. While the sample ID is accepted by the ADVIA CentraLink 
software, the 15th and 16th, uppercase, alpha characters display as if they 
were truncated in the ADVIA CentraLink software. Upon subsequent retrieval 
of the sample ID at the Sample browser window, the 16th character does not 
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display, and at the Review and Edit window, both the 15th and 16th 
characters do not display. For example, if you enter a sample ID value of 
“ABCDEFGHIJKLMNOP," the sample ID value "ABCDEFGHIJKLMNO" 
would display at the Sample browser window and the sample ID value 
"ABCDEFGHIJKLMN" would display at the Review and Edit window. 
You can enlarge the size of the Sample browser window or Review and Edit 
window to increase the Sample ID field and display the full Sample ID value.
For information on resizing windows in the ADVIA CentraLink software, refer 
to Using the Workspace‚ page 22. 
NOTE: The Sample ID value originates from the LIS, the barcode on the 
container, or the Order Entry form. Mandatory field entry.

3. Enter the tests that you are ordering in Requests. Mandatory field. 

If... Then...

you know the code or mnemonic for 
a test

you can enter it directly and press 
ENTER to add it to the list. You can also 
enter a list of known codes separated by 
commas and press ENTER. 

If you want to enter tests from a list double-select the Requests field to open 
the Requestables browser. 
Each test mnemonic is listed as Smp 
(simple) or Pan (panel) in the Type 
column to indicate that it is a single test 
or a group of tests. To limit the display to 
simple or panel display, select Options 
and select the type.

you want to learn more about a test 
before ordering it

select the test on the Requestables 
window and right-select to display 
additional information. 

you want to enter a single test on the 
order

double-select the test line on the 
Requestables window.
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NOTE: Sample ID and Requests are the only required fields on the window. 
NOTE: If a test name that consists of 20 characters was entered at the Test 
window, the test name value appears to be truncated in the Requests field at 
the Order Entry window. To verify the entire test name, put your cursor in the 
Requests field and press the right arrow key until each of the remaining 
characters of the test name display. Avoid entering test names that consist of 
20 characters. 

4. Enter the Collection D/T. 
If the Collection Date and Time values are specified, these values are 
automatically populated in the Collection D/T field for the next manual work 
order. You can override or clear the value in the Collection D/T field, however, 
for each new manual work order created. Once the Order Entry window is 
closed, the value in the Collection D/T field is cleared. 

5. Double-select Sample types to display a list of sample types. 
6. Double-select Container type to display a list of container types.
7. Double-select Patient ID to display a list of patients.
8. At the list of patients, double-select the appropriate patient to enter patient 

information on the order in most of the remaining fields. 
NOTE: If the patient is not on the list, you can manually add the new patient 
information. When you select OK to submit the order, the system prompts 
whether you want to create the new patient record. If a patient record already 
exists with the Patient ID that you are specifying, a popup window prompts 
you to confirm whether you want to update the patient record. If you select 
Yes, the patient record is updated and all sample records that reference the 
patient record are updated. If you select No because you do not want to 

you want to enter multiple tests select each test and press the 
SPACEBAR. 
Select OK to transfer the selected list to 
the Order Entry editor. When a test is 
selected, the leftmost column displays a 
> character.

If... Then...



235

update the patient records, a message window prompts that the specified 
patient data conflicts with stored patient data. Select OK. 
NOTE: Depending on the size setting in use for the Review and Edit window, 
the patient name may not display in full. To display the full patient name either 
enlarge the size of the Review and Edit window or right-select on the request 
and select Related > Patient. 

9. Double-select Patient location to select from a list of patient locations. 
NOTE: The Encounter field is reserved for future use. 

10. Select the More tab to add a comment about the order.
11. Select OK.
If the manual work order you submit has the same sample ID as another work 
order, the system displays a duplicate sample ID warning. If the manual work 
order you submit has the same sample ID as another work order and that work 
order is unsolicited and was received from an instrument rather than the LIS, the 
ADVIA CentraLink system displays a message that you can merge the orders. In 
this case, select the Merge button on the Order Entry window.
NOTE: When you select OK or Merge to submit an order, the Order Entry 
window remains open to accept another order. To close the window, select 
Cancel. 
If you entered a new patient record for the work order, the system prompts you on 
whether to create the new patient record. If you select Yes, the patient record is 
updated and all sample records in the ADVIA CentraLink database that reference 
the patient record are updated. If you select No, the patient record is not updated. 

Merging a New Test into an Existing Workorder
1. Select the Order entry icon.
2. Type the Sample ID. 
3. Enter the tests that you are ordering in Requests.
4. To merge sample results with an unmatched workorder, select Merge. 

The system merges the two orders.
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Ratio and Component Tests Ordered Manually
A ratio test is a test whose result is calculated from the results of other test 
results. A component test is a test whose result can be used in the result 
calculation of a ratio test. A test is set up as a ratio test by your administrator. An 
example of a ratio test that could be defined is HCT, where RBC and MCV are the 
component tests used to calculate the ratio test. 
If you order a ratio test manually, the component tests are automatically ordered. 
You can also manually order a component test only.
If you delete a component test from the order, the ratio test is automatically 
deleted.
If you delete a ratio test from the order, the component tests remain in the order.

Updated LAS Information Uploaded to Fields on LAS Tab 
After the workorder information is downloaded to the LAS, the sample completes 
processing the tests of its workorder, and the sample tube routes to cold storage, 
the LAS status fields of the LAS tab of the Order Entry window are automatically 
populated with location information. 
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The SeqNo field is populated with the sequence number of the LAS system that 
uploaded the LAS information. 
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Accessing Patient Records
Depending on the security parameters defined by your administrator, you could 
have limited access to patient information.
1. At the menu bar select Start > Routine > Patients > By birth date / By ID / 

By Lastname, Firstname.
You can also select the Patients icon on the tool bar. 
The Patients browser window displays.

2. Double-select a patient to access the Patient editor window.
The Patients editor window displays. 

3. Modify information in the editor and select OK.
NOTE: Depending on the size setting in use for the Review and Edit window, 
the patient name may not display in full. To display the full patient name either 
enlarge the size of the Review and Edit window or right-select on the request 
and select Related > Patient. 
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Accessing Physician Records
1. At the menu bar select Start > Routine > Physicians > By ID / By 

Lastname, Firstname. 
You can also select the Physicians icon on the toolbar. The Physicians 
browser window displays. 

2. Double-select a physician to open the Physician editor window.
The Physician editor window displays. 

Field Description

Physician ID Identification number that uniquely identifies the 
physician. 

Last name, First name, 
Title, Address

Physician name and address information. 
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Selecting a Report Format for a Physician
Requesting physicians may have different report preferences. You can respond 
to these preferences by associating a specific report model with a physician 
name. When such an association is made, the report model is used whenever a 
workorder contains the physician’s name.
1. In the Physicians browser window, double-select a physician. 

The Physician editor window displays. 
2. Double-select in the Report model field. 

The Report models window displays.
NOTE: Report models are initially configured by your system administrator. 

3. Double-select the report model name in the Report models browser window 
that you want associated with the physician. 
The name of the selected report model displays in the Report model field.
For information on configuring a report model, see Configuring a Report 
Model‚ page 328. 

4. Select OK. 

Phone The phone number at which the physician can be 
reached. 

Fax The fax number to which reports, which are Via fax 
enabled as specified at the Report window, can be sent. 
NOTE: This fax number value serves as the default to 
which files are sent when the Via fax checkbox at the 
Report window is selected. Refer to Generating a 
Sample Report‚ page 86. 

Report model The name of the template in which the physician report 
is based. 

Language The language used when printing reports for samples 
for this physician. 

Field Description
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Configuring Test Settings
This section describes how to add a new test and how to configure the 
ADVIA CentraLink system settings for the following items:
• Units (standard measures)
• Dimensions (standard measures)
• Requestables (tests or panels that can be selected for a workorder)
• Delta Norms (delta checking)
• Norms (range checking)
• Result choices (alternatives for test results)
The Tests browser window displays the tests that are defined in the 
ADVIA CentraLink system. 

Adding a Test Definition
1. At the menu bar, select Start > Configuration > Tests > By name. 

You can also select the Tests icon on the toolbar. 
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The Tests browser window displays. 
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2. To access the Test editor window, select the New icon.

The Test editor window displays with the Basic tab activated.  

Field Description

Name A unique identifier for the test
Upon entering a change to the Name field, a message 
displays warning that modifying the Name of the test 
does not modify the corresponding requestable name. 
If necessary, update the Name of the corresponding 
requestable
NOTE: Do not enter a test name value of 20 characters 
or more. While the test name is accepted by the 
ADVIA CentraLink software, the test name value 
appears to be truncated when it displays at the Order 
Entry and Review and Edit windows. 



 

246 ADVIA CentraLink Operator’s Guide

Sample type Whole blood, serum, plasma, or other. 
Upon entering a change to the Sample type field, a 
message displays warning that modifying the Sample 
type can affect how the test is processed at the 
instrument. 

Description Description of the test.

Group Reference to the Test Group, which represents the 
name of the group into which tests are organized.

Patient data type The acceptable patient data type values that apply to 
patients results include the following: 
• Numeric - Numeric results are expressed in a given 

Control Unit and can be used in numerical 
computation; for example, in comparisons against 
normal ranges and statistics. 

• String
• Enumerated - Enumerated results must match one 

of a fixed set of result choices, for example, +, ++, 
+++. 

• Image - Image results can reference image data on 
the file system. 

• Complex result values are composed of individual 
pieces of arbitrary labeled information, which allows 
for loss-less forwarding from the instrument to the 
LIS. You cannot view or edit these result values.

• Graph - Electrophoresis results can display online 
as graphical representations and can be printed on 
sample reports of type HTML. 

• NOTE: While electrophoresis is supported, the 
functionality is not currently used in the 
ADVIA CentraLink software.

Field Description
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Control data type The acceptable control data type values that apply to 
QC results include the following: 
• Numeric - Numeric results are expressed in a given 

Patient Unit and can be used in numerical 
computation; for example, in comparisons against 
normal ranges and statistics. 

• String
• Enumerated - Enumerated results must match one 

of a fixed set of result choices, for example, +, ++, 
+++. 

• Image - Image results can reference image data on 
the file system. 

• Complex result values are composed of individual 
pieces of arbitrary labeled information, which allows 
for loss-less forwarding from the instrument to the 
LIS. You cannot view or edit these result values. 
The complex datatype allows for composite data 
support, which makes it possible to receive, store, 
and transmit microbiological culture and sensitivity 
data as well as blood transfusion data.

• Graph - Electrophoresis results can display online 
as graphical representations and can be printed on 
sample reports of type HTML. 

• NOTE: While electrophoresis is supported, the 
functionality is not currently used in the 
ADVIA CentraLink software.

Field Description
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Patient unit Reference to the unit in which the patient results of 
numeric tests are expressed. 
WARNING: The units of measure for a given test must 
be defined identically at the LIS, in the 
ADVIA CentraLink software, and at the instruments. 
The units for test results uploaded from the instrument 
are not read by the ADVIA CentraLink software. You 
must predefine the units for tests in the 
ADVIA CentraLink software to match the units for tests 
on the instrument. If units of measure of results are 
manually changed on an instrument, you must change 
the units of measure for the test in the 
ADVIA CentraLink software at that time. In addition, 
you must purge all existing results for the test from the 
ADVIA CentraLink software. Units of measure are not 
uploaded to the LIS from the ADVIA CentraLink 
software. 

Control unit Reference to the unit in which the QC results of 
numeric tests should be expressed. 

Alternate unit Set an alternate unit if the unit used in the 
ADVIA CentraLink software is different from the one 
reported by the instrument. 
Upon entering a change to the Alternate unit field, a 
message displays warning that modifying the Alternate 
unit can affect the reporting of new results.

Unit coefficient Coefficient (factor) for converting from the standard to 
the alternate unit.
Upon entering a change to the Unit coefficient field, a 
message displays warning that modifying the Unit 
Coefficient can affect the reporting of new results. 

Field Description
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Unit term Constant required to convert from the standard to the 
alternate unit. 
Upon entering a change to the Unit term field, a 
message displays warning that modifying the Unit term 
can affect the reporting of new results.

Seq no Sequence number. Used to define the sequence of the 
tests on reports and on the Review and Edit window. 
Sequence numbers do not have to be unique or 
consecutive. 

Patient reported 
decimals

The number of decimal places used to represent 
patient results on the Current column of the Review and 
Edit window, on reports, and that is uploaded to the LIS 
is configurable. 
For new tests, the default value is the ? symbol. 
NOTE: The ? symbol in this field means that the 
ADVIA CentraLink software will display exactly the 
same number of decimal places uploaded from the 
instrument up to and including 9 decimal places. 
Upon entering a change to the Patient reported 
decimals field, a message displays warning that 
reported decimals of a numeric test can round both new 
and existing patient results. 
If you enter a value less than 2, a message displays 
warning that the result could be rounded. You must 
confirm that the value you want to enter is less than 2. 
The ADVIA CentraLink software stores the result as it is 
received from the instrument. This result value 
populates the Prev Run column of the Review and Edit 
window and this value is not rounded. 
If the Prev Run value is reverted, this value will be 
rounded before populating the Current column of the 
Review and Edit window. 

Field Description
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Affects of Control Reported Decimals on Instrument QC Results
Numeric Value
The numeric value of the instrument QC result is always the value received from 
the instrument. You can view the numeric value on the detailed QC Result 
window. To open the detailed QC Result window to view the numeric value, 
double-select a QC result on the QC Results (Across controls view). You can also 
view the numeric value in the Levy Jennings graph. 
NOTE: The exception is when more than 9 decimals are received from the 
instrument. Under this circumstance, the numeric QC result value is rounded to 9 
decimal places.
String Value 

Control reported 
decimals

The number of decimals used to represent instrument, 
patient moving average, and calculated QC results is 
configurable. The Control reported decimal value 
determines the number of decimals to which the QC 
result is rounded. 
Upon entering a change to the Control reported 
decimals field, a message displays warning that 
reported decimals of a numeric test can round both new 
and existing QC results. 
If you enter a value less than 2, a message displays 
warning that the precision level of QC results being 
registered will be reduced. 
For instrument QC results, refer to Affects of Control 
Reported Decimals on Instrument QC Results‚ 
page 250. 
For patient moving average QC results, refer to Affects 
of Control Reported Decimals on Patient Moving 
Average Results‚ page 253. 
For calculated QC results, refer to Affects of Control 
Reported Decimals on Calculated QC Results‚ 
page 254. 

Field Description



251

• Control reported decimal default value (?)
For QC results, the default value is the ? symbol. 
If the ? symbol populates the Control reported decimals field for instrument 
QC results, the decimal precision of the instrument QC result displayed in the 
String Value column on the QC Across Controls View window is the same as 
that of the result value received from the instrument. 
NOTE: The exception is when more than 9 decimals are received from the 
instrument. Under this circumstance, the numeric QC result value is rounded 
to 9 decimal places. 

• Control reported decimal value (0-1)
If you enter a Control reported decimals value less than 2, a message 
displays warning that the result could be rounded. You must confirm that you 
want to enter a value less than 2.
When a Control reported decimals value of 0-1 is entered, the displayed 
value in the String Value column is rounded to the specified number of 
decimals: 0 or 1. 

• Control reported decimal value (2-9) 
When a Control reported decimals value of 2-9 is entered, the displayed 
value in the String Value column is rounded to the specified number of 
decimals: 2, 3, 4, 5, 6, 7, 8, or 9. 

Mean and SD 
When the Control reported decimal value is set to 0, 1, or the ? symbol, the 
displayed value of the Mean and SD fields on the QC Across Controls View 
window is 2 decimal places. 
When the Control reported decimal value is between 2 and 9 inclusive, the 
displayed decimal precision of the Mean and SD fields is the specified number of 
decimal places. 
Target Value and Target Deviation 
On the QC Across Controls View window, the Target value and Target Deviation 
value are displayed as entered without rounding. 
Upload to LIS
Upon QC Result upload, the Control reported decimal value determines the 
number of decimals to which the QC result is rounded. 



 

252 ADVIA CentraLink Operator’s Guide

• Control reported decimal default value (?)
When the ? symbol populates the Control reported decimals field for 
instrument QC results, the decimal precision of the instrument QC result 
uploaded to the LIS is the same as the decimal precision received from the 
instrument. No rounding occurs except when more than 9 decimals are 
received from the instrument. Under this circumstance, the numeric QC result 
value is rounded to 9 decimal places.

• Control reported decimal value (0)
When you enter a Control reported decimals value of 0, the decimal precision 
of the instrument QC result uploaded to the LIS is 0 decimal places.

• Control reported decimal value (1)
When you enter a Control reported decimals value of 1, the decimal precision 
of the instrument QC result uploaded to the LIS is 1 decimal place.

• Control reported decimal value (2-9) 
When a Control reported decimals value of 2-9 is entered, the decimal 
precision of the instrument QC result uploaded to the LIS is the specified 
number of decimals: 2, 3, 4, 5, 6, 7, 8, or 9. 

* = whatever value comes from the Instrument
Table 1: Decimal Places for Instrument QC result

Control 
Reported 
Decimal

Numeric 
Value

Across 
Control 
(String 
Value)

Mean/SD Levy 
Jennings
(Y value)

BioRad 
Data

Sent to 
LIS

? * * 2 2 * *

0 * 0 2 2 0 0

1 * 1 2 2 1 1

2-9 * 2-9 2-9 2-9 2-9 2 – 9
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Affects of Control Reported Decimals on Patient Moving Average Results
Numeric Value
The numeric value of the patient moving average QC result is set to the decimal 
precision specified by the Control reported decimals value. When the ? symbol, 
0, or 1 is specified, the decimal precision is 2. When 2-9 is specified, the decimal 
precision is the specified value. You can view the numeric value on the detailed 
QC Result window. To open the detailed QC Result window to view the numeric 
value, double-select a QC result on the QC Results (Across controls view). You 
can also view the numeric value in the Levy Jennings graph. 
String Value 
• Control reported decimal default value (?)

For QC results, the default value is the ? symbol. 
If the ? symbol populates the Control reported decimals field for patient 
moving average QC results, the decimal precision of the patient moving 
average QC result displayed in the String Value column on the QC Across 
Controls View window is 0, 1, or 2 decimal places. 

• Control reported decimal value (0)
If you enter a Control reported decimals value of 0, a message displays 
warning that the result could be rounded. You must confirm that you want to 
enter the value 0.
When a Control reported decimals value of 0 is entered, the displayed value 
in the String Value column is rounded to 0 decimal places. 

• Control reported decimal value (1)
If you enter a Control reported decimals value of 1, a message displays 
warning that the result could be rounded. You must confirm that you want to 
enter the value 1. 
When a Control reported decimals value of 1 is entered, the displayed value 
in the String Value column is rounded to 1 decimal place.

• Control reported decimal value (2-9) 
When a Control reported decimals value of 2-9 is entered, the displayed 
value in the String Value column is rounded to the specified number of 
decimals: 2, 3, 4, 5, 6, 7, 8, or 9.
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Mean and SD 
When the Control reported decimal value is set to 0, 1, or the ? symbol, the 
displayed value on the QC Across Controls View window of the Mean and SD 
fields is 2 decimal places. 
When the Control reported decimal value is set between 2 and 9 inclusive, the 
displayed decimal precision of the Mean and SD fields is the specified number of 
decimal places. 
Target Value and Target Deviation 
On the QC Across Controls View window, the Target value and Target Deviation 
value are displayed as entered without rounding. 
Upload to LIS

Regardless of the value that populates the Control reported decimals field for 
patient moving average QC results, no patient moving average QC result is 
uploaded to the LIS.

* = whatever value comes from the Instrument
Table 2: Decimal Places for Patient Moving Average QC result

Affects of Control Reported Decimals on Calculated QC Results
Numeric Value
The numeric value of the calculated QC result is set to the result length of the 
calculation with a limit of 9 decimal places. You can view the numeric value on 
the detailed QC Result window. To open the detailed QC Result window to view 

Control 
Reported 
Decimal

Numeric 
Value

Across 
Control 
(String 
Value)

Mean/SD Levy 
Jennings
(Y value)

BioRad 
Data

Sent to 
LIS

? 2 0-2 2 2 0-2 N/A

0 2 0 2 2 0 N/A

1 2 1 2 2 1 N/A

2-9 2-9 2-9 2-9 2-9 2-9 N/A
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the numeric value, double-select a QC result on the QC Results (Across controls 
view). You can also view the numeric value in the Levy Jennings graph. 
String Value 
NOTE: For calculated QC results, the value displayed in the StringValue column 
of the Across Controls View screen never has more decimals places then the 
number of places of the numeric value.
• Control reported decimal default value (?)

For QC results, the default value is the ? symbol. 
If you use the ? symbol for Calculated QC Results, the ADVIA CentraLink 
software displays a variable number of decimal places depending on the 
result of the calculation. To avoid the variable precision that results from using 
the ? symbol, set the control reported decimal value to the required precision. 

• Control reported decimal value (0)
If you enter a Control reported decimals value of 0, a message displays 
warning that the result could be rounded. You must confirm that you want to 
enter the value 0. 
When a Control reported decimals value of 0 is entered, the displayed value 
in the String Value column is rounded to 0 decimal places. 

• Control reported decimal value (1)
If you enter a Control reported decimals value of 1, a message displays 
warning that the result could be rounded. You must confirm that you want to 
enter the value 1. 
When a Control reported decimals value of 1 is entered, the displayed value 
in the String Value column is rounded to 1 decimal place.

• Control reported decimal value (2-9) 
When a Control reported decimals value of 2-9 is entered, the displayed 
value in the String Value column is rounded to the specified number of 
decimals: 2, 3, 4, 5, 6, 7, 8, or 9.
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Mean and SD 
When the Control reported decimal value is set to 0, 1, or ?, the displayed value 
on the QC Across Controls View window of the Mean and SD fields is 2 decimal 
places. 
When the Control reported decimal value is set between 2 and 9 inclusive, the 
displayed decimal precision of the Mean and SD fields is the specified number of 
decimal places. 
Target Value and Target Deviation 
On the QC Across Controls View window, the Target value and Target Deviation 
value are displayed as entered without rounding. 
Upload to LIS
• Control reported decimal default value (?)

If the ? symbol populates the Control reported decimals field for calculated 
QC results, the decimal precision of the calculated QC result uploaded to the 
LIS is the variable result length of the calculation, which is the string value.

• Control reported decimal value (0)
When you enter a Control reported decimals value of 0, the decimal precision 
of the calculated QC result uploaded to the LIS is 0 decimal places.

• Control reported decimal value (1)
When you enter a Control reported decimals value of 1, the decimal precision 
of the calculated QC result uploaded to the LIS is 1 decimal place.

• Control reported decimal value (2-9) 
When a Control reported decimals value of 2-9 is entered, the decimal 
precision of the calculated QC result uploaded to the LIS is the specified 
number of decimals: 2, 3, 4, 5, 6, 7, 8, or 9. 

Control 
Reported 
Decimal

Numeric 
Value

Across 
Control 
(String 
Value)

Mean/SD Levy 
Jennings
(Y value)

BioRad 
Data

Sent to 
LIS

?
Result 
length of 
calc. 

Result 
length of 
calc. 

2 2 0-2
Result 
length of 
calc.
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* = varying result value of the calculation
Table 3: Decimal Places for Calculated QC result

0
Result 
length of 
calc. 

0 2 2 0 0

1
Result 
length of 
calc. 

1 2 2 1 1

2-9
Result 
length of 
calc. 

2-9 2-9 2-9 2-9 2-9

Control 
Reported 
Decimal

Numeric 
Value

Across 
Control 
(String 
Value)

Mean/SD Levy 
Jennings
(Y value)

BioRad 
Data

Sent to 
LIS
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3. Select the Advanced tab.

4.

Field Description 

Omit on LAS update Select this checkbox for external tests for which no 
results are expected. Upon receipt of an external test 
request, the ADVIA CentraLink system forwards it to 
the LAS for sorting and subsequently omits it.
If only one LAS Order Translator is specified on the 
LAS tab of the system Options window, the test request 
is omitted after it is sent to the configured LAS. 
If two LAS Order Translators are specified on the LAS 
tab of the system Options window, the test request is 
omitted after it is sent to both configured LAS. 

Default value Pertains to morphology flags. When specified, a default 
value such as “negative” is automatically assigned to 
results missing in a message from an instrument with 
“Full sample upload” set. 
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Edit Warning When specified, the edit warning is displayed whenever 
results are manually edited. 

Delta check limit The maximum number of days since the previous result 
of the same patient required delta checking. 
If a delta check limit is not specified, delta checking is 
always enabled. 

Trigger This value is supplied by service personnel. It is a 
MISPL program used for reflex testing.

On new requests This field references a MISPL function, which would 
trigger a particular event whenever a new request for 
this test is created. 

Field Description 
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5. Select the Calculation tab for additional fields. 

Field Description

Calculation A MISPL program used to calculate the result of a ratio 
test based on the results of the component tests. Your 
local technical support provider defines this program. 
The program contains a calculation formula, which you 
can view in this field. If this formula is changed, only the 
future ratio tests are affected. The test results available 
in the database stay the same.
Upon entering a change to the Calculation field, a 
message displays warning that modifying the 
calculation can affect the reporting of new and existing 
results.

Norm severity limit This normal severity limit is one of the values against 
which auto validation of calculated test results is 
determined when a method is not associated with the 
calculated test. 
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6. After entering the required test information, select OK.
The system adds the new test to the list of test definitions. 

Defining Calculations
A calculation is a string-valued MISPL program that is used to calculate the result 
of a test from the results of other tests. The formula is compiled against the 
sample class for calculations involving patient results and against the QC result 
class for calculations involving QC results. As such, the calculation includes 
reference only shared members like functions NumericValue() and StringValue(). 
If this calculation is changed, only future results are affected. 

Defining Test Groups 
The Test Group table contains records representing groups of tests. After 
creating test groups, you can assign tests to the test groups through the Test 
editor window. 
NOTE:  If referenced by tests or requests, a test group should not be deleted. 
Deleting a test group that is referenced can result in the generation of empty 
audit logs. Instead of deleting test groups that are referenced by tests or 
requests, reassign them. 

Delta norm severity 
limit

This delta normal severity limit is one of the values 
against which auto validation of calculated test results 
is determined when a method is not associated with the 
calculated test. 

QC severity limit This QC severity limit is one of the values against which 
auto validation of calculated test results is determined 
when a method is not associated with the calculated 
test. 

Instrument severity 
limit

This instrument severity limit is one of the values 
against which auto validation of calculated test results 
is determined when a method is not associated with the 
calculated test. 

Field Description
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1. At the menu bar, select Start > Configuration > Test groups.
The Test groups window displays. 

2. Select the New icon to access the Test group editor window. 
3. Enter the name of the test group. 

4. Select OK. 

Adding a Test to a Test Group 
1. At the menu bar, select Start > Configuration > Tests > By name. 

The Test browser window displays. 
2. Select the test to add to the test group.
3. Double-select the selected test. 

The Test editor window displays. 
4. In the Group field, enter the test group name. 

NOTE: You can enter a test into one test group only. 
5. Select OK. 

Editing a Test Definition
1. Select the Tests icon on the toolbar.

The Tests browser window displays.
2. Double-select the test that you want to edit. 

The Test editor window displays. 
3. After editing the appropriate fields, select OK.

Deleting a Test Definition
1. Select the Tests icon on the toolbar.

Field Description 

Name Name of the test group.
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The Tests browser window displays.
2. Select the test that you want to delete. 
3. Select Delete on the toolbar.

If the test is not in use, the test is deleted. 
NOTE: If any of the following items are associated with the test, you must 
delete these items before you have the ability to delete the test: patient 
results, QC results, norms and populations.

Setting a Test Unit
1. At the menu bar, select Configuration > Units. 

The Units browser window displays.
2. Double-select the appropriate unit.
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The Unit editor window displays. 

Field Description

Name A unique name for the unit, such as mL. This is a 
required field.

Dimension The dimension of the unit, such as Volume. Double-
select to display a list of dimensions and make a 
selection. This is a required field.
Upon entering a change to the Dimension field, a 
message displays warning that modifying units can 
affect the reporting of new results.
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Assigning a Unit to a Test
1. At the menu bar, select Start > Configuration > Tests > By name. 

The Test browser window displays. 
2. Select the appropriate test.
3. Double-select the selected test. 

The Test editor window displays. 
4. In the Patient unit field, enter the unit. 
5. Select OK. 

Coefficient If the unit being defined is the standard or default unit 
for this dimension, set the coefficient to 1.0. If this is an 
alternate unit, set the coefficient to the correct value for 
converting from the standard unit to the alternate unit. 
To convert results from the standard unit to an alternate 
unit, the ADVIA CentraLink software uses the formula:
Result (in alt. units) = Coefficient * Result (in std. units) 
+ Term. This is a required field.
Upon entering a change to the Coefficient field, a 
message displays warning that modifying units can 
affect the reporting of new results.

Term A constant value that may be required in the conversion 
from the standard unit to an alternate unit. Term = 0 for 
standard units. 
Upon entering a change to the Term field, a message 
displays warning that modifying units can affect the 
reporting of new results. 

Field Description
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Setting a Dimension for a Unit
A dimension is a measure for a unit that is used in a test.
1. At the menu bar, select Configuration > Dimensions. 

The Dimensions browser window displays.
2. Double-select the appropriate dimension.

The Dimension editor window displays. 

3. Edit the name and select OK.
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Setting Result Choices
Result choices are used for ADVIA 120/2120 morphology flags and other non-
numerical, discrete alternatives for test results. The alternatives can be coded 
numerically. The codes represent listed results, not a standard measure of any 
kind. Delta checking does not exist for this type of test.
Access the Result choice window and enter the appropriate code: 
1. At the menu bar, select Start > Configuration > Tests > By name. 

The Tests browser window displays.
2. Select the appropriate test. 
3. Right-select the selected test and select Result choices. 

The Result choices for test browser window displays.
4. Double-select the appropriate result choice. 

The Result choice editor window displays. 

5. Edit the fields of the Result Choice editor window as required. 
6. Select OK. 

The Result Choice window remains open for additional entries. Continue to 
add or edit entries as required. 
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7. Upon completion, close the open windows. 

Setting Morphology Flags
Morphology flags are non-numeric result choices typically confined to the 
alternatives: +, ++, +++, and negative. For this type of test, there is no delta 
checking. 
1. At the menu bar, select Start > Configuration > Tests. 

The Tests browser window displays.
2. Select the test that has associated morphology flags. 
3. Right-select the selected test and select Result Choices. 

The Result choices for test browser window displays.
4. Double-select the code in the browser window. 

The Result choice editor window displays. 

Field Description

Code Unique identifier for the result. 

Expansion Description of the result choice. If an expansion value is 
defined, it displays on the Review and Edit window and 
is transmitted to the LIS.

Severity Norm severity value that is assigned when this result is 
received. 
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Setting Test Norms
Test norms are ranges of normal test values or reference ranges. For a given 
test, you can assign several different norms including gender, species, and age 
of the patient. When test results are entered, each result is verified against the 
normal ranges defined for that test. 
1. At the menu bar, select Start > Configuration > Tests. 

The Tests browser window displays.
2. Select the appropriate test. 
3. Right-select the selected test and select Norms. 

The Norm for test browser window displays.
4. Double-select the appropriate norm. 
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The Norm editor window displays. 

Field Description 

Evaluation order Required when you are adding additional ranges to the 
default range. Defines the order in which ranges are 
evaluated. Ranges with higher severity levels are 
assigned a lower evaluation order so that they are 
evaluated first. After the first non-zero severity is 
identified, normal ranges are not evaluated. 

Method The norm applies only to results obtained from the 
instrument associated with the method. 

Sex Patient sex.
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Species Patient species.

Min age Minimum age of patient. 

Max age Maximum age of patient. 

Age unit Unit for patient age. 

Eligible Field for MISPL programs. 

Low limit Low limit of norm. 

High limit High limit of norm.

Severity Severity level if the test result exceeds the low or high 
limit.

Comment Text comment. When a result falls outside of range, the 
comment displays on the Review and Edit window.

Field Description 
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Setting Delta Norms 
A delta norm specifies the normal variation in results between two successive 
instances of the same test performed on different samples from the same patient.
The delta norm table stores threshold values for result changes between 
consecutive tests on the same patient using different samples.
A delta norm value can be expressed as either of the following: 
• Percentage change from the earlier result. Each result is verified against any 

delta norms that were defined for that test when a previous result is available 
for the same patient and when the time lapse between the two results does 
not exceed the delta check limit specified for the test. 

• If the Limit is absolute field is enabled, the absolute value of the difference 
between the current result value and a previous result value are evaluated. If 
the absolute difference exceeds the value specified within the Limit field, the 
Delta norm severity is applied. 

Access the Delta norms editor window: 
1. At the menu bar, select Start > Configuration > Tests. 

The Tests browser window displays.
2. Select the appropriate test. 
3. Right-select the selected test and select Delta norms. 
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The Delta norms for test browser window displays. 

4. Double-select the appropriate norm. 
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The Delta norm editor window displays.

Field Description 

Test The test for which Delta norm check is configured and 
based. 

Evaluation order Defines the order in which delta limits are evaluated. 
Limits with higher severity levels are assigned a lower 
evaluation order so that they are evaluated first. 
After the first non-zero severity is identified, normal 
ranges are not evaluated. 

Species Patient species. If specified, the delta norm applies only 
to this species. 
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NOTE:  You set the time interval for delta checking on the Tests window. For 
more information, see Configuring Test Settings‚ page 243.

Eligible Field for MISPL programs. 
If specified, the delta norm applies only if the site 
function evaluates as true. 
Your local technical support provider can configure a 
GetPreviousLocalResult(0) MISPL that is triggered 
through the Eligible field of the Delta Norm. For a given 
patient, this MISPL extends the ability to retrieve the 
most current previous result for the same test on a 
different sample.

Limit is absolute This checkbox determines whether the value in the 
Limit field is an absolute value, which is expressed in 
the associated test unit. 
If the Limit is absolute checkbox is not selected, the 
value in the Limit field is a relative value, which is 
expressed as a percentage. 

Limit Depending on whether the Limit is absolute checkbox is 
enabled, the Limit value is the absolute or relative result 
value shift since the previous result. 
When the Limit value is exceeded, a severity value is 
assigned to the requests delta norm Severity field and a 
comment value is assigned to the delta norm Comment 
field. 

Severity Severity level value is applied when the result value 
shift because the previous result exceeds the Limit 
value set in the Limit field. 

Comment Text comment. When a result falls outside of range, the 
comment displays on the Review and Edit window. 

Field Description 
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Defining Test Aspects
You can define multiple result aspects or characteristics for a result from the 
ADVIA Centaur® system. 
The Patient result selector configured on the Basic tab of the Method is the 
instrument result aspect that displays on the Review and Edit window. The 
Control result selector configured on the Basic tab of the Method is the 
instrument result aspect that displays on the QC Results window. 
Although only one aspect displays on the Review and Edit window and on the QC 
Results window, the ADVIA CentraLink system transmits all defined aspects to 
the LIS.
1. Select the Instruments icon.

The Instruments browser window displays. 
2. Select the appropriate instrument. 
3. Right-select the selected instrument and select Aspects.
4. Select New on the toolbar to add a new Aspect.
For more information on supported result aspects, see Result Detail tab‚ 
page 165.

Creating Panels for Requestables 
In the order entry process, individual tests and groups of tests, called panels, are 
selected for each patient sample from the list of requests on the Requestables 
browser. Simple requestables are mapped to individual tests. Panel requestables 
containing other requestables of any type are mapped to panel members. 
If required, the original test request can be omitted through MISPL. Once the 
original test request is omitted, it must be reordered from the LIS if a rerun is 
required.
You can create panels from existing test and panel definitions. 
Access the Requestables window:
1. At the menu bar, select Start > Configuration > Requestables.

The Requestable browser window displays. 
2. Double-select the appropriate requestable. 
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The Requestables editor window displays. 

Create a new panel from the Requestable browser window: 
1. Select the New icon. 

The Requestable editor window displays. 
2. Enter the Name for the new panel.
3. Select Explicit. 
4. Select Panel from the Type of Requestables field. 

Field Description

Name Unique identifier of the requestable. 

Explicit When selected, the requestable is visible in the list of 
requestables on the Order Entry window and can be 
manually requested. Simple requestables, which are 
not explicit, can still be requested as part of a panel 
requestable. 

Type of Requestable Valid values include the following: Simple and Panel. 

Test Reference to the test which can be requested through 
this requestable. 
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The Description field displays in place of the Test field. 
5. Type a description of the panel, and select OK. 

The new name is added to the list of requests. 
6. In the Requestables browser, select the new panel name. 
7. Right-select the selected panel and select As panel requestable > 

Members. 
The Panel members browser window displays. 

8. Select the New icon on the toolbar. 
The Panel member editor window displays.

9. Double-select the Requestable field on the Panel member editor window. 
A new Requestables browser window displays. 

10. Highlight the test or panel that you want to include in the new panel and select 
OK. 
The newly opened Requestables browser window closes. The selected name 
displays on the Panel member editor window. 

11. To add the name to the Panel members browser, select OK. 
12. Repeat steps 9 - 11 until all panel members are selected. 

Deleting a Panel
1. At the menu bar, select Start > Configuration > Requestables.

The Requestable browser window displays. 
2. Select the panel to delete. 
3. Right-select the selected panel and select As panel requestable > 

Members. 
The Panel members browser window displays.

4. Select the test or panel to delete and select Delete. 
5. Select Yes to delete the panel member. 
6. Select Close on the Panel members browser to return to the Requestables 

browser window. 
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Adding Tests to Requestables
1. At the menu bar, select Start > Configuration > Requestables.

The Requestable browser window displays.
2. Select the New icon on the toolbar. 

The Requestable editor window displays.
3. Type the name for the new test panel.
4. Select Explicit.
5. Select Simple. 
6. Double-select the Test field. 

The Tests browser displays. 
7. Select the test to add to the list of requests. 
8. Select OK to add the name on the Requestable editor window. 
9. Select OK on the Requestable editor window to add the test to the list in the 

Requestables browser window. 
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Defining Instruments
The Instruments editor window defines the instruments connected to the 
ADVIA CentraLink system. 
1. At the menu bar, select Start > Configuration > Instruments. 

You can also select the Instruments icon on the toolbar. The Instruments 
browser window displays.

2. At the editing toolbar, select the New icon. 
The Basic tab of the Instrument editor window displays.

Field Description 

Name The unique identifier of the instrument.
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Type Specifies the type of instrument: 
• Normal - A traditional instrument. Certain normal 

instruments, IMMULITE 2000 and 2500 and 
ADVIA Chemistry 1800 can be connected to a 
concentrator. 
NOTE: Support for ADVIA Centaur XP connectivity 
to a concentrator is currently in development.
Each of the following instrument parameters must 
be defined for a normal instrument: flags, methods, 
aspects, OnEndResultMessage, full sample upload, 
batch size, barcode Translation. 
Normal instruments that are eligible for connection 
to a concentrator can only be a member of one 
concentrator. 

• Concentrator - An instrument of type concentrator is 
a system that facilitates instrument connections. 
When a concentrator configuration is defined, 
normal instruments must be defined to the 
concentrator. Test requests are scheduled against 
the concentrator. The ADVIA CentraLink software 
does not know which of the normal instruments 
connected to the concentrator will receive and 
execute test requests. 
Unless the Auto target feature, which references 
the AutoTarget Seq No value from the Methods of 
normal instruments, is enabled, the concentrator 
targets the normal instrument that will receive the 
workorder.
One concentrator instrument can have two normal 
instrument connections. 
A concentrator cannot be a member of another 
concentrator.
Refer to Understanding Instrument Types‚ 
page 286. 

Field Description 
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Parent Instrument Only instruments of type Normal can be associated to a 
Parent Instrument. A Parent Instrument must always 
refer to an instrument of type Concentrator. 
NOTE: If you specify a parent instrument value, you 
cannot specify a translator value. This safeguard is 
employed to ensure that communication for instruments 
defined to a concentrator is managed by the translator 
of the concentrator. 

Group Reference to the containing instrument group. 
NOTE: All instrument records, that is, those of type 
Normal and of type Concentrator, can refer to an 
instrument group. No restriction is imposed on an 
instrument’s reference to an instrument group. 
In a concentrator configuration the following applies: 
• For test requests that are scheduled against the 

concentrator, the instrument group references the 
instrument group of the concentrator. 

• For test requests that contain a result from the 
concentrator, the instrument group references the 
normal instrument that generated the result. 

Translator References the translator record, which defines 
communication with the instrument.
NOTE: If you specify a translator value, you cannot 
specify a parent instrument value. This safeguard is 
employed to ensure that communication for instruments 
defined to a concentrator is managed by the translator 
of the concentrator. 

Coding system References the coding system record, which defines 
the mapping of tests and other codes between the 
ADVIA CentraLink system and the instrument. 
Refer to Setting Up Coding Systems‚ page 320.

Field Description 
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Default sample type When the sample record in the ADVIA CentraLink 
system does not reference a sample type, this default 
value specifies the sample type that should be 
associated with the sample in the workorder message 
to the instrument. Required only for instruments that 
must have some sample type in their workorder 
message.

Default container type When the sample record in the ADVIA CentraLink 
system does not reference a container type, this default 
value specifies the container type that should be 
associated with the sample in the workorder message 
to the instrument. Required only for instruments that 
must have some container type in their workorder 
message.

Enable rescheduling If selected, an instrument can rerun a test request when 
the test request is scheduled to another instrument. 
If not selected, an instrument cannot rerun a test 
request when the test request is scheduled to another 
instrument.

Moving average batch 
size 

Determines how many patient results are used to 
compute a new moving average. 
If the value 10, for example, is entered to the Moving 
average batch size field, 10 patient results for the 
method generate a QC result. 

Field Description 
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3. Select the Advanced tab.
The Advanced tab of the Instrument window displays. 

Field Description

Barcode translation References a string-valued, instrument-based MISPL 
function. The MISPL function is to determine whether 
an incoming barcode identifies a patient sample, a 
control sample, or a sample with an unreadable 
barcode and to translate the incoming barcode into 
either a sample barcode or a QC lot code that matches 
a database record.
Upon entering a change to the Barcode translation 
field, a message displays warning that modifying the 
Barcode translation can affect sample identification.
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Download by Worklist Activates the workorder download by worklist feature 
for this instrument. 
In response to an ALL query from the instrument 
translator, the ADVIA CentraLink software returns the 
contents of the first worklist available for download to 
the instrument as opposed to returning all eligible 
samples. 
NOTE: To resend a workorder request to an instrument, 
you must first unschedule the request and then resend 
the unscheduled request to the instrument. 

On ALL Query Match 
Target

In response to an ALL query without sample 
identification from the instrument translator, the 
ADVIA CentraLink software returns requests targeted 
to the instrument associated with the translator that 
generated the query. 

On ALL Query Max 
Samples

In response to an ALL query without sample 
identification from the instrument translator, the 
ADVIA CentraLink software returns no more than the 
maximum number of samples defined in this field. 
When targeting is disabled and multiple, equivalent 
instruments of the same type exist, this value-enables 
the distribution of requests among same type 
instruments. 
If the ? symbol populates the field, all available 
requests are downloaded in response to a query from 
an instrument translator. 

Max previous results If selected and if the instrument is capable of 
performing delta checking, the maximum number of 
previous results for the same patient for the same test 
can be sent to the instrument with the workorder. 

Field Description
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Understanding Instrument Types 
Two instrument types exist: Normal and Concentrator. 
An instrument of type Normal is a traditional instrument to which workorders are 
downloaded and from which results are uploaded. All instrument parameters, for 
example, flags, methods, aspects, OnEndResultMessage, full sample upload, 
batch size, barcode Translation, must be defined on a normal instrument. The 
following normal instruments can be connected to a concentrator: IMMULITE 
2000 and 2500 and ADVIA Chemistry 1800. 
NOTE:  Support for ADVIA Centaur XP connectivity to a concentrator is currently 
in development. 
An instrument of type concentrator is a system that facilitates instrument 
connections. When a concentrator configuration is defined, normal instruments 
must be defined to the concentrator. You cannot delete a concentrator record 
while a normal instrument is defined to the concentrator. Flags are not supported 
on the concentrator instrument type. 

Instrument Connections to the ADVIA CentraLink System
Only normal instruments contribute to the total number of connected instruments 
on the ADVIA CentraLink system. Concentrator instruments do not contribute to 
the total number of connected instruments. The translator that the normal 

Full sample upload If selected, a patient result upload is considered final; 
that is, no additional results for the sample are 
expected from the instrument. If some results are 
missing upon result upload, their default values as 
defined in the test record are automatically assigned. 

NOTE:  Full sample upload does not apply to QC 
results. 

On end result 
message

Reference to a MISPL function, which is executed 
when a complete result message is received from the 
instrument. 

Field Description
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instrument communicates with is the normal instrument’s connection to the 
ADVIA CentraLink system. 
At the Instrument window, you would define a normal instrument connected to a 
concentrator as having a parent instrument. This parent instrument value 
identifies the concentrator to which the normal instrument is connected. As a 
parent instrument is defined to this normal instrument, a translator cannot be 
defined. This ensures that when a normal instrument is connected to a 
concentrator, all communication is managed by the translator of the concentrator. 
At the Instrument window, you would define a concentrator instrument as having 
a Translator. This concentrator translator serves as the translator for the normal 
instrument, which references the translator indirectly through its specified parent 
instrument field value. In this scenario, the translator of the concentrator defines 
the normal instrument’s connection to the ADVIA CentraLink system. 
At the Instrument window, a normal instrument that is not connected to a 
concentrator is defined as having a Translator. In this scenario, this normal 
instrument translator defines the normal instrument’s connection to the 
ADVIA CentraLink system. 

Workorder Processing with a Concentrator Configuration
During workorder download, test requests are scheduled to the concentrator, 
which targets the connected normal instrument for processing. 
NOTE: Unless the Auto target feature is enabled, the concentrator targets the 
normal instrument that will receive the workorder.
The test request is processed on the normal instrument, which generates the 
result. The generated result record contains the result value as well as a 
reference back to the normal instrument identifier. In order for the generated 
result record values to be saved as a result to the concentrator, to which the 
request is scheduled, the normal instrument must be defined to the concentrator. 
Without a valid normal instrument identifier to which the result values are 
mapped, the concentrator cannot use the valid result and stores the result value 
as “X_NORESULT.” 

Concentrator Overriding Values
The following instrument fields of the concentrator instrument override the setting 
in the corresponding fields of the underlying normal instruments.
• Maximum previous results 
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• Coding system 
• Default sample type 

NOTE: When a sample type is not defined for the sample in the 
ADVIA CentraLink software, the sample type of the concentrator is 
downloaded to the normal instrument in the Workorder message.

• Default container
• Enable rescheduling parameter 

NOTE: When replying to a Query message, the Enable rescheduling 
parameter of the concentrator is used because tests are scheduled against 
the concentrator. The ADVIA CentraLink software cannot determine 
beforehand which of the normal instruments connected to the concentrator 
will receive and execute a test request.

• Download by worklist
• On All query match target
• On All query max samples 

How Queries from the Concentrator are Processed

Specific Query 
When the ADVIA CentraLink software receives a specific query from the 
concentrator, the ADVIA CentraLink software downloads a workorder for the 
sample attaching all methods whose associated tests can be done by either one 
or both of the normal instruments defined to the concentrator. The 
ADVIA CentraLink software does not determine which of the normal instruments 
connected to the concentrator will receive and execute test requests. Except 
when the Auto target feature is enabled, the concentrator is responsible for 
targeting the normal instrument that will receive the workorder. 
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All Query
When the ADVIA CentraLink software receives an ALL query from the 
concentrator, the following occurs depending on whether instrument download by 
worklist is enabled: 

Test requests are scheduled to the concentrator, which targets the connected 
normal instruments for processing.

Test Selection Update 
The ADVIA CentraLink software can be configured to automatically download 
updates to requests for a sample that have already been queried for and 
downloaded to the concentrator. 
When the ADVIA CentraLink software receives a test selection update from the 
concentrator, it only downloads the add-on, reflex and rerun tests of samples 
already transmitted to the concentrator at some time in the past. 
Updated workorder information for a given sample that has not been downloaded 
to the concentrator previously, is not downloaded to the concentrator in response 
to a Test Selection Update. The ADVIA CentraLink software determines whether 

If the instrument 
download by 
worklist...

Then...

is enabled all worklists of the normal instruments connected to the 
concentrator are transmitted in the workorder to the 
concentrator. The workorder contains all corresponding 
sample information in the worklists of the normal 
instruments and requests that match the target of the 
normal instrument. If a worklist for the concentrator is 
available, that worklist is also transmitted to the 
concentrator. 

is not enabled the concentrator parameters specified at the Instrument 
window in the On ALL Query Match Target and On ALL 
Query Max Samples fields are taken into account and 
the appropriate workorders are downloaded to the 
concentrator. 
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workorder information for a given sample was sent to the concentrator previously 
by checking the Sample log table for applicable concentrator instrument records. 

How results from the Concentrator are Interpreted and Displayed

Patient Results
At the Review and Edit window, patient results received from the concentrator are 
associated with the normal instrument from which they were generated, not the 
concentrator. These patient results display with the normal instrument. The flags 
attached to the patient results refer to the flags of the normal instrument. Auto 
validation rules applied to the patient results correspond to those defined on the 
Method records of the normal instrument. 

Moving averages
Moving averages refer to the normal instrument. To enable moving averages, 
select the Check moving average checkbox on the method of the normal 
instrument.

Full Sample Upload
Full sample upload refers to the normal instrument. To enable full sample upload, 
select the Full sample upload checkbox on the Advanced tab of the Instrument 
window of the normal instrument. When the concentrator receives results from a 
normal instrument supporting full sample upload, all test requests scheduled to 
the concentrator that can be performed by the normal instrument are assigned 
the default value specified on the corresponding tests.

QC Results
At the QC Results (Across controls view) window, QC results received from the 
concentrator are associated with the normal instrument from which they were 
generated, not the concentrator. These QC results display with the normal 
instrument. The QC flags attached to the QC results refer to the flags of the 
normal instrument. QC severities raised for these results correspond to those 
defined on the Method records of the normal instrument. 

Normal Instrument Identifier Upload to the LIS
The normal instrument identifier, (Request.Instrument), is transmitted to the LIS 
when this upload behavior is supported by the LIS translator. 
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Instrument Logs
The Instrument Log window stores event information on activities performed on 
an instrument. The types of activities include the following: logging, maintenance, 
calibration, and reagent change. 
For those events associated with an instrument and a method and for which a 
QC population exists, you can associate this instrument log event with a dotted 
vertical line that displays on the Levey-Jennings graph. 

Access the Instrument Log editor window: 
1. At the Instrument window, right-select and select Related > Instrument logs. 
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NOTE: You can also access this window through the Method window. 
The Instrument logs browser window displays. 

2. At the Instrument logs browser window, select the New icon or press Insert. 
The Instrument logs editor window displays. 

Field Description

Instrument Instrument to which the log applies. 
When the Instrument log browser is accessed through 
the Method window, this field is automatically populated 
with the instrument value on the Method window.

Method Reference to a specific method. 
When the Instrument log browser is accessed through 
the Method window, this field is automatically populated 
with the test value on the Method window. 
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Instrument Setup Targeting
The Setup targeting option enables targeting for all associated methods at once. 
Access the Setup targeting window: 
1. At the menu bar, select Start > Configuration > Instruments. 

The Instrument browser window displays. 

Event time The time in which the activity that was performed on the 
instrument took place 

Event type The type of activity performed on the instrument: 
• Log 
• Maintenance
• Calibration
• Reagent change

Show on qcgraph If selected, a dotted vertical line that corresponds to the 
event is plotted and displays on the Levey-Jennings 
graph when the event is associated with an instrument 
and a method and for which a QC population exists. 

Code Code representing the event that displays on the 
Levey-Jennings graph. 
NOTE: To prevent legibility issues, limit the amount of 
text for display on the Levey-Jennings graph.

Description Free text description of the event.

Comment Free text comment. 

Field Description
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2. Right-select the appropriate instrument and select Setup targeting. 

Instrument Retarget Function
When an instrument is taken offline, you have the option of deleting the worklists 
that are in Ready status for this offline instrument. The process of deleting the 
status Ready worklists for the offline instruments allows for worklists that are not 
yet scheduled and targeted to this instrument to be targeted to another 
instrument and prevents additional targeting to this offline instrument. 
When the instrument is brought online, worklists are retargeted to this instrument 
using the Setup targeting function. 
Access the Retarget window: 
1. At the menu bar, select Start > Configuration > Instruments. 

The Instrument browser window displays. 

Field Description

Enable Determines whether requests for the instrument's tests 
can be targeted to the instrument. 

Seq no Determines the order, among all eligible instruments, in 
which the current instrument is considered as target for 
a matching request. 
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2. Right-select the appropriate instrument and select Retarget. 

Configuring Moving Average Batch Size for an Instrument
1. From the instrument editor window, enter the Moving average batch size. 

The Moving average batch size must be entered for each sample in every 
moving average data point.

2. Select OK. 

Enabling Moving Average for a Method
1. At the menu bar, select Start > Configuration > Instruments. 

The Instruments browser window displays. 
2. Select the appropriate instrument. 
3. Right-select the selected instrument and select Related > Tests.
4. Double-select on the appropriate method. 

The Method editor window displays. 
5. Select Check Moving Average. 
6. Select OK.

Setting up QC Populations for Moving Average Data
1. At the menu bar, select Start > Routine > Quality Control > QC 

populations.

Field Description

Delete ready worklists If selected, all Ready status worklists targeted to the 
instrument are deleted. 



 

296 ADVIA CentraLink Operator’s Guide

The QC population query window displays.
2. Select OK.

The QC Populations browser displays. 
3. Select New on the editing toolbar.

The QC Population editor window displays. 
4. Enter the Method test. 
5. Select Moving average. 

By selecting Moving average, you are specifying that this is a patient-based 
population. The selected moving average checkbox specifies that a species, 
not a QC Lot, is grouped with the test and instrument within the QC 
population. 

6. Enter the remaining data and select OK. 
See QC Populations‚ page 177 for details on defining QC populations. 

Automatically Creating QC Populations for Moving Average Data 
If you did not create QC Populations for the moving average data, the 
populations are automatically created when patient results are received from the 
instruments. Once these populations exist, however, you must define the 
Reference value and Reference deviation in order for Westgard checks to apply.  
NOTE:  Westgard rules are applied using the Reference value and Reference 
deviation rather than the Target value and Target deviation.
To initially set the Target value and Target deviation as the Reference value and 
Reference deviation:
1. At the QC Population browser window, select the population for which you 

want to define the Reference value and Reference deviation.
2. Right-select the selected population and select Set Target.

The Set Target window displays.
3. Enter the Target value and Target deviation. 
4. Select Set as reference.
5. Select OK.
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The Target value and Target deviation is also set in the Reference value and 
Reference deviation fields.

Once statistics are available, change the Reference value and Reference 
deviation to Statistics as follows:
1. Select the population for which you want to change the Reference value and 

Reference deviation.
2. Right-select the selected population and select Set Reference.

The Set Reference window displays.
3. Select Target, Current Statistics, or Cumulative Statistics. 
4. Select OK. 
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Creating or Modifying Instrument Groups
You can create groups of instruments. An instrument can belong to one 
instrument group only. You can add instruments to a group through the 
Instruments editor window. 
References to the containing instrument group are automatically created 
whenever new requests or QC results are created, which improves query 
performance. When an instrument changes groups, however, requests and QC 
results are not synchronized. 
NOTE:  When instrument groups are created, patient results received prior to 
instrument group creation are not returned in queries for the specified group. 
NOTE:  If referenced by requests, QC results, or other instrument groups, an 
instrument group should not be deleted. Deleting an instrument group that is 
referenced can result in the generation of empty audit logs. Instead of deleting 
instrument groups that are referenced by requests, QC results, or other 
instrument groups, reassign them. 
Access the Instruments Groups editor window and enter or modify an instrument 
group: 
1. At the menu bar, select Start > Configuration > Instrument groups.

The Instrument groups browser window displays. 
2. To create a new instrument group, select the New icon or press Insert.
3. To access an existing instrument group, double-select the appropriate 

instrument group. 
The Instrument Group editor window displays. 

4. Enter or modify the Name and Description of the instrument group. 
5. Select OK.
Assign an instrument to an instrument group: 
1. At the menu bar, select Start > Configuration > Instruments. 

The Instruments browser window displays.
2. At the Instruments browser window or the Instrument editor window, right-

select the instrument and then select Set Group.
The Set Group editor window displays.
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3. To display all available Instrument groups, double-select the Group field. 
4. Double-select the desired Instrument group.
5. On the Set group window, select OK. 

NOTE: Using the right-select Set group function at the Instruments browser, 
you can assign multiple instruments to a group at the same time.
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Configuring Instrument Tests (Methods) and Flags
Setting Instrument Flags
You define Instrument flags for every new instrument configured in the 
ADVIA CentraLink system. The ADVIA CentraLink system only receives flags 
that are already defined. Instrument flags that are not configured in the 
ADVIA CentraLink system are ignored. 
NOTE: QC results received with undefined instrument flags are automatically 
omitted from the ADVIA CentraLink software. 
An instrument flag has a code, explanatory text (expansion), and two severity 
flags. You can define the severity that is assigned when an instrument flag is 
associated with a QC result, and you can define the severity that is assigned 
when an instrument flag is associated with a patient result. Defining these flags 
independently allows for more precise instrument severity determinations 
between QC result and patient results respectively.
To see the flags on the Review and Edit window, you must define the instrument 
flags.
Access the Instruments window: 
1. At the menu bar, select Start > Configuration > Instruments. 

The Instruments browser window displays.
2. Select the instrument for which you are defining flags. 
3. Right-select the selected instrument and select Related > Flags. 

The Flags defined on instrument browser window displays.
4. Double-select the appropriate flag. 



301

The Instrument flag editor window displays. 

Field Description

Instrument This field is automatically filled with the name of the 
instrument you are modifying.

Code Unique identification for the flag. This code must match 
the code used by the instrument.

Expansion Determines the flag description on the Review and Edit 
window and on reports. 

Patient severity The overriding patient severity flag value applicable to 
patient results, which automatically sets the Instrument 
value on the Severity tab of the Request window to the 
highest severity. 
NOTE:  If the patient severity flag value is greater than 
the instrument severity value on the Severity tab of the 
Request window, then this patient severity flag value 
overwrites the instrument severity value on the Request 
window. 
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Setting Instrument Tests (Methods)
You must define all the tests performed on an instrument in a Tests on instrument 
list. The tests on this list are instrument-specific, and the test definitions do not 
automatically apply to another instrument. 
The Method window enables you to configure a test on an instrument and to 
specify a different result selector for patient results and control results.
NOTE:  Your administrator or local technical service provider must ensure that 
the test list for an instrument is accurate. It is possible to add a new instrument to 
the instrument list by copying settings from an existing instrument using the Deep 
Copy function.
1. At the menu bar, select Start > Configuration > Instruments. 

The Instruments browser window displays.
2. Select the instrument for which you are defining a method. 

Control severity The overriding QC severity flag value applicable to 
control samples, which automatically sets the 
Instrument severity field value of the QC results window 
to the highest severity. 
If this control severity flag value is greater than the 
Instrument severity field value of the QC results 
window, then this control severity flag value overwrites 
the Instrument severity field value of the QC results 
window. 

NOTE:  If the instrument severity flag is not relevant to 
QC results, set the Control severity at the Instrument 
Flag window to 0. If the instrument severity flag is 
relevant to QC results, set the Control severity at the 
Instrument Flag window to equal the highest value of 
the Westgard rules applicable to that method. 
If an unknown flag is received, the field value is set to 
-5. 

Field Description
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3. Right-select the selected instrument and select Related > Tests. 
The Tests on instrument browser window displays. 

4. Double-select the appropriate test. 
The Method editor window displays. 
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The top portion of the Method window includes the following fields: 

Basic Tab
The Basic tab fields include the following:

Field Description

Test Reference to the test that can be performed on the 
instrument.

NOTE: If the test is a calculated test, the 
ADVIA CentraLink software does not download orders 
or accept results from the instrument. 

Instrument This field is automatically filled with the name of the 
instrument.

Field Description

Patient result selector This selector is a reference to one of the instrument’s 
aspects. The Patient result selector determines the 
aspect that represents the actual result value for patient 
results. 
This aspect displays on the Review and Edit window. 
The ADVIA Centaur system is an example of a system 
that makes use of this field value. 
Commonly used aspects are DOSE (concentration) 
and INTR (interpretation). For information on defining a 
result selector see Defining Test Aspects‚ page 276. 
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Control result selector This selector is a reference to one of the instrument’s 
aspects. The Control result selector determines the 
aspect that represents the actual result value for QC 
results. 
This aspect displays at the QC Results window.
The ADVIA Centaur system is an example of a system 
that makes use of this field value. 
Commonly used aspects are DOSE (concentration) 
and INTR (interpretation). For information on defining a 
result selector see Defining Test Aspects‚ page 276. 

Unit Double-select the field to open the Units for dimension 
browser. Double-select the unit you want to enter in the 
editor. Edit this field only if the unit of the method differs 
from the default unit in the test table. The units must be 
of the same dimension for proper conversion to take 
place.
Upon entering a change to the Unit field, a warning 
message displays. The message prompts that you 
should only modify the Unit on the method if it is 
necessary to convert the result uploaded from the 
instrument to match the units reported in the 
ADVIA CentraLink software. Modifying the Unit on the 
method can affect the reporting of new results. 

Field Description
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Low detection limit Linearity Range: If results fall outside the delimited 
range, they are converted to the detection limit, 
preceded by a <, and displays on the Review & Edit 
window. The value displayed on the Review & Edit 
window is the value uploaded to the LIS.
Upon entering a change to the Low detection limit field, 
a warning message displays. The message prompts 
that modifying the Low detection limit will change new 
results from the instrument that are less than the Low 
detection limit to the Low Limit value, preceded by the 
“<” symbol. 

High detection limit Linearity Range: If results fall outside the delimited 
range, they are converted to the detection limit, 
preceded by a >, and displays on the Review & Edit 
window. The value displayed on the Review & Edit 
window is the value uploaded to the LIS. 
Upon entering a change to the High detection limit field, 
a warning message displays. The message prompts 
that modifying the High detection limit will change new 
results from the instrument that are greater than the 
High detection limit to the High Limit value, preceded by 
the “>” symbol.

Enable targeting Select this checkbox if requests for the method's test 
are targeted to the method's instrument. 

Field Description
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Auto target seq no This field is enabled when the Auto target requests 
checkbox of the More tab of the system Options 
window is selected. 
If the auto targeting feature is activated, the value in 
this field determines the instrument that can satisfy the 
request. 
Among the instruments capable of satisfying the 
request, the one with the lowest value is selected as 
target. 
NOTE: For instruments of type concentrator, the 
concentrator typically targets the normal instrument that 
will receive the workorder. When the Auto target feature 
is activated and the ADVIA CentraLink software 
receives an ALL query from the concentrator, however, 
test requests are transmitted to the concentrator and 
these requests are targeted to the normal instrument 
specified within this Auto target seq no field. 

Enable workorders Select this checkbox if workorders for this test are sent 
to the instrument. 
If the test is never ordered individually, but only as part 
of a panel, leave the checkbox unselected. In the LAS 
environment, this checkbox is unselected if the test is 
disabled on the LineMaster.

Download dilution Select this checkbox if the instrument method can 
accept a dilution coefficient.

Check moving average Select this checkbox if the moving average is 
calculated for this test. 

Field Description
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Counter key label Specify the key to be used for counting test results in 
the Diff Pad. Do not edit the field for tests that do not 
use the Diff Pad. Ensure that the ? symbol displays in 
the field.
Upon entering a change to the Counter key label field, a 
message displays warning that modifying the Counter 
key label can affect the manual entry of results using 
the Diffpad. 

Reagent information Upon receipt of a global reagent information message 
from an instrument, the reagent information is stored in 
this field. 
If result-specific reagent information does not exist for 
the result associated with this method, global reagent 
information is also saved to the Reagent information 
field of the Request or QC request window for the 
result. 
NOTE: Reagent information received at the result level 
has priority over global reagent information stored at 
the Method. 

Field Description
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Autovalidation Tab
The Autovalidation tab includes the following fields: 
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Field Description

QC severity This field is automatically filled with the highest QC 
severity of the method since the last QC reset and can 
be one of the following: Westgard QC severity, 
instrument flag control severity, QC type error severity, 
QC severity on invalid reference. 
See Resetting the QC Severity from the QC Results 
(Across Controls View) Window‚ page 205. 

QC severity on type 
error 

The value assigned to the QC severity when a control 
result is received that cannot be converted to the test's 
control data type. 
This integer value defaults to 5. 
Refer to Type Error QC Result‚ page 194. 

QC severity on invalid 
reference

QC severity on invalid reference is the value assigned 
to the QC severity when a control result is received with 
a comparator that prevents it from being 
unambiguously positioned with respect to the 
population reference value. 
For example: 
Control result value <10 
Population reference value 5
This integer value defaults to 5. 
Refer to Invalid Reference QC Result‚ page 195. 

Allow on type error Allow on type error determines whether automatic 
validation proceeds when a patient result is received 
that cannot be converted to the test's patient data type.
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Configuring Autovalidation for a Method
When results are received from an instrument for a request and the request’s 
Norm, Delta norm, QC, and Instrument severities are all below the respective 
Norm severity limit, Delta norm severity limit, QC severity limit, and Instrument 

Allow on invalid range Allow on invalid range determines whether automatic 
validation proceeds when a patient result is received 
with a comparator that prevents it from being 
unambiguously positioned with respect to the 
applicable normal ranges. 
For example: 
Patient result value <10 
Range values 5 to 6 
WARNING: Do not enable Allow on invalid range. 
If your normal ranges are properly configured or if you 
do not have norms defined, you will not receive invalid 
reference patient results and there is no reason to 
enable this setting.

Severity limits If requests in Review status receive a result through 
this method and the request's Norm, Delta norm, QC 
and Instrument severities are all below the respective 
Norm severity limit, Delta norm severity limit, QC 
severity limit and Instrument severity limit, then it is 
automatically validated. If any of the limits are left 
unspecified, no auto-validation occurs. 
The following severity limits are used in the auto 
validation of methods: 
• Norm severity limit 
• Delta norm severity limit 
• QC severity limit 
• Instrument severity limit 

Field Description
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severity limit of the method, the result is automatically validated. If any of the 
limits are left unspecified, no auto validation occurs. 

Westgard Tab
By default, Westgard checks are enabled. You have the option, however, of 
disabling individual Westgard checks. 
When any of the fields of the Westgard tab is set to 0, the individual Westgard 
check is disabled. To the right of a disabled Westgard field, the label “(disabled)” 
displays. When a Westgard check is disabled, no Westgard comment is added to 
the QC result and no Failed Westgard comment is uploaded to the LIS. 
The Westgard tab includes the following fields: 
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Field Description

1-2s, 1-3s, 10-x, 2-2s, 
4-1s and R-4s

Severity assigned to the method QC severity if a QC 
result obtained through this instrument channel fails the 
respective Westgard check and if the current QC 
severity of the method is lower.
When any of these fields is set to 0, the individual 
Westgard check is disabled. To the right of a disabled 
Westgard field, the label “(disabled)” displays.

Apply Westgard 
checks

Determines whether the method is subject to Westgard 
checking on numerical tests.
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Setting Autovalidation for a Single Instrument
1. At the menu bar, select Start > Configuration > Instruments. 

The Instruments browser window displays.
2. Select the instrument for which you are setting limits. 
3. Right-select the selected instrument and select Related > Tests.

The Tests on instrument browser window displays. 
4. Double-select the appropriate test. 

The Method editor window displays. 

Include comparator 
QC results

Determines whether comparator QC results contribute 
to Westgard checks. 
• When the checkbox is selected, the comparator QC 

results contribute to Westgard checks. 
• Default - When the checkbox is not selected, the 

comparator QC results do not contribute to 
Westgard checks. The type error severity is raised 
for the Method, which prevents autovalidation of all 
patient results for the specified method. This QC 
result is not taking into account for Westgard 
checks of subsequent QC results. 

When a comparator QC result does not contribute to 
Westgard checks, a comment displays in the Comment 
field of the QC Result (Across controls view) window. 
This additional comment is added to existing 
comments. The comment is not uploaded to the LIS 
and is not listed on reports. Refer to the description for 
the Comment field in the Statistics Area‚ page 202. 
To enable this feature for all methods of an instrument 
or test, refer to Configuring Westgard Rules for an 
Instrument‚ page 316 or Configuring Westgard Rules 
for a Test‚ page 317. 
By default, the checkbox is not selected. 

Field Description
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5. To view the currently defined autovalidation limits, select the Autovalidation 
tab.

6. Right-select on the method window and select Setup autovalidation.
The Setup autovalidation window displays.
NOTE: The Setup autovalidation window is used to define the autovalidation 
limits. The Setup autovalidation window should not be used to view the 
autovalidation limits that were defined for the method because the Setup 
autovalidation window always displays each of the autovalidation limit fields 
set by default to a question mark. To view the autovalidation limits defined for 
a method, always view the values displayed at the Autovalidation tab of the 
Method window. If you select OK at the Setup autovalidation window and the 
autovalidation limit fields are set to the default question mark, the 
autovalidation limit fields are changed to a question mark. If it is not your 
intent to define the autovalidation limits, select Cancel at the Setup 
autovalidation window. 

7. Enter the new severity level for each limit. 
8. At the Setup autovalidation window, select OK. 
9. At the Method editor window, select OK. 

Configuring Westgard Rules
The ADVIA CentraLink system comes preconfigured with standard Westgard 
checks to apply to QC results. The default QC severity level for each Westgard 
check is 1. A setting of 0 disables the specific check. 
To the right of a disabled Westgard field, the label “(disabled)” displays. When a 
Westgard check is disabled, no Westgard comment is added to the QC result and 
no Failed Westgard comment is uploaded to the LIS. 



 

316 ADVIA CentraLink Operator’s Guide

Configuring Westgard Rules for an Instrument
You can simultaneously setup Westgard checking for all methods of an 
instrument through the Setup Westgard window. 
Customize the QC severity level for all Westgard checks performed on all results 
from a single instrument: 
1. At the menu bar, select Start > Configuration > Instruments.

The Instruments browser window displays.
2. Select the instrument for which you are setting limits. 
3. Right-select the selected instrument and select Related > Tests.

The Tests on instrument browser window displays.
4. Double-select the appropriate test.

The Method editor window displays.
5. Select the Westgard tab.
6. Enter the new severity level for each Westgard check. 

When any of the fields of the Setup Westgard window is set to 0, the 
individual Westgard check is disabled. To the right of a disabled Westgard 
field, the label “(disabled)” displays. When a Westgard check is disabled, no 
Westgard comment is added to the QC result and no Failed Westgard 
comment is uploaded to the LIS.

7. Select Apply westgard checks.
If this check box is not selected, the Westgard rules are not applied to the 
method.
If you select Include comparator QC results, comparator QC results 
contribute to Westgard checks for all methods of a test. When a comparator 
QC result does not contribute to Westgard checks, a comment displays in the 
Comment field of the QC Result (Across controls view) window. Refer to the 
description of the Comment field in the Statistics Area‚ page 202.

8. Select OK.
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Configuring Westgard Rules for a Test
You can simultaneously setup Westgard checking for all methods of a test 
through the Setup Westgard window. 
Configure the system to use other severity values for the Westgard checks 
performed on a specific test regardless of the instrument on which it was 
performed by completing the following steps: 
1. At the menu bar, select Start > Configuration > Tests.

The Tests browser window displays. 
2. Select the test for which you are setting limits. 
3. Right-select the selected test and select Setup Westgard. 

The Setup Westgard editor window displays.

4. Enter the new severity level for each Westgard check.
When any of the fields of the Setup Westgard window is set to 0, the 
individual Westgard check is disabled. To the right of a disabled Westgard 
field, the label “(disabled)” displays. When a Westgard check is disabled, no 
Westgard comment is added to the QC result and no Failed Westgard 
comment is uploaded to the LIS. 

5. Select Apply westgard checks checkbox. 
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If this check box is not selected, the Westgard rules are not applied to the 
method.

6. If you select Include comparator QC results, comparator QC results 
contribute to Westgard checks for all methods of a test. 
When a comparator QC result does not contribute to Westgard checks, a 
comment displays in the Comment field of the QC Result (Across controls 
view) window. Refer to the description of the Comment field in the Statistics 
Area‚ page 202.

7. Select OK.

Configuring Westgard Rules for a Method
Configure the system to use other severity values for the Westgard checks 
performed on specific tests on a single instrument by completing the following 
steps: 
1. At the menu bar, select Start > Configuration > Instruments. 

The Instruments browser window displays. 
2. Select the instrument for which you are setting limits. 
3. Right-select the selected instrument and select Tests. 

The Tests on instrument browse window displays. 
4. Double-select the appropriate test. 

The Method editor window displays. 
5. Select the Advanced tab. 
6. Select the Westgard setup tab.
7. Enter the new severity level for each Westgard check.

When any of the fields of the Setup Westgard window is set to 0, the 
individual Westgard check is disabled. To the right of a disabled Westgard 
field, the label “(disabled)” displays. When a Westgard check is disabled, no 
Westgard comment is added to the QC result and no Failed Westgard 
comment is uploaded to the LIS.

8. Select Apply westgard checks. 
If this check box is not selected, the Westgard rules are not applied to the 
method.
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9. Select OK.

Method Setup Targeting Function
The Setup targeting option from the Method window determines whether 
matching test requests are downloaded to the instrument. This function is not 
applicable to methods referring a calculated test.
Access the Setup targeting window: 
1. At the Method editor window, right-select, and select Setup targeting. 

Field Description

Enable Determines whether matching test requests can be 
targeted to the instrument. 

Seq no Determines the order, among all instruments capable of 
performing the associated test, in which the associated 
instrument is considered as target for a matching 
request. 
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Setting Up Coding Systems
The ADVIA CentraLink system typically communicates with many different 
applications using different names for the same item. To avoid naming conflicts, 
you can set up coding systems. 
A coding system is a set of names used by a given application to denote 
equivalent ADVIA CentraLink system names. Coding systems are stored in the 
ADVIA CentraLink system database and can be modified or expanded at any 
time. in order for the changes to take effect after modifying a coding system, you 
have to stop and restart the services and translators. 
Coding systems can contain codes for the following items
• Tests
• Sample types
• Container types
• Species
• Sample source 

Using Coding Systems 
Coding systems work for the following items:
• Instruments
• LIS
• ADVIA Automation system
Your local technical support provider configures the LIS and ADVIA automation 
coding systems. You may need to add an instrument test code.
You can reference coding systems from instruments to denote the coding system 
used for instrument communication. Multiple instruments can use the same 
coding system. This typically occurs when you are using several instruments of 
the same brand and type. 

Setting Up a Test Code
Test codes are instrument-dependent. In general, each test on an instrument 
must have a unique identifier in the coding system for that instrument on the 
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ADVIA CentraLink system. An exception is where one test on the instrument is 
matched to more than one test on the ADVIA CentraLink system. In this case, 
each test is uniquely identified on the ADVIA CentraLink system by the same 
type. For example, the ADVIA 1650 system uses the same test code for serum 
and urine tests and they are differentiated by the sample type.
Upon entering a change to any field of the Test code window, a message displays 
warning that modifying Code values can affect the reporting of new results. 
1. At the menu bar, select Start > Configuration > Coding Systems. 

The Coding system browser window displays. 
2. Select the appropriate instrument. 
3. Right-select the selected instrument and select Related > Test codes.

The Test codes in coding system browser window displays. 
4. Select New on the toolbar to add a new test code.

The Test codes editor window displays.
Coding system is populated automatically and refers to the coding system to 
which the test belongs.

5. Enter Test. 
The test value is the ADVIA CentraLink system test name.

6. Enter Value. 
This code is the value recognized by the LIS/LAS/instrument.
The sample type value of the test populates the Sample type field. This field 
is not enabled for entry. This value is a reference to the sample type to which 
this code is restricted. 

7. Select OK.

Setting up a Sample Type Code 
In the ADVIA CentraLink software default setup, the sample type “serum” is 
identified with the string “Serum.” A LIS might use the abbreviation “Sr” to denote 



 

322 ADVIA CentraLink Operator’s Guide

the serum sample type. If this occurs, you can create a sample type code that 
associates the abbreviation “Sr” with the ADVIA CentraLink system’s serum. 
NOTE:  If you do not specify a LIS code for serum, the ADVIA CentraLink system 
expects the LIS to use and understand the ADVIA CentraLink system identifier 
“Serum.” 

Upon entering a change to any field of the Sample type code window, a message 
displays warning that modifying Code values can affect the reporting of new 
results. 
1. At the menu bar, select Start > Configuration > Coding Systems. 

The Coding system browser window displays. 
2. Select the appropriate instrument. 
3. Right-select the selected instrument and select Related > Sample type 

codes.
The Sample type codes in coding system browser window displays. 

4. Select New on the toolbar to add a new sample type code.
The Sample type code editor window displays.
Coding system is populated automatically and refers to the coding system to 
which the test belongs.

5. Enter the Sample type. 
6. Enter the Value.

This code is the value recognized by the LIS, LAS, and instrument.
7. Enter Match order. 

Match Order is an integer value used when a single code value is mapped to 
multiple sample types and unsolicited results are uploaded from the 
instrument. The ADVIA CentraLink system picks up the mapping with the 
lowest match order.

8. Select OK.

Setting Up a Container Type Code
Container type codes associate container types with coding systems. 
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1. At the menu bar, select Start > Configuration > Coding Systems. 
The Coding system browser window displays. 

2. Select the appropriate instrument. 
3. Right-select the selected instrument and select Related > Container type 

codes.
The Container type codes in coding system browser window displays. 

4. Select New on the toolbar to add a new container type code.
The Container type code editor window displays.
Coding system is populated automatically and refers to the coding system to 
which the test belongs.

5. Select OK after entering the relevant field values.

Setting Up a Species Code
If the LIS does not specify species codes in a workorder, the workorder in the 
ADVIA CentraLink system has a question mark in the species field indicating 
species unspecified. If the lab only handles specimens from humans, you do not 
have to specify a species. The understanding is that every sample with species 
unspecified is human. When a lab processes more than one species, however, 
you must enter species codes. 
Upon entering a change to any field of the Species code window, a message 
displays warning that modifying Code values can affect the reporting of new 
results. 
1. At the menu bar, select Start > Configuration > Coding Systems. 

The Coding system browser window displays. 
2. Select the appropriate instrument. 
3. Right-select the selected instrument and select Related > Species.

The Species codes in coding system browser window displays. 
4. Select New on the toolbar to add a new species code.

The Species code editor window displays.
Coding system is populated automatically and refers to the coding system to 
which the test belongs.
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5. After entering the relevant field values, select OK.

Defining Sample Sources 
NOTE:  You can define sample sources and set up sample source codes in the 
ADVIA CentraLink software. The ADVIA CentraLink software, however, does not 
currently support connectivity to microbiology instruments. 
Some microbiology instrument types require the exchange of sample source 
data, which is also known as body part location data. For example, to store body 
part location data on where a sample was phlebotomized, the sample source 
data may be "my left foot." While the ADVIA CentraLink software allows you to 
configure sample source data, you cannot display sample source information 
through the Sample editor or browser windows. Complex datatypes and sample 
source data are transmitted directly from the LIS to the instruments and from the 
instruments back to the LIS. You cannot view or manually alter the results. 
Initially you define a sample source through the Sample source editor window. 
The description field enables you to store body type location information for 
microbiology instruments. After this sample source data is defined, you can link it 
to the appropriate coding system. 
Access the Sample source editor window: 
1. At the menu bar, select Start > Configuration > Sample sources. 

The Sample source browser window displays. 
2. Double-select any entry.
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The Sample source editor window displays. 

Setting Up a Sample Source Code 
NOTE:  You can define sample sources and set up sample source codes in the 
ADVIA CentraLink software. The ADVIA CentraLink software, however, does not 
currently support connectivity to microbiology instruments. 
Sample source codes associate sample sources with the appropriate coding 
system. For example, in coding system CS, sample source Left Knee is 
represented by code value MGE.
When linked, the ADVIA CentraLink software can match internal and external 
sample source identifiers during communication with external applications. 
1. At the menu bar, select Start > Configuration > Coding Systems. 

The Coding system browser window displays. 
2. Select the appropriate instrument. 
3. Right-select the selected instrument and select Sample source code.

Field Description

Name Unique identifier of the sample source. 

Description Free text description of the sample source. 
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The Sample source code window displays. 

Field Description

Coding system Reference to the coding system that contains the code. 

Sample source Reference to the sample source that is identified by the 
code. 

Value Code identifying the sample source within the coding 
system. 



327

Configuring Patient Locations
The Patient locations browser window lists the locations that can be associated 
with a patient. 
1. From the menu bar, select Start > Configuration > Patient locations. 

The Patient locations browser displays. 
2. To add a new Patient location, select New on the toolbar.

The Patient location editor window displays. 

3. Enter the appropriate information and select OK. 

Field Description 

Name Unique identification for the location.

Description Description of the location.
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Configuring a Report Model
Report models are templates for reports. Report models allow you to configure 
header, body, and footer information. If a report model is not defined, a default 
report style is used. 
1. At the menu bar, select Start > Configuration > Report models.

The Report model browser window displays. 
2. To add a new Report model, select New on the toolbar. 

The Report model editor window displays. 

Field Description 

Name Unique identifier for the report model. 

Comment Full name or explanation of the report model.
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Define a report model through the report model editor window by completing the 
following steps: 
1. Enter or modify the Name and Comment.
2. Double-select Header. 

The Texts based on table browser window displays. You can select from the 
available header designations. If you need a customized header, contact your 
local service provider for assistance.

Fax Header When sending a fax and the Via fax checkbox at the 
Report window is selected, the 
ReportModel.FaxHeader text is added as the header.

Header Unique identifier or name for the report header/title.

Column Heading List List of column headings separated by commas.

Column type list List of column types separated by commas. The order 
of the column types corresponds to the order of the 
headings in the Column heading list field. The following 
column types are available: 
• Description: description of test
• Name: test name (mnemonic)
• Norm: Applicable normal range
• Severity: associated severity
• Unit: units or measure for the displayed results
• ValidationUser: login name of validating user
• Value: result value
• Validation Date/Time: date and time of result 

validation. 
• Instrument: instrument on which the validation was 

performed.

Footer Unique identification or name for the report footer.

Field Description 
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Right-select the selected header and select Preview to display the header. 
3. Double-select Column heading list. 

The Multi-lingual text editor window displays. 
a. Select New to create a new column heading list or Edit to modify an 

existing one.
b. Enter or modify the comma-separated list of column headings in the 

bottom Editor field. 
The list of headings must be in the same order as the list of column types.

c. Select a language. 
d. Select Save to record the list in the Report model editor. 

4. In the Column type list field, specify each column type in a comma-separated 
list using only the specified types. 
NOTE: The order of the column types must correspond to the order of the 
column headings. 

5. Double-select Footer. 
The Texts based on table browser window displays. You can select from the 
available footer designations. If you need a customized footer, contact your 
local service provider or distributor for assistance.

6. Select OK.
NOTE:  For information on printing a report, see Generating a Sample Report‚ 
page 86 and Generating QC Reports‚ page 220. For information on assigning a 
report model to a physician, see Accessing Physician Records‚ page 239. For 
information on setting a report model as the default, see Customizing Reports‚ 
page 398. 
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Defining Print Commands
The following print commands exist on the Record menu: 
• Print – When you select Print, ADVIA CentraLink software automatically 

prints a copy of the open browser to the default printer. 
• Print... – When you select Print..., the Output options window displays. 

Through the Output options window, you can choose among several print 
options before printer. 

Access the Output options window: 
1. At the toolbar, select Record > Print.... 

The Output options editor window displays.

Field Description

Selection only If selected, print only the selected records.
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Device type The options include the following: File, Terminal, 
Printer, Clipboard, Excel, or Word. 
The default for printing is Printer. 

Format The options include the following: Text or HTML. 

Printer Reference to the printer to which output is directed. 

Set as default If selected, allows you to save the value in the Printer 
field as the default user printer.

Directory Target location for generated files. 

File Name of the generated target file. 

Copies Number of copies to be printed.

Field Description
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Setting Up Users and Security
You can add users to the ADVIA CentraLink system and assign different 
privileges to them.

Adding New Users
Set up new users with a login name, password, and other settings:
1. Log on as System Manager.
2. At the menu bar, select Start > System management > Security > Users.

The Active users window displays. 

3. At the toolbar, select the New icon or at the keyboard, press Insert. 



 

336 ADVIA CentraLink Operator’s Guide

The User editor window displays. 

Field Description 

Initials User’s initials. 

Last name User’s last name. 

First name User’s first name. 

Login name Unique identifier for the user. When a user first logs in 
to the ADVIA CentraLink system, the password is the 
same as this login name.

Type Possible values in increasing order of authority are 
Guest, User, System manager, and Developer. 
Siemens strongly recommends that you select “User” 
as the type for all operators. For more information on 
using types, see Assigning Privileges‚ page 342.

Language User’s preferred language. This setting overrides the 
site default specified in application-level settings.

Enabled Determines whether or not a user is allowed to log in. 
You cannot delete user records. Mandatory field entry.
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Autologin allowed Allows a user to log on without a password.

Minimum password 
length

Minimum number of characters in the logon password. 
This setting overrides the site default specified in 
application-level settings. It is not applicable to system 
managers or developers. The Maximum length is 20 
characters.

Maximum password 
age

The maximum age of a password, measured in days. 
This setting overrides the site default specified in 
application-level settings. It is not applicable to system 
managers or developers. Mandatory field entry.

Start function Function that is activated automatically every time the 
user logs in. For example, you can set the system to 
open the Review and Edit window at start up.

Start function param 
set

Specifies the parameter set to be used for the Start 
function.

Authorization timeout Maximum time in seconds that a user can refrain from 
interacting with the application. This setting overrides 
the site default specified in application-level settings. 
Mandatory field entry.

Context timeout Maximum time in seconds that a user can leave the 
password dialog unattended. This setting overrides the 
site default specified in application-level settings.

Printer Default printer for the user.

E-mail address User’s email address. 

Mail method User’s preferred mail receipt method. Valid settings are 
Internal (through ADVIA CentraLink system built-in 
mail), External (through Internet), or both.

Field Description 
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Setting a User Password
If you assign a password to a user, the user must type it in the password field on 
the Logon window when logging on.
Define a user password on the User window: 
1. Right-select and select Change Password.
2. Enter the new password. 

The system has a six password memory; you cannot reuse a password until it 
has been changed six times. 

3. Enter the password again in the verification field. 
4. Select OK.

Assigning Printers to a User
At the Active user’s browser window, the Printers right-select option allows you to 
assign printers to a given user. 
NOTE: User’s of type System Manager cannot assign their own printers; 
however, user’s of type System Manager can assign printers to other System 
Managers. 
Assign a preferred list of printers to a user: 
1. At the menu bar, select Start > System management > Security > Users.

The Active users window displays. 
2. Highlight the user to whom who want to assign printers. 
3. At the highlighted user entry, right-select the user and select Related > 

Printers. 
The Printer assignment browser window displays. 

4. At the toolbar, select the New icon or at the keyboard, press Insert. 
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The Printer assignment editor window displays.

5. In the Printer field at the Printer assignment editor window, double-select the 
? symbol. 
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The Printers browser window displays and lists all of the printers defined to 
the system. 

6. At the Printers browser window, select the printers that will be assigned to the 
given user. 
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7. After the appropriate printers are selected, select OK. 
The Printer assignments window displays and lists each of the printers that is 
assigned to the given user. 

 
8. At the Printer assignments window, select Close. 

The Active users window displays. 
The printers are assigned to the user. When the user accesses the Printers 
browser window, the Show my printers only checkbox must be selected in 
order to view the preferred printer list assigned to the user. Refer to At the 
menu bar, select Start > System management > Printers.‚ page 395. 

About System Managers
You can set up multiple users as System Manager. For each System Manager 
you add, we recommend you specify an email address. System Managers can 
receive email alerts from the Watchdog monitoring program. For more 
information, see Watchdog Service Alerts‚ page 361.
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Assigning Privileges
You can create privileges and associate them with operators, functions, and data.
The high level steps for assigning privileges are as follows: 
1. Add new operators as type User.
2. Add a new privilege.
3. Define the privilege by adding functions and data to it. 

This is known as protecting the functions and data. If functions and data are 
assigned to a privilege, no operator of type “User” has access to them unless 
assigned to the privilege.

4. Assign an operator to the privilege, giving the operator access to the 
functions and data.

NOTE:  The following users types are not associated with privileges: Guest, 
System Manager, and Developer. Guests are never granted any privileges. 
System managers and developers never require any privileges. Only for the 
generic type User are privileges taken into account.

Each function has a minimal user type assigned to it. This is the minimal authority 
or experience level a user has to activate that function.
Consider the following table that depicts the relationship among functions, 
privileges, and users. 

Functions are assigned to privileges and then users are assigned to privileges. In 
the above scenario, only a user assigned to “Senior” can validate a sample. You 
can assign one function or one user to two different privileges. 

Functions Privileges Users 

Order Entry Advanced Marit

Sample Validation Manager Steven

Result Entry Senior Lieven

Physician
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Adding a Privilege
1. Log on as the System Manager.
2. At the menu bar, select Start > System Management > Security > 

Privileges.
3. Select New on the toolbar.
4. Type in a Name that is the unique identification of the privilege.
5. Select OK.

Adding Functions to a Privilege
You can associate a privilege with data or functions to protect them from 
unauthorized user access. You can subsequently assign privileges to users to 
grant them access to the data and functions that the privilege protects.
NOTE:  Whenever you add a function to a privilege, it is protected from all users; 
that is, the function is not available to users of type “User” until you assign a user 
to the privilege.

1. Log on as the System Manager.
2. At the menu bar, select Start > System Management > Security > 

Privileges.
The Privileges browser window displays. 

3. Select the appropriate privilege. 
4. Right-select the selected privilege and select Functions Protected.

A list of functions currently protected by the privilege displays. Functions are 
identified by the combination of a table and a mnemonic. 

5. Select New on the toolbar. 
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The Function Privilege window displays. 

 
6. Double-select the Function table. 

A list of database table names displays. 
7. Select the table that contains the function.
8. Double-select the Function mnemonic. 

A list of Methods displays.
NOTE: The Privilege field is automatically populated with name of the 
privilege you are modifying.

9. Select OK. 



345

Adding Users to a Privilege
After you have assigned functions to a privilege, you can assign users to allow 
them access to those functions.
1. Log on as the System Manager.
2. At the menu bar, select Start > System Management > Security > 

Privileges.
The Privileges window displays. 

3. Select the appropriate privilege. 
4. Right-select the selected privilege and select Privileged Users.

A list of users currently assigned to the privilege displays. 
5. Select New on the toolbar. 

The User’s Privilege window displays.
6. Double-select User to select from the Users window.
7. Select OK.
The next time the user logs on, the privilege is in effect.

Default Functions for All Users
By default, users have access to the following basic functions: 
• DeltaNorm – Comment, Eligible, Species, Test
• Instrument – Tests
• Method – QCPopulations
• Norm – AgeUnit, Comment, Eligible, Method, Species, Test
• PanelMember – Requestable
• PanelRequestable – Members
• Patient – Age, Species
• Physician – ReportModel
• QCLot – DeepCopy, QCPopulations, Report
• QCPopulation – LeveyJenningsGraph, Lot, Method, Recalculate, Report, 

Results, SetReference
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• QCResult – Population
• Request – CheckResult, DiscontinuationUser, Discontinue, EditComment, 

Invalidate, Patient, Rerun, Results, Revert, Sample, UploadUser, Validate, 
ValidationUser, ViewImage

• Requestable – PanelMembership
• Result – AvailabilityUser, AddComment, Method, Request, ViewImage, 

ScheduleUser
• Sample – CheckResults, DiffPad, Patient, PatientLocation, Physician, 

Report, Requests, Rerun, ReviewAndEdit, Type, UploadResults, ViewImage
• SampleType – Description

Services – CheckActivity
• Site – Calculator, Calendar, InstrumentsByName, OrderEntry, 

PatientsByLastNameFirstName, PhysiciansByLastNameFirstName, 
QCLotsByNumber, QCPopulationQuery, RequestablesByMnemonic, 
ResultEntry, SampleQuery, SamplesByIdentifier, SampleTypesByMnemonic, 
ServicesByName, SpeciesByName, TestsByMnemonic, ReviewAndEdit

• Species – Patients
• Test – Instruments, Norms, SampleType, ResultChoices, DeltaNorms, 

Requestables

Using the Default Advanced Privilege
The Advanced privilege is shipped with the ADVIA CentraLink system but must 
be granted to users before they have access to advanced functions. 
Display the list of functions associated with the Advanced privilege by completing 
these steps:
1. Log on as the System Manager.
2. At the menu bar, select Start > System Management > Security > 

Privileges.
The Privileges window displays. 

3. Select the Advanced privilege. 
4. Right-select to access the list of protected fields, functions, and tables. 
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Protecting Table and Field Data
You can associate privileges with individual database tables and fields to protect 
them from unauthorized viewing, modification, or both. 
Control access to a table by specifying table and the type of access to restrict:
1. Create or select a privilege to associate with access to the table.
2. Right-select and select Tables protected.
3. Enter the Table. 
4. Enter the Type of access to restrict.

NOTE: The Privilege field is automatically populated with name of the 
privilege you are modifying.

5. Select OK. 
Control access to a field by specifying the field name, field table, and type of 
access that you want to restrict:
1. Create or select a privilege to associate with access to the field.
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2. Right-select and select Fields protected. 

3. Enter the Field name.
4. Enter the Field table. 
5. Enter the Type of access to restrict. 

NOTE: The Privilege field is automatically populated with name of the 
privilege that you are modifying.

6. Select OK. 
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Auditing Database Tables
Auditing provides a means of tracking the history of database tables. When 
auditing on a table is enabled, each of the transaction records of the table is 
saved to an audit log file. Auditing is performed at the table record level. User 
actions are audited; batch actions are not audited. 
You can specify which tables to audit from a predefined list. The following actions 
can be tracked: 
• Sample deletion 
• Sample omission
• QC result omission 
• QC result reinstatement
• QC severity resetting
• QC population modification
• QC Lot Modification
• Request omission
• Request deletion
• Result Editing
• User account modification
• Modifications to the Norms
• Modifications to Flags
• Modifications to the Delta Norms
• Modification to MISPLs
• Modifications to Calculations
• Modifications to Texts Table
• Modifications to the Coding Systems
• Modification to Commands
• Modifications to Tasks
• Modification to Units and Dimensions
• Modification to Aspects
• Modification to Container type
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• Modification to Instrument records
• Modification to Instrument Groups
• Modification to Test Groups
• Modification to Requestables
• Modification to Patients
• Modification to Patient Location
• Modification to Physicians
• Modification to Sample Types
• Modification to Species
• Modification to Specific-Self (Options)
• Test and Method table modification
• Audit Trail purge
The tables that are audited by default are listed as follows: 
• Aspect
• bt_ActualFunctionParameter
• bt_ActualFunctionParameterSet
• bt_ActualQueryParameter
• bt_ActualQueryParameterSet
• bt_Command
• bt_Task
• CodingSystem
• ContainerType
• ContainerTypeCode
• DeltaNorm
• DilutionCondition
• Dimension
• gp_Site
• gp_SiteFunction
• gp_Text
• Instrument
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• InstrumentCode
• InstrumentFlag
• InstrumentGroup
• lg_Type
• Method
• Norm
• PanelMember
• PanelRequestable
• Patient
• PatientLocation
• Physician
• QCLot
• QCPopulation
• QCResult
• Request
• Requestable
• Result
• Sample
• SampleSource
• SampleSourceCode
• SampleType
• SampleTypeCode
• sc_User
• SimpleRequestable
• Species
• SpeciesCode
• SpecificSelf
• Test
• TestCode
• TestGroup
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• Unit
Audit logs contain the following information: 
• Changed fields with From and To values
• Date and time the change was made
• User who initiated the change
• Action performed by the user who initiated the change
Audit information can be exported and can be purged. Automated tasks, 
executed by the user “Batch,” are excluded from auditing. 
NOTE: User actions are audited, batch actions are not audited. 

Viewing Audit Logs
You can view a list of the logging activity that pertains to a specified user, table, or 
both through the Log Entries window. 
Access the Log entries window: 
1. At the menu bar, select Start > System Management > Logging> Audit 

Overview.



353

The Audit overview query window displays. 

 

2. After entering the parameters, select OK. 

Field Description

From Parameter that limits the display of audit log entries to 
those that have a date stamp value equal to or greater 
than this From date value. 
This is a required field. 
NOTE: The number of days between the From date and 
the To date values cannot exceed 60 days.

To Parameter that limits the display of audit log entries to 
those that have a date stamp value less than or equal 
to this To date value. 
NOTE: The number of days between the From date and 
the To date values cannot exceed 60 days.

User Parameter that limits the display of audit log entries to 
those initiated by this user. 
NOTE: Either a User or Table name value must be 
entered. 

Table Parameter that limits the display of audit log entries to 
those applicable to this table. 
NOTE: Either a User or Table name value must be 
entered. 



 

354 ADVIA CentraLink Operator’s Guide

The Log entries window displays. 

The audit information that displays is restricted to meet the audit query 
parameters entered to the Audit overview query window. The parameters for 
this restricted audit set apply until the current Log entries window session 
ends. 

Field Description

Creation Time Displays the creation date of a log entry.

S Displays the severity of the entry. 

Login Displays the name of the user.
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Table Name Displays the name of the table for which the audit log is 
generated. 

Name Displays the log type of the audit log. 

Description Displays the transaction details of the record within the 
audited table. 

User name Displays the full name of the user. 

Log Type Area

Name Displays the name of the log type. 

Enable If selected, indicates whether this type of log is currently 
enabled. 

Log Process Area

Name The name of the program that initiates the logging 
process. 

Final If selected, this checkbox Indicates whether the logging 
process is closed for the log file and thereby finalized. 

Creation time Displays the creation time of the log file. 

Expire date Displays the expiration date of the log file. 

Disposition Area
Limit to selected 
record

If selected, restricts the displayed list of audit log entries 
to the transaction records within the current view that 
pertain to the currently selected record. 
NOTE: The display of audit log entries is refreshed from 
the transaction records that display in the current view, 
not from all applicable transaction records stored in the 
database. 

Field Description
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Group by record If selected, groups all transaction records within the 
current view to the record to which the transaction audit 
log entries apply. Groups of transaction records are 
distinguished from each other by a different background 
display after each transaction group. 
For example, within the current view, all records that 
pertain to User A would be grouped together against a 
white background; all records that pertain to User B 
would be grouped together and these records would be 
distinguished from those of the previous group with a 
grey background; all records that pertain to User C 
would be grouped together against a white background, 
and so on. 

Show subject record If selected, transfers control to the applicable editor 
window in which the transaction was entered and saved 
and displays the details of the transaction record within 
this editor window.
NOTE: If the first record of the transaction record 
grouping is a deleted record and you select Show 
subject record, the corresponding editor window does 
not display because the deleted record does not exist. 

Export to browser If selected, exports the displayed audit log data to an 
XML-based file that can be printed. 

Options If selected, displays the Audit overview query window, 
which allows for you to update the parameters of the 
query. 
Upon redisplay of the Log entries window, the audit log 
data is refreshed to reflect records that meet the 
entered audit criteria. 
Refer to Entering Auditing Criteria that Restricts the Log 
Entries Display‚ page 357. 

Field Description
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Entering Auditing Criteria that Restricts the Log Entries Display
Through the Audit overview query window, you can restrict the audit information 
that displays within the Log entries window to that which meets specified audit 
criteria. 
Access the Audit overview query window: 
1. At the Log entries window, select Options. 

The Audit overview query window displays. 
For details on the parameters of the Audit overview query window, refer to 
Viewing Audit Logs‚ page 352. 

2. After entering the parameters, select OK. 
The refreshed (Audit Overview) Log entries window displays. 
The audit information that displays is restricted to meet the audit query 
parameters entered to the Audit overview query window. The parameters for 
this restricted audit set apply until the current (Audit Overview) Log entries 
window session ends. 

Close If selected, the Log entries window closes. 

Field Description
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Checking Log Files and Starting and Stopping the Server
The ADVIA CentraLink system maintains log files that track database activity. 
You can monitor the log files and then stop and re-start the ADVIA CentraLink 
software and its databases.
In the Log Folder field of the General tab of the system Options window, a root 
folder directory for all log files is specified. This root folder contains subfolders for 
service logs, which are named svc, and translator logs, which are named trl, 
respectively. These subfolders are again subdivided in subfolders dedicated to 
individual services and translators. If the ? symbol is specified in the Log Folder 
field of the General tab of the system Options window, the log file folder defaults 
to <CentraLink>\log. 
The ADVIA CentraLink system server is the computer containing the 
ADVIA CentraLink databases: 
• Genro: Generic, Read-only data (for example, scheme info)
• CentraLink: Specific, Read-write data (for example, tests, samples, etc.)
These databases are installed as part of the ADVIA CentraLink application and 
are in Progress database format. Some Progress commands, including the 
Progress Explorer Tool, display in your Start menu. The Progress Explorer Tool 
allows you to manually start or stop the two databases that the ADVIA CentraLink 
system uses.
During the ADVIA CentraLink system installation procedure, the databases are 
set up to automatically start and stop upon system startup and shutdown. 
However, you may need to manually start or stop the database. For example, you 
may need to stop the database to upgrade the ADVIA CentraLink system to a 
newer version then restart it after the upgrade is complete.
In addition to starting and stopping the database servers, other services, such as 
those used for instrument communication, need to be started and stopped as 
well. 
If changes are made to a translator, for example, you must stop and start the 
translator for the changes to take effect. 
CAUTION: Be sure to stop all the ADVIA CentraLink system services before 
making any system changes, such as changing the system date and time.
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Using Progress Explorer
The Progress Explorer Tool allows you to manually start and stop the databases. 
When you start Progress Explorer, you must be connected to the 
ADVIA CentraLink system server running the databases. This is the server where 
AdminService for Progress 10.1C is running. This software is installed on the 
server during the installation or upgrade process. 

Manually Stopping the Database
1. At the menu bar, select Start > System management > Services > 

Shutdown. 
2. Exit all interactive ADVIA CentraLink sessions on the server and on the client 

workstations.
3. Shut down all databases: 

a. At the menu bar, select Start > Programs > OpenEdge > Progress 
Explorer Tool. 

b. Using the tree view, go to the ADVIA CentraLink databases: Console 
Root > Progress Explorer > localhost > Databases. 

c. Right-select the SampleNet database and select Stop. 
Repeat these shutdown procedures for the CentraLinkgenro database.
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Manually Starting the Database 
You must start the ADVIA CentraLink server from the computer on which the 
ADVIA CentraLink server software is installed. Do not start the server from any 
other computer.
1. Start all databases:

a. At the ADVIA CentraLink server Windows Start menu, select Programs > 
OpenEdge > Progress Explorer Tool. 

b. Using the tree view, go to the ADVIA CentraLink databases: Console 
Root > Progress Explorer > localhost > Databases. 

c. Right-select the Samplenet database and select Start. 
Repeat these startup procedures for the CentraLinkgenro database.

2. Start the services and translators on the ADVIA CentraLink session server:
a. At the menu bar, select Start > System management > Services > 

Startup. 
This procedure only starts services and translators with the AutoStart attribute 
selected. Verify that services and translators are selected correctly. You must 
start any unselected required services and translators individually.
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Understanding the Watchdog Service and Dashboard
You can automatically monitor communication with the LIS, ADVIA Automation, 
and analysis instruments using the Watchdog service and the Watchdog 
Dashboard.

Watchdog Service 
The Watchdog service is a background program that monitors connectivity and 
availability. The Watchdog service monitors the following items:
• Connection status of translator services and their associated translators
• Availability of the LIS FTP service
• Connection status of the Database server
• Availability of space on disk drive used for image storage
All incoming information is gathered, interpreted, and dispatched to the 
Watchdog Dashboards. Information related to connectivity and availability is 
posted as messages in the Message log of the Dashboard and are broadcast as 
alerts via email to system managers. 

Watchdog Service Alerts
The Watchdog service can be configured to alert every ADVIA CentraLink 
system user of type System Manager. Alerts are sent as messages displayed to 
the Dashboard, as emails, or as both.
To receive alerts as emails, you as system manager must specify the mail server, 
mail port, and your email address on the Mail tab of the system Options window. 
NOTE:  A system manager receives a Windows messenger alert if the system 
manager’s login name to the ADVIA CentraLink software is the same as the 
system manager’s login name to Windows. 

The Watchdog service generates alerts under the following conditions: 
• When a service remains in status Undetermined for more than 50 seconds
• When a translator remains in status Disconnected for more than 10 seconds
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Watchdog Dashboard 
The Watchdog Dashboard connects to the Watchdog service. Through its 
graphical interface, the Watchdog Dashboard displays the monitoring results of 
the Watchdog service. 
The Watchdog Dashboard displays the status of communication with the 
connected translator services and translators and displays log messages. You 
can filter the displayed translator services and translators by name or by 
instrument group. 
Through the Send QC Warnings to Watchdog checkbox on the Watchdog tab of 
the system Options window, you can configure sending QC severity change 
messages to the Watchdog Dashboard. 
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To access the Watchdog Dashboard: 
1. Select the Dashboard icon on your desktop. 

The Dashboard window displays.

Translator services are located on the left side of the Watchdog Dashboard 
window. The associated translators are located on the right. 

Dashboard Toolbar 
The Watchdog Dashboard window toolbar contains the following: 
• About button - Displays the About dialog box, which displays product version 

and copyright information. 
• View button - As per a dropdown menu selection, allows you to sort the 

display of services and translators as follows:
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- Show all items - Displays all the services and translators.
- Hide inactive - Displays only the active services and translators.
- Show specific set - Displays services and translators by instrument group.

• Setup button - Accesses the Watchdog Dashboard Preferences window. 
Through the Watchdog Dashboard Preferences window, you can configure 
the Watchdog Dashboard to connect at Watchdog startup to a specific host 
and port, which is the default and is recommended, or to search for and 
display all available Watchdog services on the network upon Watchdog 
Dashboard startup. 

• Filter field - As per translator name values entered to this field, you can filter 
the display of translator service and translator information by translator name. 

Dashboard Tabs 
The Watchdog Dashboard window consists of two tabs: Communication Monitor 
tab and Message Log tab. 

Communication Monitor Tab
Translator servers and their associated translators display on the Communication 
Monitor tab of the Watchdog Dashboard. You can filter the display of this 
translator information by name or by instrument group. 
On a given row of the Watchdog Dashboard, the leftmost rectangle represents 
the translator service and the rectangles that follow in the same row represent the 
associated translators.
Message Handling and Alert Display
Warnings, errors, and alerts display as follows: 
• Light bulb icons - Upon receipt of an QC message alert, a light bulb icon 

displays in the translator service or translator rectangle. When you select the 
light bulb icon, the message displays in the Information text area at the 
bottom of the Watchdog Dashboard window. 

• I icon - Displays when your mouse hovers over the a service or translator on 
the Communications tab. When you click on the corresponding rectangle on 
which the I icon displays, data display in the Information panel is refreshed 
with information that pertains to the corresponding service or translator. 

• Messenger service alert window - Displays upon disconnect of a service, 
translator, or ftp server and when limited space on the hard drive is detected. 
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Starting and Stopping Translator Services and Translators 
If you logged into Windows with a user account that has the privileges to start and 
stop services, you can start and stop services and translators from the Watchdog 
Dashboard. 
At the Watchdog Dashboard, you can start and stop the translator services and 
translators from the following two areas:
• Translator service and translator rectangle - By right-selecting an individual 

rectangle and selecting start or stop, you can start or stop the corresponding 
translator service or translator. 

• Information panel - By selecting a translator service or translator, you can 
isolate and display the data of individual translator services and translators at 
the information panel at the bottom of the window. At the information panel, 
you can start and stop translator services and translators by selecting Start or 
Stop in the Actions area. 

Refer to Start and Stop Translator Services and Translators‚ page 374.
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Status of Communication 
The status of communication with the connected servers and translators displays 
through color codes. 

QC Severity Messages 
Through the Send QC Warnings to Watchdog checkbox on the Watchdog tab of 
the system Options window, you can configure sending QC severity change 
messages to the Watchdog Dashboard. 
These QC severity message displays are compatible with both Normal and 
Concentrator instrument types.
For QC messages from a concentrator translator, the value of the sender is the 
name of the concentrator translator; the warning displays as a light bulb icon on 
the concentrator translator rectangle. Upon selecting the light bulb icon on the 
concentrator translator rectangle, the QC message text displays in the 
Information area of the Watchdog Dashboard and contains a reference to the 
normal instrument. 

Color Service Status / Meaning Translator Status / Meaning

Green Active
Sent activity confirmation less 
than 1 minute ago.

Active
Started and connected to 
external application.

Gray Inactive
Defined in database, but not 
started.

Inactive
Defined in database, but not 
started.

Red Undetermined
Did not send an activity 
confirmation for more than one 
minute because the service is 
inactive or busy. 

Disconnected
Started but not connected to 
external application.
NOTE: Translators that use FTP 
as the low-layer protocol, for 
example, the LMX LIS translator, 
do not have a status of 
Connected or Disconnected. 
The status of these translators is 
either Active or Inactive. 
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If the ADVIA CentraLink QC severity is 0, then the QC message displays as 
severity information in the Information panel and also as log messages in the 
Message Log tab. 
If the ADVIA CentraLink QC severity is greater than 0, then the QC message 
displays as a severity warning in the Information panel and also as log messages 
in the Message Log tab. 

Message Log Tab 
Log messages and QC messages display in a table format on the Message Log 
tab of the Dashboard.
You can select the header of each column of the log table to sort the log message 
display. 
The Log tab lists the most recent postings to the message log. A scrollbar 
displays as required. 
By selecting a given log message row, you can isolate and display the data of the 
log messages at the information panel at the bottom of the window. 
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Configuring the Watchdog Service and Dashboard
Starting Watchdog Service Independent of Other Services
The Watchdog Startup window allows you to configure a control service that 
communicates with the Dashboard. Unless the control service is started 
manually, the control service starts automatically when the Watchdog starts. 
To start the Watchdog service independent of other services, do the following: 
1. At the menu bar, select Start > System Management > Services > 

Watchdog > Start. 
The Start window displays. 

Field Description 

Log file keep The recommendation is to leave this field value defined 
as the ? symbol. 
NOTE: The field value on this Start window is not used. 
Your technical support provider configures this value in 
the watchdog.dashboard.log4j.properties file. 
Log file keep is the numerical value associated with the 
unit of time in which the log file is kept. 
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You can view the current configuration of the Watchdog, which includes the fields 
and values of the Startup window as well as the Server and Port fields, through 
the Watchdog tab of the system Options window. These values can only be 
changed on the Register Watchdog window or the Startup window. 

Log file keep unit The recommendation is to leave this field value defined 
as the ? symbol. 
NOTE: The field value on this Start window is not used. 
Your technical support provider configures this value in 
the watchdog.dashboard.log4j.properties file.
The unit of time in which the log file is kept. 
Log file keep is expressed in the Log file keep unit. It 
determines how long log files will be kept. After the 
specified period, they are automatically deleted to 
preserve disk space.

Log file max size The recommendation is to leave this field value defined 
as the ? symbol. 
NOTE: The field value on this Start window is not used. 
Your technical support provider configures this value in 
the watchdog.dashboard.log4j.properties file.
This maximum log file size is expressed in megabytes. 
Specifies the maximum size to which the log file can 
increase before the log file is closed and superseded by 
a new one.

Control service Mandatory field that references the service that allows 
the Watchdog to start and stop other services. 
The Watchdog control service must use the XML-based 
internal language. You must prefix the Watchdog 
control service name with "xml_" and in the Specific 
options field of the Services window, set the its options 
to 
-O "UseLengthPrefix=YES\\MessageHandlers=
xml_amh.r". 

Field Description 



 

370 ADVIA CentraLink Operator’s Guide

Registering and Unregistering Watchdog
Before you can start the Watchdog service, you must register it with Windows. 
You must register Watchdog on the ADVIA CentraLink system server.
NOTE: After registering the Watchdog service, always start the Watchdog service 
to avoid delays in communication with the instrument translators. 
Register the Watchdog service: 
1. At the menu bar, select Start > System Management > Services > 

Watchdog > Register.
The Register Watchdog window displays. 

 

Field Description 

Service name Name of the Windows service to be registered. 

Folder The folder where the Watchdog is installed. The default 
is the Watchdog subfolder of the application root folder.

Server Contains the name or IP address of the 
ADVIA CentraLink system server.

Port Specifies the TCP/IP port where the Watchdog is 
listening.
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Unregister the Watchdog service: 
1. At the menu bar, select Start > System Management > Services > 

Watchdog > Unregister.

Starting and Stopping Watchdog
After the Watchdog is registered, you must start and stop it along with AutoStart 
services and translators. 
NOTE: After the Watchdog service is registered, you must always start the 
Watchdog service to avoid delays in communication with the instrument 
translators. 
Start the Watchdog service: 
1. At the menu bar, select Start > System Management > Services > 

Watchdog > Start. 
Stop the Watchdog service: 
1. At the menu bar, select Start > System Management > Services > 

Watchdog > Stop. 

Configuring Watchdog Dashboard
Defining Watchdog Dashboard Preferences 
By default, the Watchdog Dashboard takes the first available port as the Receiver 
port, which is the port through which the Watchdog Dashboard receives data 
from the Watchdog service. 
If your lab requires incoming socket communication on fixed ports, however, then 
you can assign a fixed port to the Receiver port. 

User login name Windows user account used to run the service. This 
account does not need administrator privileges but 
requires the user right “Log on as a service.” If running 
in a domain, use <DomainName>\<LoginName>; 
otherwise, use <ComputerName>\<LoginName>.

User password  User’s Windows password.

Field Description 
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Access the Watchdog Dashboard Preferences window:
1. At the Watchdog Dashboard, select Setup. 

The Watchdog Dashboard Preferences window displays. 
NOTE: Each of the parameters defined on the Watchdog Dashboard 
Preferences window is a global setting. The selections made to the Watchdog 
Dashboard Preferences window affect each Watchdog Dashboard connected 
to this Watchdog service. 
If another Watchdog Dashboard is open and active at the time the 
preferences are reset, however, the other Watchdog Dashboard does not 
reflect the changed preferences until you exit this Watchdog Dashboard and 
subsequently reopen this Watchdog Dashboard. 

2. At the topmost radio buttons area, select Always connect to the Watchdog 
Services running. 
NOTE: The default option upon Watchdog Dashboard Preferences display is 
Display ZeroConf-enabled discovery dialog at startup. The recommendation, 
however, is to select the Always connect to the Watchdog Service running on 
option in order to always connect to the Watchdog service.
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If the Display ZeroConf enabled discovery dialog at startup is selected, 
however, the Watchdog Service Discovery window always displays the 
available Watchdog services upon Watchdog Dashboard startup. 

3. At the Host field, enter the Host specified when you registered the Watchdog 
service. 

4. At the Port field, enter the Port specified when you registered the Watchdog 
service.
NOTE: Even when the Always connect to the Watchdog Services running 
field is selected, the Watchdog service discovery window displays upon 
Watchdog startup if the Watchdog service is down or the Watchdog service 
cannot connect to the specified host and port. Under these circumstances, 
troubleshoot the problem to restart the Watchdog service and, if required, 
reconfigure the port. After the issue is resolved, ensure that the Always 
connect to the Watchdog Services running field is selected and restart the 
Watchdog. 

5. At the Default filter field, you can enter the filter by name that restricts the 
default display of translator services and translators upon Watchdog 
Dashboard setup. 
For example, you could enter the value ADVIA to the Default filter field to 
restrict the display of translator services and translators displayed by 
instrument group. 

6. At the Receiver port field, enter the port on which the Watchdog Dashboard 
will receive the data from the Watchdog Daemon. 

7. At the Purge log items older than hours field, enter 24. 
Upon Watchdog Dashboard startup, log items older than 24 hours are 
purged. 

8. At the Purge QC warning older than days field, enter 24. 
Upon Watchdog Dashboard startup, QC warnings older than 24 hours are 
purged. 

9. Select OK. 
After you reopen the Watchdog Dashboard, selections made to the Watchdog 
Dashboard Preferences window take affect. 
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Start and Stop Translator Services and Translators 
At the Dashboard, you can start and stop the translator services and translators 
from the following two areas:
• Translator service and translator rectangle
• Information panel
At the translator service or translator rectangle, start or stop services and 
translators as follows: 
1. Right-select the corresponding translator service or translator rectangle.
2. From the dropdown menu, select Start or Stop. 
At the information panel, start or stop services and translators as follows: 
1. Select the translator service or translator.

At the information panel at the bottom of the window, the data of individual 
translator services and translators displays.

2. In the Actions field at the Information panel, select Start or Stop. 
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Checking Database Storage 
You can manually or automatically check ADVIA CentraLink software’s database 
storage size.
You can verify disk space availability, database extent usage, and database lock 
table overflow risk. Disk space availability checking is only available on the 
ADVIA CentraLink system server. 
Verify available database storage on the server by completing the following step: 
1. At the menu bar, Start > System management > Database > Check 

storage. 
The Check storage window displays. The system checks local disks only. 

Field Description 

Backup maximal days 
passed

A warning is generated when more days have elapsed 
since the latest Progress database backup than the 
specified Backup maximal days passed. 
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Warnings are displayed to the current user and mailed to all enabled users of 
type “System Manager.”
System managers can schedule the storage check function to run automatically. 

Disk minimal 
megabytes free

Minimal amount of megabytes that must be available to 
prevent a warning.The recommended setting is 200. 
This warning may trigger either before or after the 
maximal usage value is set. For example, if you set this 
value to 200 MB, and set the maximal usage to 80%, 
but only 75% of the disk has been used, this warning is 
triggered first.

Disk maximal 
percentage used

Maximum percentage of used disk space to prevent a 
warning. The recommended setting is 80. This warning 
may trigger before or after the minimal disk space value 
is set. For example, if you set this value to 80% and the 
disk has 500 MB free, and minimal free megabytes is 
set to 100 MB, this warning is triggered first.

Area minimal 
megabytes free

Minimal amount of megabytes that must be available 
per storage area to prevent a warning.

Area maximal 
percentage used

Maximum percentage of used space per storage area 
that must be maintained to prevent a warning. 

Check overflow extent When selected, a warning message displays when the 
overflow extent is in use.
Enables an advanced check on database size. The 
ADVIA CentraLink system database consists of 55 
extents, each of which has a 2 gigabyte limit. 

Support email address Sets the system to forward a copy of the warning to the 
specified address. This feature requires that an Email 
host and port were configured in the email address field 
of Mail tab on the system Options window.

Field Description 
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Purging Data from the Database
You can access the Purge data window through the Sample status overview 
window or you can access it as a pulldown option from the System Management 
function. 
NOTE: As an audit log is generated and written to during the manual purge 
process, system performance can be significantly degraded when initiating a 
manual purge. If you purge on a regular basis, contact your local technical 
support provider to configure a task, which can be scheduled to purge 
automatically. 
Access the Purge data window: 
1. At the menu bar, Start > System management > Database > Purge data. 
2. At the Sample status overview window, select Purge. 

To access the window from the Sample status overview window, see Purging 
Sample and Worklist Data from the Database‚ page 72. 
The Purge data window displays. 

Field Description

Days to keep The period of time, starting from the current date back, 
for which the data is not purged. 

Samples When selected, samples with status Uploaded, Omitted 
or Unknown, that is, those samples without requests, 
and their dependent data are purged. 

Worklists When selected, worklists and their dependent data are 
purged. 
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Scheduling Tasks
A task specifies that a command is launched automatically at a specific time and 
perhaps on a recurring basis. 
Scheduled tasks might include uploading and downloading:
• Uploading QCs to the LIS
• Automatically uploading samples to the LIS
• Download workorders to the LAS
Set up a scheduled task:
1. At the menu bar, select Start > System management > Commands > 

Commands 
The Commands browser window displays. 

2. Select the appropriate command. 
3. Right-select the selected command and select Tasks.

The Task browser window displays. 
4. Select New on the toolbar. 
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The Task editor window displays. 

5. Enter the Name value, the From value, which is the start date, and the Until 
value, which is the to date. 

6. Specify the Recurrence pattern information to automatically perform the 
specified command. 

7. Select OK. 
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Backing Up and Restoring the Software
Backing Up the Databases
Do not shut down the databases before making a backup. You can continue 
working while the backup is being made. You can launch the ADVIA CentraLink 
database backup utility from the ADVIA CentraLink system. 
NOTE:  The recommendation is to perform a database backup once a day. 

To launch the ADVIA CentraLink database backup utility from the 
ADVIA CentraLink system complete the following steps: 
1. At the ADVIA CentraLink menu, select Start > System Management > 

Database > Backup. 
The ADVIA CentraLink backup utility window displays. 

The Write to tape checkbox field allows for you to write the database to tape 
or to file. When selected, the database backup is written to tape. When not 
selected, the database backup is written to a file on disk in the path specified 
within the Temporary backup directory.
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Default is to Write to tape; the corresponding Write to tape checkbox is 
selected. 

2. Ensure that the Write to tape checkbox is appropriately selected. 

3. Select Start. 
Progress messages display on the screen throughout the backup process. 
NOTE: When the possibility of insufficient disk space exists while performing 
a manual backup, the following message displays: "You probably don't have 
enough disk space on your temporary drive to do the backup. Are you sure 
you want to proceed? (Y/N)"

If the Write to Tape 
checkbox is...

Then...

selected the database backup is written to tape and 
subsequently deleted from disk.
NOTE: The RD1000 removable disk is not treated as a 
tape. 
NOTE: When you select the Write to Tape checkbox, 
both the database and cytograms are backed up and 
written to tape.

not selected the database backup is written to a file on disk in the 
path specified within the Temporary backup directory 
field. 
NOTE: This includes writing to the RD1000 removable 
disk, which is on the PowerEdge 2900 server. 
NOTE: Cytograms are only backed up when you select 
the Write to Tape checkbox, which backs up the 
database and cytograms and writes them to tape. 
The cytograms must be backed up manually using 
windows explorer or through the command prompt. 
When you leave the Write to Tape checkbox 
unselected, the cytograms are not backed up and are 
not written to the file on disk. 
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If you select Yes and sufficient disk space does not exist, the database locks. 
Under these circumstances, you would have to reboot the ADVIA CentraLink 
server to resolve the problem. 
Always terminate the backup by selecting No. 

A complete backup operation is done in several steps. Three major operations 
are performed during a backup: 
• A database image is written to the spare disk on the server
• The database image is written to the tape
• Cytograms are written to the tape
The current step is marked by the yellow arrow. Steps that are completed are 
marked with a green check mark. A backup is successful when all check boxes 
are marked with a green check mark. Steps that failed are marked with a red 
cross. If a step fails, examine the log at the bottom of the backup window. A 
status window displays while the data is written to the tape.
After a successful backup operation, the backup tape is ejected automatically. 
Take it out and keep it in a safe place. In case of an error, you can select the Eject 
button to remove the tape.

Performing a Backup
The only difference in the operation of the low-end server and the high-end 
server is a minor distinction in the operation of the tape drive. 
Performing a backup on the low-end server involves a waiting period. Insert the 
tape and wait for the tape drive to complete its initialization. This takes 
approximately 2 minutes. Wait until the Ready light has stopped flickering before 
starting the ADVIA CentraLink system backup procedure. 
If the backup procedure is started without waiting, the ADVIA CentraLink system 
backup application reports one of the following errors: No Media or Device not 
ready. If the error is posted, cancel the backup, wait for the tape drive to complete 
its initialization, and restart the backup. 
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Compatibility of Backup Tapes
The Dell PowerEdge 2900 server uses a RD1000 removable disk, not a tape. 

NOTE:  The DLT/VS160 is backward read compatible with the DLT Tape IV tapes 
used on the DLT1/VS tape drive, which means that tapes from Dell PowerEdge 
2500 or 2600 servers can be restored to the Dell PowerEdge 1800 or 2800 
servers, but these tapes cannot be used for backup.

Siemens PN 
for Server

Dell Model Tape Drive Tape Format Storage 
Capacity

084-B003-01 Dell 
PowerEdge 
2500

DLT1/VS DLT IV 40/80GB

084-B003-02 
and -03

Dell 
PowerEdge 
2600

DLT1/VS DLT IV 40/80GB

084-B003-04 Dell 
PowerEdge 
2800

DLT/VS160 VS1 80/160GB

084-B003-05 Dell 
PowerEdge  
2800 

DLT/VS160 VS1 80/160GB 

084-B003-06 Dell 
PowerEdge  
2800 

DLT/VS160 VS1 80/160GB 

084-B001-01 Dell 
PowerEdge 
1800

DLT/VS160 VS1 80/160GB
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The DLT/VS tape drive does not read or write to the VS1 tapes used by the DLT/
VS160 tape drive. Tapes from Dell PowerEdge 1800 or 2800 servers cannot be 
restored to the Dell PowerEdge 2500 or 2600 servers.

Restoring the Databases from a Tape Backup
You can easily restore a previous database from tape using the 
ADVIA CentraLink system database restore utility.
Before restoring the database, you must have a working ADVIA CentraLink 
system installation. If an ADVIA CentraLink system installation was not 
successful, you must reinstall the ADVIA CentraLink software from the 
ADVIA CentraLink CD-ROM before restoring the database from tape. 
NOTE:  Restore works only with a backup from the same ADVIA CentraLink 
system version. The backup version must have the first digit in the three-digit 
version identification.

Ensure that no ADVIA CentraLink system client, even the one on the server, is 
running when the restore operation is underway. It is not necessary to manually 
shut down the databases; the restore program shuts down the databases 
automatically. 
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Step 1: Restoring the Database Images
The database images are restored first using Windows.

Windows 2000 and Windows 2003 Restore Procedure from a Tape Backup
1. At the Windows Start menu, select Programs > Accessories > System 

Tools > Backup.
2. Insert the backup tape. 

If a New Import Media window displays, select Allocate this media to 
Backup now and then select OK. 
This window displays only when you are moving tapes from one system to 
another or when the operating system was reinstalled on the server. 

3. At the Backup window toolbar, select Tools > Options.
The Options window displays. 

4. Select the Restore tab. 
5. Select Always replace the file on my computer. 
6. Select OK. 
7. At the Backup window, select the Restore tab.
8. At the left pane of the restore window, select the tape named CentraLink 

backup in your backup media section. 
9. In the right pane, if you do not see two backup sets for the ADVIA CentraLink 

system databases and cytograms, double-select CentraLink backup in the 
left pane.
A catalog of the tape is made and the two sets display in the right pane. 

10. Select both backup sets and select Start Restore.
A message displays prompting if you want to continue. 

11. Select OK. 
A message displays prompting if you want to overwrite the files.

12. Select OK.
A status window displays. Allow the restore operation to run to completion. 

13. Close the Backup application.
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Step 2: Rebuild the Database from the Image
ADVIA CentraLink software is shipped with a utility that makes it easy to 
reconstruct the database starting from the backup image that you just restored. 
1. At the Windows Start menu, select Run. 
2. Type d:\centralink\bin\restore.exe.
3. Select OK.
4. If the path displayed in the image file field is exactly the same as the location 

where the image file is restored, you need not modify this field. 
Through Windows Explorer, verify that the following files are in this location: 
centralink1, centralink.inp and centralink.st. Typically the files are located in 
the following directory: F:\CentraLink\Tmp\Backup. If you do not know the 
temporary directory name, search for the files on another drive. Do not 
confuse these files with the actual databases, each of which has an 
extension: db, d1, d2, d3, b1. 
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5. Select Start to start rebuilding the database. 
The restore operation is done in several steps. The current step is marked by 
the yellow arrow. Steps that are completed are marked with a green check 
mark. A restore is successful when all check boxes are marked with a green 
check mark. Steps that failed are marked with a red cross. 

6. If a step fails, examine the log at the bottom of the Restore window.
After a successful restore operation, the newly restored databases are 
started. It can take several minutes before the databases are fully started. 
Wait at least three minutes before starting the ADVIA CentraLink software 
again. You did not wait long enough, if the following error message displays: 
There is no server for database.

Step 3: Restoring Cytogram Images
If all paths are exactly the same in the actual ADVIA CentraLink system 
installation as on the backup tape, skip this step. The images are already stored 
in the correct location.
If all paths are not exactly the same in the actual ADVIA CentraLink system 
installation as on the backup tape, move the images from the previous Cytogram 
directory to the current Cytogram directory:
Restore cytogram images: 
1. Initiated Windows Explorer.
2. Mark all files, including all subdirectories, in the old Cytogram directory.
3. Drag them into the new Cytogram directory.
4. After verification, you can delete the old cytogram directory. 

Restoring the Databases from a Disk Backup 
You can easily restore a previous database from a disk backup using the 
ADVIA CentraLink system database restore utility.
Before restoring the database, you must have a working ADVIA CentraLink 
system installation. If an ADVIA CentraLink system installation was not 
successful, you must reinstall the ADVIA CentraLink software from the 
ADVIA CentraLink CD-ROM before restoring the database from disk. 
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NOTE: Restore works only with a backup from the same ADVIA CentraLink 
system version. The backup version must have the first digit in the three-digit 
version identification.
Ensure that no ADVIA CentraLink system client, even the one on the server, is 
running when the restore operation is underway. It is not necessary to manually 
shut down the databases; the restore program shuts down the databases 
automatically. 

Step 1: Rebuild the Database from the Image
The ADVIA CentraLink software is shipped with a utility that makes it easy to 
reconstruct the database starting from the backup image that you just restored. 
1. At the Windows Start menu, select Run.
2. Type d:\centralink\bin\restore.exe.
3. Select OK.
4. Copy the following 3 database backup files that are located on disk to the 

default restore path directory: centralink1, centralink.inp and centralink.st. 
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NOTE: Typically the default restore path is F:\CentraLink\Tmp\Backup. 

5. Ensure that the value in the Database image files: field is the path of the 
default restore directory where you copied the database backup files. 

6. Select Start to start rebuilding the database. 
The restore operation is done in several steps. The current step is marked by 
the yellow arrow. Steps that are completed are marked with a green check 
mark. A restore is successful when all check boxes are marked with a green 
check mark. Steps that failed are marked with a red cross. 

7. If a step fails, examine the log at the bottom of the Restore window.
After a successful restore operation, the newly restored databases are 
started. It can take several minutes before the databases are fully started. 
Wait at least 3 minutes before starting the ADVIA CentraLink software again. 
You did not wait long enough, if the following error message displays: There 
is no server for database.
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8. To restore the cytograms files from disk, copy the files to the Cytogram 
directory in the CentraLink folder. 
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Selecting and Adding Languages
The ADVIA CentraLink system supports multiple languages:
• You can define a language for the user interface.
• You can define additional languages and translations for menu options and 

reports.

Understanding User Interface Languages
The user interface languages, also called system languages, and their 
translations include English, French, German, Dutch, Spanish, and Italian. 
You can use different user interface languages concurrently. One user might use 
an English client session while another user uses a French client session.

Changing User-Defined Languages
The ADVIA CentraLink system database contains a table for user-defined 
languages. User-defined languages are used to qualify translations for 
multilingual fields in various tables. Multilingual fields include menu option labels 
and test descriptions.
You provide translations for multilingual fields. Providing translations for menu 
options or toolbar button help text in any of the system languages is not required. 
These are automatically translated from the built-in glossaries when you activate 
a menu after database initialization.
Access the Language window: 
1. At the menu bar, select Start > System Management > Languages. 
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The Languages window displays. 

Field Description 

Name Unique name for the language, such as French. 

Code Unique identifier for the language. 

System language Associated user interface language, which can be used 
for retrieving translations of non-multilingual strings.
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Defining Languages for Users
When defining a new user, you can set the user’s language by referencing one of 
the languages listed in the Language table. If a language is not defined for a user, 
the language defaults to the language defined in the Language field of the 
General tab on the system Options window. A user can override an assigned 
language on the Logon window.

Setting the Language for Add-on Programs
Some add-on ADVIA CentraLink system components, such as backup, restore, 
and Watchdog, run outside of the ADVIA CentraLink system database. Since 
most of these are Windows services, their language setup is different from the 
ADVIA CentraLink system language setup. Instead of using the 
ADVIA CentraLink system language, they use the user language specified in 
Windows. 
You can set up this language apart from the Windows 2000 or Windows 2003 
system language. The ADVIA CentraLink system add-ons can run in a language 
different from Windows. Error messages originating from Windows, however, are 
in the Windows system language. In certain cases, the language on the buttons 
doesn’t match the user language. 
Define the Windows user language in Windows: 
1. At the menu bar, select Start > Control Panel > Regional Settings or 

Regional and Language Options. 
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The Regional Settings Properties window displays. 

2. Select the appropriate language from the drop-down menu. 
3. Select OK. 
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Printing
The table of printers is a table of operating system commands that is launched 
when non-graphical print jobs are run. Examples of non-graphical print jobs are 
text-format sample and QC reports and generic browser printouts.
1. At the menu bar, select Start > System management > Printers. 

The Printers browser window displays. 

2. To limit the display of printers to those assigned to your user name, select 
Show my printers only. 
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For information on assigning printers to a user, see Assigning Printers to a 
User‚ page 338.

3. To define a new printer, select the New icon on the toolbar. 
The Printer editor window displays. 

 

Field Description 

Name A unique name for the printer.
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Windows path Identifies a printer installed on your network; for 
example :\\Centralinksvr\hplaserj. 
Document types that are supported are defined by a list 
of file extensions set in the MA Section of the 
<CentraLink root>/bin/Progress.ini file. 
Insert a line like this (the default value is “doc”):
WindowsPrintingSupportedExtensions=“txt,doc”

Top limit and
Left limit

These fields are not used in the ADVIA CentraLink 
system.

Print command Use this field whenever a document of an unsupported 
type is printed. It is an operating system command with 
a placeholder ('&1') for the name of the file to be 
printed:
copy &1 \\<server-name>\<printer-share-name>
Substitute <server-name> and <printer-share-name> 
as appropriate.

Preamble and 
Postamble

These fields optionally reference files to send to the 
printer using the Print command, before and after the 
actual file is printed. These files may contain printer-
specific directives, for example to ensure page breaks 
between consecutive files. 
Like the Print command field, these fields are used only 
for printing non-supported file types.

Field Description 
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Customizing Reports
The ADVIA CentraLink system generates reports according to report models. 
When the system generates a report, it uses the default report model from the list 
of available models. Every sample or test in the report follows the default report 
model unless a different model is associated with the requesting physician. 
For more information on report models, see Configuring a Report Model‚ 
page 328.
Change the default report model by completing the following steps:
1. At the menu bar, select Start > System management > Options.

The Options editor window displays. 
2. Select the More tab. 

The name of the current default report model displays in Report model.
3. Double-select Report model. 

The Report models window displays and lists the available models.
4. Select the appropriate report and select OK. 

Report model is populated with the selected report model name.
Reports generated after this change use this report model. 

NOTE:  Your system administrator can establish automatic reporting by defining a 
reporting command to run automatically. Commands are always associated with 
a table and reference both a query, which determines the records for processing, 
and a function, which determines how to process the records. The format setting 
of text or HTML is specified through command parameters. When a command is 
defined, your system administrator can create associated task records, which are 
scheduled for execution by a task scheduler service. 
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Customizing the Toolbars
The ADVIA CentraLink system is installed with a default set of toolbar buttons. 
You can add, edit, and delete toolbar buttons.
Add a toolbar button by completing the following steps:
1. At the menu bar, select Start > System management > Menu > Toolbar 

buttons.
The Toolbar buttons browser window displays.

2. Double-select an existing entry that requires editing or select the New icon on 
the toolbar.
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The Toolbar button editor window displays. 

3. Select OK after entering the relevant information. 
You must log out and log back in to the ADVIA CentraLink system to view the 
toolbar button modifications. 

Field Description 

Row Determines the relative vertical position of the button.

Sequence Determines the relative horizontal position of the 
button.
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Function table and 
Function mnemonic

Together these field values reference the function 
activated by the button.

Function parameter 
set 

References any combinations of parameter values pre-
configured for the function. 

Label Text that displays on the button. 

Help text Text that displays on the button's tool tip. The help text 
is visible when the mouse is positioned over the button. 

Image up, Image 
down, and Image 
disabled 

File names of the image the button displays when it is 
active but not pressed, pressed, and disabled. Image 
up is the only mandatory file name. 
These image file names are located in the <root>/img 
directory. 

NOTE:  Images and text are mutually exclusive.

Insert ruler If selected, the toolbar icon is separated from other 
toolbar icons by a vertical line. 
If not selected, the toolbar icon is not separated from 
other icons by a vertical line. 

Field Description 
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Troubleshooting 
The following information may be helpful in troubleshooting system problems and 
in everyday operation of the ADVIA CentraLink system.

Error Messages
ADVIA CentraLink Client/Workstations Sessions
The ADVIA CentraLink system supports up to 15 open sessions at one time. If 
you attempt to open more than 15 sessions, an error message displays. The 
content of this message differs depending on whether the session is opened on 
the ADVIA CentraLink system server or on a client/workstation. To close the error 
message, press CTRL+BREAK. 

Deleting Items from Tables
The following message may display if you delete an item from a table while the 
browser for that table is open:
b_Base record not on file (138)
If this message displays, select OK to close the message. The system deletes 
the item and no further action is necessary.

Manually Creating Workorders or Validating Results
The following message may display when you manually create workorders or 
validate results:
b_SpecificSelf in use by mipssys on CON:. Wait or choose cancel to stop
If this message displays, wait a moment and it automatically closes. Do not select 
Cancel, which closes the entire the ADVIA CentraLink system application.
b_sample record not on file 
This error is generated when concurrently communicating with the 
ADVIA 120 system and working on the ADVIA CentraLink system. Upon display 
of this error, you can close the Review and Edit window, reopen the window, and 
requery the same sample. The error message no longer displays when system 
processing is complete. 
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Manually Uploading QC data to the LIS
The following message may display when you manually upload QC data to the 
LIS: 
Tsl$TimeOutAppl() 
If this message displays, select OK to close the message. No further action is 
necessary.
If message continues, contact your local technical support provider.

Transmitting Result Messages
The following message error may occur if the result message is too long to be 
processed within the time specified in the LIS Translator. 
Trl$TimeOut Appl() Error on LIS Upload
The suggested value for the LIS Translator Time-out is 20 seconds. If this error 
continuously occurs, contact your local service provider or distributor. 

Troubleshooting and Tips
QC lot results are not recognized 
Problem: The ADVIA CentraLink system reports that the control does not match 
a lot.
Solution: You must add each QC lot to the ADVIA CentraLink system, and you 
must fill in all information about it on the QC lot window. For more information, 
see QC Lots‚ page 173.

QC lot results are not recognized when the expiration date is older than the start 
date.
Problem: When the ADVIA CentraLink system imports controls, it does not 
check the expiration date. If control samples with an old expiration date are sent 
to the ADVIA CentraLink system from an instrument, the ADVIA CentraLink 
system reports that the control does not match a lot. 
Solution: Using the QC Lot window, change the expiration date to a later date 
than the start date. When you change the date, the ADVIA CentraLink system 
recognizes the control and creates a population for it. 
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Error message received for aspiration time
Problem: When attempting to display a list of samples based on a query for 
“Aspiration time,” you may receive the error message, “Invalid range for 
aspiration time.”
Solution: When filling in the Sample Query window, be sure to type in the 
aspiration time in 24-hour format (for example, 20:00).

Blank Window when Uploading Sample Results
Problem: The system may displays a blank window for a few seconds while 
uploading sample results. 
Solution: This does not affect system operation and requires no intervention.

No QC Graph data displays for a test in the Across Controls window
Problem: When viewing QC results on the Across Controls window, the system 
does not display any information for a test in the graph columns.
Problem: If a target value is specified for a test, it is used as the center point for 
the QC graph calculations. However, if no target value is specified, the reference 
value must be set to “Current Statistics” in order for the system to use the 
reference value as the center point on the Across Controls window. 
To set the reference value:
1. Open the QC Population editor for the test. 

For detailed information, see Specifying Test and Instrument Parameters for a 
QC Lot‚ page 176.

2. Select the appropriate QC population. 
3. Right-select the selected QC Population and then select Set Reference.
4. On the Set Reference window, set the Source to Current statistics and then 

select OK.

Multiple Sample Types in a Single Workorder
In some cases, the system discards some test requests when downloading 
workorders from the LIS. When the LIS downloads a workorder, the 
ADVIA CentraLink system LIS translator assumes the sample type of the first test 
is the sample type for every subsequent test in the workorder. If any of the tests 
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have a different sample type, the translator discards them. Any test received with 
the sample type set to the ? symbol is added to the order. 

Using Symbols in Numeric Results
The ADVIA CentraLink system allows numeric results that include the > (greater 
than) and < (less than) symbols. Numeric results that include the > or < symbols 
are transmitted to the ADVIA CentraLink system from networked instruments or 
they are manually entered. You must ensure that your LIS is capable of handling 
any results that contain these symbols.

QC Monitoring for Ratio Test Results
When ratios are defined in the ADVIA CentraLink system, the recalculation of a 
ratio is automatic when any input to the calculation changes through a rerun or a 
manual edit. However, when you define a test as a ratio test in the 
ADVIA CentraLink system, the system can no longer receive or manage QC data 
for the test.
If QC monitoring for a ratio test is essential, you must change the test type to a 
routine instrument-sourced test. Instrument-sourced ratio tests are not 
automatically recalculated when one of the inputs is rerun or manually edited. 
Therefore, if you disable a test as a ratio test (by removing the ratio calculation for 
the test), you must ensure that a warning message is added to the test definition.

Images for Samples with Unknown Sample ID Numbers
The ADVIA CentraLink system rejects the results for sample records with 
unknown sample ID numbers. Any associated image files, however, remain in the 
FTP directory and you must manually deleted them from the system.

ADVIA 120/2120 Disposition Codes
The ADVIA CentraLink system does not display disposition codes for results from 
the ADVIA 120/2120 hematology system. If a result is manually edited at the 
ADVIA 120/2120 system and then sent to ADVIA CentraLink system, there is no 
indication in the ADVIA CentraLink system that the result is edited. You must 
make sure that the ADVIA 120/2120 system is set to Review None mode so that 
you can manually edit results only in the ADVIA CentraLink system. 
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